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1 Capítulo 1 

Bienvenido a FEA 

Supongamos que desea resolver un problema físico como encontrar las tensiones de un objeto cuando 
se aplican fuerzas prescritas. Este es un problema típico de FEA: se aplica algún tipo de carga a un objeto 
y se calcula la respuesta sujeta a restricciones especificadas. 

 

En un problema de mecánica, el objeto podría ser un engranaje, la carga podría ser una fuerza aplicada 
por otro engranaje, la respuesta podría ser las tensiones a lo largo del engranaje. La restricción es que el 
engranaje debe permanecer sobre el eje. 

En un problema térmico, el objeto podría ser un tablero de electrónica, la carga podría ser el flujo de calor 
en su superficie interior y el flujo de calor por convección en su superficie exterior. La respuesta sería la 
distribución de la temperatura en el material. 

El método de elementos finitos es una técnica numérica para obtener 
una respuesta aproximada al problema representando al objeto 
mediante un conjunto de formas simples - los elementos finitos. Cada 
uno de estos elementos tiene determinadas propiedades de material y 
está conectado a los elementos adyacentes en nodos: puntos 
especiales en los bordes del elemento. Este conjunto de elementos 
conectados en sus nodos es llamado malla. 

Debido a que los elementos pueden modelar fácilmente formas 
complicadas, FEA es un método popular y poderoso para predecir en 
forma realista el comportamiento de muchas estructuras y 
componentes de ingeniería. 

El proceso de utilizar el método de elementos finitos generalmente es iterativo - Usted debe resolver el 
modelo varias veces para estimar el error en los resultados y reducirlo a un nivel aceptable. Esto se llama 
estudio de convergencia de malla. 

 

1. Cree el modelo: 

• Coloque los nodos o elementos individuales de a uno o 

• use las herramientas de creación y edición de malla para hacerlo más fácil o 

• Importe un modelo CAD y utilice el mallado automático para generar una malla. 

• Asigne propiedades de los materiales a los elementos y 

• Aplique cargas y restricciones a la malla. 

 

 

Malla compuesta por 4 
elementos y 18 nodos
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2. Resuelva del modelo: 

• Defina el tipo de análisis que desea, por ejemplo, mecánico estático, modos de vibración, 
respuesta dinámica con el tiempo, etc. 

• Deje que el Solucionador de Mecway haga el trabajo. 

3. Refine la malla y nuevas resoluciones hasta que los resultados no cambian mucho: 

• Registre los valores de la solución anterior en los puntos de interés. 

• Refine la malla, aumentando la densidad de elementos en la región de interés. 

• Resuelva de nuevo y repita el procedimiento hasta que los valores en los puntos de interés 
sean similares a los de la solución anterior. 

 

Esta gráfica de convergencia de malla muestra una componente de la tensión en el borde superior de la 
viga para 4 densidades de malla diferentes. Con alrededor de 400 nodos podríamos considerar que el 
error es aceptable. Otras formas de elementos pueden dar una convergencia más rápida con menos 
nodos. 
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2 Capítulo 2 

Descripción general de Mecway 

En este capítulo se presenta el flujo de trabajo Mecway para realizar análisis de elementos finitos.  

 

 

 

2.1 Malla 

Una malla de elementos finitos se compone de nodos (puntos) y elementos (formas que unen los nodos). 
Los elementos representan el material, por lo que deben llenar el volumen del objeto modelado. La malla 
se muestra en el área de gráficos que ocupa la mayor parte de la ventana de Mecway. 

Puede editar una malla usando el menú de Mesh tools o seleccionando partes y utilizando el menú 
contextual del botón derecho del ratón para acceder a las herramientas de edición de mallas. 

El resto de los contenidos de un modelo se muestra en el esquema de árbol en el lado izquierdo de la 
ventana. Tiene varios grupos que contienen diferentes tipos de ítems que se enumeran a continuación. 
La mayoría de estos ítems pueden ser modificados a través de un menú contextual al cual puede acceder 
haciendo clic con el botón derecho sobre ellos. 

2.2 Análisis (Analysis) 

Puede cambiar propiedades globales tales como tipo de análisis, constantes físicas, ajustes del 
Solucionador y opciones de salida editando el elemento Analysis en el esquema de árbol. 

2.3 Geometría (Geometry) 

Si genera una malla a partir de un archivo STEP exportado desde un programa CAD entonces estos 
archivos se muestran en el grupo Geometry. Cada elemento de geometría puede ser auto-mallado para 
generarle una malla. 
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2.4 Componentes y Materiales (Components & Materials) 

Un componente es una colección exclusiva de elementos. Cada elemento debe pertenecer a exactamente 
un componente. 

Los componentes se utilizan para asignar materiales y controlar el aspecto (color y visibilidad) de los 
elementos. Todos los elementos de un componente comparten el mismo material y color. Para los 
modelos complejos con diferentes partes o características puede ser útil asignar cada parte a un 
componente para ayudar en el trabajo sobre la malla. 

Cada componente debe tener un material asignado. El mismo material puede ser compartido entre varios 
componentes. 

Puede convertir un componente en una selección con nombre seleccionando sus elementos y creando 
una nueva selección de elementos o agregarlos a una selección con nombre ya existente. Una selección 
con nombre que contenga elementos puede ser convertida en un componente de manera similar. 

2.5 Cargas y restricciones (Loads & Constraints) 

Este grupo contiene todas las cargas y restricciones en el modelo. Las cargas que se aplican a 
selecciones con nombre muestran sus nombres como ramas secundarias en el esquema de árbol. 

2.6 Selecciones con nombre (Named selections) 

Una selección con nombre es una colección no exclusiva de nodos, elementos o caras. Una cara es una 
cara o arista de un elemento. Se pueden utilizar las selecciones con nombre para aplicar cargas y 
restricciones o simplemente para ayudar a organizar el modelo. Por ejemplo, para aplicar una fuerza a la 
superficie de un objeto, en lugar de aplicarlo directamente a las caras, usted puede poner todas las caras 
en una selección con nombre y aplicar la fuerza a la selección con nombre. 

2.7 Solución (Solution) 

Después de la resolución, los resultados se muestran en la rama Solution en el esquema de árbol. Puede 
hacer clic en una variable de campo para ver su gráfica de contorno coloreado. Para agregar más 
variables de campo, haga clic con el botón secundario en Solución o abra el menú Solución en la barra 
de menú y elija otras nuevas. Algunos se pueden generar y mostrar de inmediato, mientras que otros 
requieren que resuelva el modelo nuevamente para generarlos. Si resuelve un modelo cuando no se 
muestran variables de campo en Solución, producirá el conjunto mínimo necesario para obtener la 
mayoría de las otras sin resolver nuevamente. También incluye el estrés de Von Mises cuando 
corresponda. 

2.8 Configuraciones (Configurations) 

Configuraciones le permiten definir varios conjuntos diferentes de cargas y restricciones en el mismo 
modelo. Por ejemplo, usted puede tener una configuración para cargas muertas y otra para cargas 
muertas y cargas vivas juntas. Cada configuración tiene su propia solución independiente por lo que 
también se puede utilizar para mantener disponibles varias soluciones al cambiar algo en el modelo. Use 

Edit→  New configuration para crear una nueva configuración. Luego suprima y elimine cargas y 

restricciones de forma independiente en cada configuración o para todas las configuraciones a la vez. 

Clique las pestañas arriba del esquema de árbol para seleccionar la configuración activa que se mostrará 
y resolverá. 
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2.9 Unidades 

Cada valor numérico tiene su propia unidad. Puede cambiar la unidad de cualquier cantidad 
seleccionándola en el cuadro desplegable junto al número. Esto también convertirá el número en la nueva 
unidad para que mantenga el mismo significado físico. Una excepción son las tablas de entrada 
(propiedades de materiales dependientes de la temperatura y cargas dependientes del tiempo) y fórmulas, 
que no se modifican. 

 

Las unidades predeterminadas para los elementos recién creados se determinan por las unidades usadas 
previamente, de modo que aprende sus preferencias. 

Las libras-fuerza y libras-masa se distinguen por los símbolos lbf y lb respectivamente. 

 

2.10 Comentarios 

Para agregar un comentario en formato de texto al archivo, haga clic con el botón derecho en Analysis y 
elija Comment. Con solucionadores externos, estos se escribirán al principio del archivo de entrada como 
comentarios. 
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3 Capítulo 3 

Visualización y selección 

3.1 Ampliar, desplazar y girar 

3.1.1 Botones herramienta 

  Girar a la vista isométrica. 

  Girar a la vista con un par de ejes paralelo a la pantalla. 

  Ajustar a la ventana 

 

3.1.2 Teclado 

 +    Acercar 

 -    Alejar 

 Teclas de flecha  Desplazar arriba/abajo/izquierda/derecha 

 Alt + teclas de flecha Girar 15° sobre la horizontal o el eje normal a la pantalla  

 F4 y F5  Girar 15° sobre el eje vertical 

 

3.1.3 Ratón 

   Girar  Arrastre el cursor con el botón central. Clique para ubicar el centro de rotación. 

 Zoom  Gire la rueda del mouse 

 Desplazar Arrastre el cursor con el botón derecho 

Puede cambiar esta configuración por defecto del ratón en Tools→ Options→ View control. 

 

3.1.4 Mouse 3D 

Se puede utilizar un dispositivo 3Dconnexion como SpaceMouse para: navegación 3D (desplazar, zoom, 
rotación), ajustar las 6 vistas ortogonales preestablecidas, vista ISO1 y Zoom rápido. 

 

3.1.5 Tríada 

La tríada en la parte inferior derecha de la pantalla se puede utilizar para girar rápidamente la vista en 
paralelo con el plano XY, YZ o ZX o isométrica. Haga clic izquierdo o derecho en la flecha o en el punto 
celeste para fijar la vista en paralelo a los ejes o isométrica. 
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La orientación predeterminada es con el sentido Y positivo hacia arriba y Z positivo al frente. Puede 
cambiar a la otra convención popular con Z positivo hacia arriba e Y positivo hacia atrás utilizando Tools→ 
Options→ View orientation. Esta opción determina las orientaciones obtenidas pulsando las flechas de 
la tríada y las 6 vistas ortogonales predeterminadas (delante, detrás, etc.). No tiene ningún efecto sobre 
el modelo o la solución. 

Use View → Save current view para guardar la orientación de la vista y otros ajustes, incluido el estado 

de ocultación de los componentes. Luego puede aplicar rápidamente la configuración de la vista guardada 
haciendo doble clic en el elemento del esquema de árbol. 

 

3.2 Modos de visualización 

 

 Mostrar superficies de elementos 

 

 

 

 

 Mostrar bordes de elementos 

 

 

 

 

 Mostrar bordes de modelo 

 

 

 

 Mostrar espesor de elementos cáscara cuando se 
muestran superficies de elementos. 

 

 

 

 

 Exploded view en el menú View aleja 
las partes desconectadas entre sí. 

Esto es útil para seleccionar superficies de 
contacto y para ver los resultados en áreas 
obstruidas. 
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Open cracks en el menú View cambia a este modo. 
Ayuda a ver lugares de la malla donde los elementos 
parecen estar conectados, pero no comparten los 
mismos nodos. Cuando está activado el modo de abrir 
grietas, la superficie exterior de la malla se contrae 
ampliando las brechas. 

 

 

 

 

3.3 Selección 

Mecway se enfoca en la selección, o sea que, para realizar la mayoría de las tareas de edición de mallas, 
primero hay que seleccionar nodos, caras o elementos. 

 

  Seleccionar nodos 

  

  Seleccionar caras 

  

  Seleccionar elementos 

 

Cambiar entre estos tres modos convierte cualquier selección existente al nuevo tipo. 

 

 Selección rectangular 

 Selección circular  

 Selección pintando. Arrastre el ratón para seleccionar caras limitadas por las aristas de la 
malla. 

 Selección detectando aristas. Cliquee en una cara (incluyendo lados de carcasas o vigas) para 
seleccionar rápidamente toda la superficie limitada por las aristas de la malla. Si no se detectan 
los bordes correctos, ajuste el ángulo de umbral de borde (Edge threshold) con el control 
deslizante que aparece. Este es el ángulo más grande entre las normales de caras adyacentes 
sobre el que se extenderá la selección. 

Mantenga presionada la tecla Ctrl mientras selecciona para agregar o quitar elementos de la selección.  

Mantenga pulsada la tecla Mayús para evitar el desplazamiento de nodos mientras selecciona nodos con 
el ratón. 

Edit→ Select nodes by formula permite seleccionar nodos según una desigualdad de la forma 

f(x, y, z)  <  g(x, y, z) 

donde f() y g() son funciones matemáticas de la posición. Por ejemplo, para seleccionar los nodos dentro 

de una esfera de radio 3m, centrada en el origen, escriba x^2+y^2+z^2 < 3^2 y ponga m como unidad en 

Position. 

Para obtener un tutorial guiado, consulte el tutorial Visualización y selección más adelante en este 
documento. 
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4 Capítulo 4 

Mallado manual 

En este capítulo se explica cómo utilizar las herramientas disponibles en Mecway para crear su modelo 
de elementos finitos. A diferencia del diseño asistido por ordenador (CAD) que utiliza líneas, superficies 
y sólidos, los programas de análisis de elementos finitos utilizan sólo nodos y elementos. En Mecway 
también es posible importar modelos CAD y crear una malla adecuada con las herramientas de mallado 
automático de Mecway, pero esto se describe en el Capítulo 5: Modelos CAD. 

Un modelo de elementos finitos es una malla de elementos. Cada elemento tiene nodos que son 
simplemente puntos sobre el elemento. Cada elemento sólo puede conectarse con otros elementos de 
nodo a nodo. Un contacto entre un borde de un elemento y un nodo de otro no es una conexión. Los 
elementos en sí mismos tienen formas muy simples, como líneas, triángulos, cuadrados, cubos y 
pirámides. 

Cada elemento está formulado para obedecer una determinada ley de la ciencia. Por ejemplo, en el 
análisis estático, los elementos están formulados para relacionar los desplazamientos y la tensión, de 
acuerdo con la teoría de elasticidad de materiales. En el caso de análisis de frecuencia los elementos 
están formulados para relacionar las formas de deflexión y frecuencias según la teoría de dinámica 
estructural. Asimismo, en el análisis térmico los elementos relacionan temperatura y calor según la teoría 
de transferencia de calor. Por lo tanto, es esencial que se comprenda la teoría física subyacente antes de 
utilizar el software de análisis de elementos finitos. 

Cuando comience un nuevo modelo, compruebe primero si su elección de forma de elemento es 
compatible con el tipo de análisis. Las formas de elementos disponibles para cada tipo de análisis se 
enumeran en el capítulo 6 - Tipos de análisis. 

En este manual agruparemos las herramientas de mallado manual por propósito: 

i. herramientas de creación, que crean una malla bidimensional 
ii. herramientas de edición, que dan forma y modifican la malla bidimensional creada 
iii. herramientas que convierten una malla bidimensional en una malla tridimensional 
iv. herramientas de refinamiento para lograr la convergencia de resultados 

4.1 Herramientas de creación  

En esta sección se describe cada uno de los instrumentos para crear una malla. Las herramientas para 
modificarlas se describen en la sección 5.2. 

4.1.1 Cuadrado rápido / Cubo rápido (Quick square / Quick cube) 

Si está haciendo un modelo simple ortogonal o desea hacer una prueba rápida de alguna característica 

en Mecway, use Mesh tools→ Create→ Quick square  o Mesh tools→ Create→ Quick cube  . 
Los lados tienen longitudes de 1 y pueden ser utilizados como bloques de construcción para un modelo 
escalando, reposicionando y refinando. 

4.1.2 Nuevo nodo (New node) 

Utilice Mesh tools→ Create→ Node... o  para colocar los nodos 
mediante clics de ratón o introducir las coordenadas. Si utiliza clics 
del ratón, los nodos se sitúan en un plano paralelo a la pantalla que 
pasa por el origen, por lo que es conveniente utilizar una de las vistas 
ortogonales. 
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4.1.3 Nuevo elemento (New element) 

Para crear elementos individuales utilice Mesh tools→ Create→ Element... 

o . Puede dibujar elementos haciendo clic sobre espacios vacíos para 
colocar cada nodo. Si hace clic en un nodo existente, el elemento estará 
vinculado a él. 

El orden en el que los nodos son clicados afectará a la dirección en la que 
surten efecto las subdivisiones el elemento cuando se utilizan las 
herramientas de edición. Por tanto, sea coherente en cómo usted hace clic en 
los nodos. Por ejemplo, puede elegir hacer clic en los nodos yendo en sentido 

contrario a las agujas del reloj a partir de la esquina inferior izquierda. 

4.1.4 Insertar nodo en medio (Insert node between) 

Seleccione dos o más nodos y utilice Mesh tools→ Insert node 

between… o   para crear un nodo en el centroide de los nodos 
seleccionados. Esto es útil cuando se crean nodos en una malla gruesa. 

 

 

4.1.5 Generador de Curvas (Curve generator) 

Mesh tools→ Create→ Curve generator... Crea elementos línea siguiendo curvas definidas por 
ecuaciones paramétricas 3D. Si estos elementos limitan una figura plana cerrada, entonces puede utilizar 
el mallador automático bidimensional, Mesh tools→ Automesh 2D.… para llenar la figura. 

  

También se puede utilizar para generar formas 3D hechas de elementos rectos line2 o curvados line3 
como, por ejemplo, una hélice utilizando estos parámetros: 

p initial  0 
p final   3*2*pi  (3 vueltas) 
X=   cos(p)*1 (radio es 1) 
Y=   sin(p)*1 (radio es 1) 
Z=   p/10  (pase es 10) 
Number of elements 50 
 

Hay ecuaciones predefinidas para algunas formas, así usted las puede crear rápidamente. Ellas son línea 
recta, arco, círculo, elipse y parábola. 
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El uso más común del generador de curvas es crear 
arcos y círculos. Los arcos se pueden crear indicando el 
centro y puntos de inicio y fin o especificando el inicio, fin 
y otro punto del arco. 

 

 

4.1.6  Automallador 2D (Automesh 2D) 

 

Mesh tools→ Automesh 2D.… se utiliza para llenar un área 
delimitada por elementos línea o formada por elementos planos 
cuadriláteros o triángulos o una mezcla de ambos. Después de un 
automallado exitoso los elementos originales ya no existen. Sólo 
puede crear elementos que se encuentran en un plano, que puede 
estar en cualquier orientación. 

El automallador llenará con elementos 
toda el área delimitada, incluyendo los 
agujeros. Usted tendrá que eliminar 
manualmente los elementos en el área 
de los agujeros. 

Los bordes curvos se pueden definir 
usando elementos cuadráticos (line3, 
tri6 o quad8) para que no se conviertan 

en facetados cuando la malla es muy fina. 

Dependiendo de cómo creó y editó su modelo, puede haber lugares donde dos partes de la línea limitante 
parecen estar unidas, pero no lo están. Por ejemplo, estos dos 
elementos línea parecen conectados el uno con el otro, pero al 
mostrar sus números de nodo, es evidente que hay 
superposición de dos nodos. Esto significa que los elementos 
línea no están conectados uno al otro. 

Si hay elementos línea no conectados, el automallador fallará. Por 
lo tanto, antes de ejecutar el automallador utilice la herramienta de edición Mesh tools→ Merge nearby 
nodes... para sustituir cualquier superposición de nodos por un nodo común, lo cual conecta todos los 
elementos. 

Si los valores predeterminados del automallador crean una malla con sólo unos pocos elementos grandes, 
vuelva a ejecutar el automallador usando un valor menor para Maximum element size. Si usted no sabe 

qué valor especificar, utilice la herramienta cinta métrica  para medir el segmento de línea más 
pequeño. Le dará una lectura dinámica a medida que haga clic y arrastre desde un nodo a otro. 

4.1.7 Automallado 3D (Automesh 3D) 

Mesh tools→ Automesh 3D… remalla una parte sólida. También puede llenar el volumen de una malla 
cáscara cerrada. Puede incluir regiones esféricas de refinamiento local. 

La nueva malla se elimina de cualquier carga o selección con nombre y todos sus elementos se colocan 
en el mismo componente incluso si la malla original pertenece a varios componentes. 
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4.1.8 Malla de placa (Plate mesh) 

En Mesh tools→ Create→ Plate mesh hay plantillas para crear formas simples como placas circulares, 
cuadradas y octogonales con o sin agujeros. Estas plantillas son fáciles de usar y son autoexplicativas. 

   

Estas formas pueden ser extruidas o rotadas para generar sólidos tridimensionales. 

4.2 Herramientas de edición 

4.2.1 Mover (Move) 

Mesh tools→ Move/Copy... Se usa para reposicionar o duplicar nodos o elementos. Puede elegir un 
sistema de coordenadas cartesianas o polares, cilíndricas o esféricas. Las coordenadas polares le 
permiten cambiar el tamaño radial de un objeto manteniendo su espesor constante. 

Note la casilla Copy. Si está marcada, la selección se 
mueve y duplica. Hay que tener en cuenta que las copias 
no están conectadas una a la otra. Utilice Mesh tools→ 
Merge nearby nodes... Para conectarlas. 

 

4.2.2 Girar (Rotate) 

Mesh tools→ Rotate/copy... Se usa para reubicar 
rotacionalmente nodos o elementos. Con la opción Copy 
marcada se pueden duplicar, nodos y elementos. 

 

 

 

4.2.3 Espejo (Mirror) 

Mesh tools→ Mirror/copy... Se usa para reubicar nodos o elementos 
por simetría sobre el plano XY, YZ o ZX. Cuando se marca la opción 
Copy, se puede usar para reflejar las mallas. 

En el plano del espejo los elementos no estarán conectados por lo que 
tendrá que usar Mesh tools→ Merge nearby nodes... para hacer una 
malla continua. 

 

4.2.4 Escala (Scale) 

 

Mesh tools→ Scale/copy... Se usa para cambiar el tamaño de toda 
la malla o los elementos seleccionados.  
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4.2.5 Agujero (Hole) 

Mesh tools → Hole... corta un agujero circular a través de una 
malla sólida o de cáscara. Seleccione un nodo para definir el 
punto central. Elija la dirección normal a la superficie o paralela 
al eje X, Y o Z. Defina el diámetro introduciendo su valor. 
Funciona mejor en mallas regulares de hexaedros o 
cuadriláteros y puede producir algunos elementos mal 
formadas con mallas más complejas. 

 

4.2.6 Hueco (Hollow) 

Mesh tools→ Hollow se utiliza para convertir una malla sólida en una 
malla de cáscaras. 

 

 

 

 

 

4.2.7  Proyectar sobre superficie (Project onto surface) 

Mesh tools→ Project onto surface... se usa para deformar una 
malla en una forma suavemente curvada de esfera, domo 
torisférico, cilindro, cono o la forma de otra malla. 

 

 

Puede usarlo para crear curvas suaves en una malla que ha 
quedado facetada después de un refinado, para redondear una esquina o crear un cabezal de recipiente 
a presión a partir de un disco plano. 

 

 

4.2.8 Transferir desplazamientos desde la solución (Transfer displacements from solution) 

Mesh tools→ Transfer displacements from solution deforma el modelo según las variables de campo 
de desplazamientos del conjunto de datos de la solución actualmente seleccionado. Puede especificar un 
factor de escala para que cada desplazamiento sea multiplicado por dicho valor. 

4.2.9 Suavizar (Smooth) 

Mesh tools → Smooth mejora la forma de elementos 
distorsionados moviendo cada nodo hacia la posición media de 
sus vecinos. Las formas de las superficies existentes se 
conservan y las aristas no se cambian. Evite uso repetido de 
esta herramienta sobre superficies curvas gruesas porque el 
movimiento de los nodos de la superficie modifica ligeramente 
la forma de la nueva superficie definida por los nodos. 
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4.2.10 Desconectar elementos 

Para separar una parte de la malla del resto, seleccione los 
elementos a separar y use Mesh tools→ Disconnect elements. 
No notará un cambio en la ventana gráfica, pero podrá verificar 
que se han desconectado usando View→ Exploded view. 

 

4.2.11  Combinar nodos cercanos (Merge nearby nodes) 

Mesh tools→ Merge nearby nodes sirve para asegurarse de que los elementos están conectados nodo 
a nodo, sustituyendo los nodos superpuestos con un único nodo compartido. Ciertas operaciones de 
mallado como Mesh tools→ Refine→ Custom... o Mesh tools→ Move/Rotate (con la opción Copy) 
crearán mallas que no están conectados. Al ensamblar varios archivos con File→ Import ... las mallas no 
se conectarán automáticamente entre sí en la superficie de acoplamiento. 

Si algunos nodos están seleccionados antes de utilizar esta herramienta, sólo los nodos seleccionados 
serán considerados. Sin embargo, si marca la casilla de verificación Merge other nodes into selected 
nodes entonces los nodos seleccionados no se moverán, sino que los otros nodos dentro de la distancia 
de tolerancia se fusionarán con ellos. 

View→ Open cracks expone elementos inconexos. Se contraen ligeramente los elementos para abrir 
cualquier brecha existente entre las caras adyacentes de elementos inconexos. 

Para eliminar estas brechas use Mesh tools→ Merge nearby nodes para eliminar nodos superpuestos. 
Tiene que especificar una distancia radial dentro de la cual dos o más nodos serán combinados en un 
único nodo. Si pone un valor muy pequeño algunos nodos superpuestos no serán eliminados. Si pone un 
valor demasiado grande corre el riesgo de colapsar elementos que pierdan un nodo. Utilice la herramienta 

Tape measure  para determinar la distancia mínima entre dos nodos de la malla y utilice un valor 
menor, de manera que los elementos no se colapsen. Notará una reducción en la cantidad de nodos que 
se muestra en la barra de estado después de usar este comando si se combinaron nodos.  

4.2.12 Eliminar nodos sin usar (Delete unused nodes) 

Mesh tools→ Delete unused nodes eliminará nodos que 
no pertenezcan a un elemento, ecuación de restricción o 
acoplamiento nodo-superficie como nodo de referencia. 

Si usa Edit→ Delete elements and retain nodes, los 
nodos se mantienen. Si no puede verlos, active el modo 

de selección de nodos  

4.2.13 Invertir (Invert) 

A veces los elementos sólidos pueden crearse invertidos de adentro hacia afuera. Esto provocará la falla 
del Solucionador y un mensaje de elemento con topología incorrecta. Puede seleccionar los elementos 
afectados y utilizar Mesh tools→ Invert para arreglar su topología. Invertir también puede ser útil para 
voltear elementos cáscara para que sus caras superiores queden todas del mismo lado. 

4.2.14 Eliminar ítems (Delete items) 

Para eliminar elementos, primero selecciónelos o seleccione cualquiera de sus caras y luego presione 
Supr. Esto también eliminará otros nodos del elemento que queden sin usar. Para borrar elementos sin 
eliminar sus nodos presione Ctrl + Supr. 

Para eliminar un componente junto con todos sus elementos y sus nodos, haga clic derecho en el 
componente en el esquema de árbol y seleccione Delete. 

Para eliminar nodos, selecciónelos y pulse Supr. 
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4.3 Convertir una malla 2D en una malla 3D 

Una vez creada una malla plana 2D, puede ser extruida, girada o solevada para crear un modelo 3D. 

4.3.1 Extruir (Extrude) 

 

 

 

Utilice Mesh tools→ Extrude... para crear una malla 3D sólida. 

 

Los nodos se extruyen en elementos línea. 

 

 

Los elementos línea y bordes de cáscaras se extruyen en cáscaras  

 

 

 

 

 

Las cáscaras y las caras de 
sólidos se extruyen en sólidos   

 

 

4.3.2 Rotar (Revolve) 

Use Mesh tools→ Revolve... para crear una malla 3D 
sólida. Cualquier nodo en el eje de revolución será 
duplicado para cada elemento, creando una malla 
desconectada Para solucionar este problema, use 
Mesh tools→ Merge nearby nodes después. 

Los nodos con Revolve se transforman en elementos 
line 3. 

 

 

Los elementos línea y bordes de cáscara se rotan en 
cáscaras.  

 

 

 

 Las cáscaras y las caras de sólidos se 
rotan en sólidos. 
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4.3.3 Barrer (Sweep) 

La herramienta barrer realiza una extrusión a lo largo de una ruta definida que puede ser curva o tener 
separación del elemento no uniforme. 

Después de iniciar la herramienta con Mesh tools→ Sweep..., seleccione las caras que definen el perfil 
correspondiente (profile faces) y pulse el botón Use selection. A continuación, seleccione las caras que 
definen la ruta (path faces) y luego pulse Use selection. Si las caras del perfil son planas serán barridas 
en sólidos. Si son bordes de cáscaras o líneas, serán barridas en cáscaras. La ruta debe consistir en 
elementos línea o bordes de cáscaras y debe tener un nodo final en común con el perfil. 

 

Si necesita controlar la orientación del perfil al ser extruido, por ejemplo, para hacer una hélice o eje 
torcido, puede definir un trazado guía (guide path). Cada cara del trazado guía determina la orientación 
del perfil en la cara correspondiente de la ruta. El trazado guía debe tener un nodo final en común con el 
perfil. Si contiene más caras que la ruta, las caras adicionales son ignoradas. Si contiene menos caras 
que la ruta, la orientación luego de la última cara guía continuará incambiada.  

 

Si la ruta o el trazado guía no se cruzan con el perfil, puede agregar un elemento de línea, conectándolos 
con una cara que sea parte del perfil. Esto dará como resultado elementos extra que deberá eliminar 
después de realizar el barrido. 
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4.3.4 Solevar (Loft) 

La herramienta solevar rellena el espacio entre 
dos perfiles con coincidencia de patrones nodales 
con elementos sólidos. Esto puede usarse para 
crear partes cónicas. El orden de los números de 
nodo debe ser idéntico en cada perfil con la única 
diferencia de un corrimiento constante. Puede 
utilizar Mesh tools→ Move/Copy para generar 
una 2ª malla que cumpla este requisito. 

 

4.4 Herramientas de refinamiento 

Un elemento individual no puede representar con exactitud un cambio 
complicado en las variables de campo a través suyo. Lo aproxima 
como una función constante, lineal o cuadrática. Por lo tanto, se 
necesitan elementos más pequeños en las regiones de la malla donde 
los resultados cambian rápidamente. 

Para determinar las áreas que necesitan refinamiento de malla en 
primer lugar tendrá que resolver una malla gruesa y mirar el gráfico de 
contorno de color de la solución. Si ve que la variable de campo está 
cambiando mucho dentro de un solo elemento, eso le indica que la 
zona puede necesitar más elementos. 

Comprobar la convergencia de malla es una parte crucial del análisis de elementos finitos, porque sin una 
estimación del error, los resultados pueden ser tremendamente equivocados. Para ello, debe resolver el 
mismo modelo con diferentes niveles de refinamiento de malla y anotar los valores de campo importantes 
para cada malla. Si un refinamiento adicional provoca sólo un cambio pequeño en los resultados, tales 
como un 3%, entonces se dice que han convergido y no se necesita refinamiento adicional. 

 

4.4.1 Refinar x2 (Refine x2) 

 

Mesh tools→Refine→ x2 o  reemplaza cada 
elemento con dos elementos a lo largo de cada borde. 
También inserta elementos de transición para que la parte 
de la malla refinada se conecte correctamente con la 
parte que permanece sin refinar. 

 

 

 

4.4.2 Refinar Personalizado (Refine custom) 

Mesh tools→ Refine→ Custom... Se utiliza para subdividir elementos 
especificando el número de subdivisiones en cada una de las tres direcciones. 
Si no hay elementos seleccionados, se utiliza toda la malla. 

 

 

4.4.3 Refinamiento x3 (sólo elementos 1D/2D) (Refine x3) 

Mesh tools→ Refine→ x3 (Refine x3) refina los nodos o elementos seleccionados subdividiendo cada 
elemento en tres elementos en cada dirección. Puede usarse con elementos line2/3, tri3/6 y quad4/8. 
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4.4.4 Desrefinar x2 (Unrefine x2) 

Mesh tools→ Refine→ Unrefine x2 Invierte el efecto de refinar x2 aplicado globalmente para producir la 
malla original más gruesa. Admite todas las formas excepto elemento pirámide y cuña (pyr5, pyr13, 
wedge6, wedge15). También se pueden desrefinar otras mallas estructuradas si sus elementos tienen la 
misma topología. 

Las cargas y restricciones, selecciones nombradas y componentes se mantienen donde todos sus 
elementos o caras forman parte de un único elemento o cara desrefinado. 

El algoritmo desrefinar requiere un nodo de esquina para empezar. Una esquina aquí es un nodo que 
utiliza sólo un elemento de la misma forma. Algunas mallas no tienen esquinas, como un cilindro o esfera. 
En estos casos, seleccione un subconjunto de los elementos que tiene una esquina y desrefínelo primero. 
A continuación, seleccione los elementos restantes (Edit→ Invert selection) y desrefine como se muestra 
a continuación. 

 

Si la malla tiene una densidad diferente a lo largo de cada borde, tales como los producidos con 
Refine→ Custom, use Mesh tools→ Refine→ Custom en algunos de los elementos de modo que 
cada borde de una región tenga 2n elementos, a continuación, aplique Mesh tools→ Unrefine x2 n 
veces como se muestra a continuación. 

 

4.4.5  Cambiar forma de elemento (Change element shape) 

A menudo los elementos de mayor orden son más eficientes. Convierta entre 
elementos lineales y cuadráticos usando Mesh tools→ Change element 
shape... 

También puede remplazar algunas formas de elementos con patrones de 
formas diferentes como convertir un cuadrilátero en dos triángulos. Las posibles formas de elemento 
serán activadas o desactivadas según las formas de elementos presentes, de modo que es posible que 
tenga que repetir este paso para obtener la forma final deseada. 

 

4.5 Calcado de una imagen 

Si usted tiene una imagen de una proyección (jpg, png o bmp) de una pieza, puede abrirla con Mecway y 
se mostrará en el fondo de uno de los 3 planos de coordenadas para que pueda colocar manualmente 
los nodos en las ubicaciones correctas. El archivo de imagen se vinculará al modelo en lugar de ser 
incrustados. Si mueve el archivo liml, debe mover las imágenes con él. 
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Por ejemplo, para trazar un contorno 3D desde un dibujo de proyección ortográfica de 3 vistas, importe 
(File→ Import) un archivo de imagen que contenga cada vista y coloque cada uno en una orientación 
diferente, eligiendo XY, YZ o ZX plane en el cuadro de diálogo que aparece. Si una imagen está 
desalineada, puede ajustar su posición haciendo clic con el botón derecho del ratón en el nombre del 
archivo en el esquema de árbol e introducir una distancia de Horizontal offset (hacia la derecha) o 
Vertical offset (hacia arriba). Después de que las imágenes se configuren, cambie a una vista ortogonal 
haciendo clic en la flecha de orientación de la tríada y use la herramienta New element o New node para 
colocar los nodos mediante clics del ratón. 

 

4.6 Simetría 

 

 

Si la geometría, cargas y restricciones son simétricos 
(simetría de espejo), un modelo puede reducirse a la 
mitad o la cuarta parte.  

 

 

Al tomar ventaja de la simetría de espejo se deben imponer restricciones en el plano de simetría. En el 
análisis estático los nodos en el plano de simetría deben ser restringidos para que no se mueva fuera de 
ese plano de lo contrario ocurrirá una brecha o penetración que en realidad no puede existir en el modelo 
completo. Para elementos con grados de libertad de rotación como cáscaras y vigas, cada nodo que se 
encuentra en el plano de simetría debe restringirse a no tener rotación alrededor de cualquiera de los dos 
ejes que se encuentran en el plano de simetría. En el análisis térmico no debe haber flujo de calor a través 
de un plano de simetría, que es una condición que se aplican automáticamente cuando no se especifican 
otras condiciones de contorno. El mismo concepto se extiende a flujo de corriente continua. 

Tenga cuidado al suponer simetría de espejo para problemas de frecuencia o de pandeo porque se 
perderán modos no simétricos. 

La Simetría cíclica que se produce en turbinas, ventiladores, etc. puede ser aprovechada mediante el 
modelado de sólo un segmento que contenga la característica cíclica, en lugar de toda la vuelta. El patrón 
de nodos debe coincidir en ambos lados del segmento. 
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4.7 Información de malla 

4.7.1 Coordenadas nodales (Nodal co-ordinates) 

    Haga clic en un nodo para ver sus coordenadas. 

4.7.2 Longitud (Length) 

Active la herramienta Cinta métrica, haga clic y arrastre de un nodo a otro. 

Si se está viendo la solución cuando existen variables de campo de 
desplazamiento, también informa la distancia deformada añadiendo los 
desplazamientos a las coordenadas de nodo. 

4.7.3 Área de superficie (Surface área) 

Tools→ Surface area informa el área de la superficie de las caras seleccionadas. También informa el 
área después de la deformación si se está viendo la solución, ésta contiene variables de campo de 
desplazamiento y no es una forma modal. 

4.7.4 Volumen (Volume) 

Tools→ Volume informará el volumen de los elementos seleccionados. Si no hay elementos 
seleccionados, se mostrará el volumen de la malla completa. También informa el volumen después de la 
deformación si se está viendo la solución, ésta contiene variables de campo de desplazamiento y no es 
una forma modal. 

4.7.5 Masa (Mass) 

Tools → Mass calcula la masa del modelo o los nodos o elementos seleccionados. Incluye masa de 
densidad y puntuales. 

4.7.6 Centro de masa (Center of mass) 

Tools → Center of mass muestra el centro de masa (centro de gravedad) del modelo o los nodos o 

elementos seleccionados. Incluye tanto la densidad como la masa puntual. 

4.7.7 Encontrar elementos duplicados 

A veces, dos o más elementos comparten los mismos nodos, por lo que se ven como uno solo y causan 
una rigidez inesperadamente alta u otros errores. Tools → Find duplicate elements busca elementos 
que tienen mutuamente todos sus nodos de esquina pertenecientes a otro elemento. Selecciona todos 
los elementos adicionales para que se pueda ver dónde están y borrarlos con la tecla Supr. 

4.8 Errores de modelado 

Los resultados sólo pueden ser tan exactos como el modelo. Use estimaciones aproximadas de cálculos 
a mano, experimentos o la experiencia para comprobar si los resultados son o no razonables. Si los 
resultados no son los esperados, el modelo puede tener errores graves que hay que identificar. 
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4.8.1 Malla demasiado gruesa  

 

La solución de elementos finitos es más 
precisa a medida que se refina la malla. 
Una forma eficiente de refinar una malla es 
concentrar el refinamiento de malla en 
aquellas áreas donde se puede mejorar la 
precisión, dejando inalteradas las zonas 
que ya son exactas. 

Usted tendrá que ejecutar primero al menos 
un modelo para identificar las áreas donde 
los valores están cambiando mucho y las áreas donde los valores se 

mantienen más o menos igual. El segundo será su modelo refinado.  

Refine las áreas donde ve grandes cambios en las variables de campo. No refine áreas donde los valores 
son más o menos los mismos; esto sólo aumentará el tamaño del modelo. 

4.8.2 Elección incorrecta de elementos 

Problemas de flexión con geometrías tipo placas, como paredes, donde el espesor es inferior a sus otras 
dimensiones, deben ser modelados con elementos cáscara o elementos sólidos cuadráticos como el 
hex20 o tet10. Los elementos cáscara, viga y membrana no deben usarse cuando sus supuestos 
simplificados no se aplican. Por ejemplo, vigas o cáscaras que son demasiado gruesas, membranas que 
son demasiado gruesas para estrés plano y demasiado delgadas para deformación plana. En cada uno 
de estos casos deben utilizarse elementos sólidos. 

 

4.8.3 Elementos lineales 

Los elementos lineales (elementos sin nodos intermedios) son demasiado 
rígidos a la flexión, por lo que normalmente deben ser refinados más que los 
elementos cuadráticos (elementos con nodos intermedios) para que los 
resultados converjan. 

 

4.8.4 Elementos gravemente distorsionados 

Las formas de elemento compactas y regulares dan la mayor precisión. El triángulo ideal es equilátero, el 
cuadrilátero ideal es cuadrado, el hexaedro ideal es un cubo, etc. Las distorsiones tienden a reducir la 
precisión, haciendo que el elemento sea más rígido de lo que debería ser, degradando generalmente las 
tensiones más que los desplazamientos. Sin embargo, distorsiones leves a moderadas no tienen efecto 
apreciable sobre la exactitud. La realidad es que ocurrirán distorsiones de forma en el modelado de EF 
porque es imposible representar la geometría estructural con elementos de forma perfecta. El deterioro 
en la precisión ocurrirá sólo en las proximidades del elemento mal formado y no se propagará a través 
del modelo (principio de St. Venant).  

 

Evite grandes relaciones de aspecto. Una relación de largo a ancho generalmente 
no debe ser mayor a 3. 

 

Elementos sesgados. El ángulo de sesgado generalmente no debe superar 30 
grados. 

  

Los cuadriláteros no deben parecer casi como triángulos. 
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Evite lados fuertemente curvos en elementos cuadráticos. 

   

 

Nodos intermedios muy descentrados. 

 

Si un elemento está demasiado distorsionado para resolver, por lo general se muestra con 
una cruz roja. Esto sucede si está invertido, se auto-intersecta o está colapsado. 

 

Si estos elementos defectuosos aparecen después de mallar un archivo STEP, suelen ser elementos 
cuadráticos con bordes demasiado curvados. En ese caso, active Enderezar elementos defectuosos 

(Straighten bad elements) en Geometry → filename → Meshing Parameters y vuelva a generar la 

malla. 

4.8.5 Discontinuidades de malla 

El tamaño de los elementos no debe cambiar abruptamente de fino a grueso. Debe haber una transición 
gradual. 

    

 

Los nodos no pueden conectarse a bordes de elementos. Esto redundará en 
huecos y penetraciones que no ocurren en la realidad.  

 

 

Los elementos lineales (sin nodos intermedios) no deben estar conectados 
a nodos intermedios de elementos cuadráticos, porque el borde del 
elemento cuadrático deforma cuadráticamente mientras que el borde del 
elemento lineal deforma linealmente. 

 

 

Los nodos esquinas de elementos cuadráticos no deben conectarse a nodos 
intermedios. Aunque ambos bordes deforman cuadráticamente, no lo hacen de 
la misma forma. 
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Evite utilizar elementos lineales junto a elementos cuadráticos pues el nodo 
intermedio provocará una brecha o penetración con el elemento lineal.  

 

 

Ninguno de estos errores es fatal. Sólo causará discontinuidades en los 
resultados que no deben ser considerados presentes en la pieza real. Estos efectos son localizados y no 
se propagan a través de la malla. También puede utilizar contacto unido para conectar mallas no 
conformes sin causar los problemas descritos anteriormente. 

4.8.6 Restricciones incorrectas 

Los soportes fijos darán como resultado menos deformación que los soportes simples que permitan al 
material moverse dentro del plano de soporte. 

4.8.7 Movimiento de cuerpo rígido 

En análisis estático, para que una estructura se tense debe evitarse todo movimiento de cuerpo rígido. 
Para problemas 2D los movimientos de cuerpo rígido son dos traslaciones (a lo largo de los ejes X e Y) y 
uno de rotación (sobre el eje Z). Para problemas 3D hay tres translaciones (a lo largo de los ejes X, Y y 
Z) y tres rotaciones (sobre los ejes X, Y y Z). 

El movimiento del cuerpo rígido puede eliminarse aplicando restricciones tales como Soporte fijo (Fixed 
support), Desplazamiento (Displacement) y Rotación de nodo (Node rotation). 

Los análisis de frecuencia y respuesta dinámica no necesitan tener todos sus movimientos de cuerpo 
rígido eliminados. Sin embargo, los primeros modos serían modos de cuerpo rígido. Por ejemplo, si no se 
aplica ninguna restricción en un problema de frecuencia, entonces los primeros 6 modos sería para los 6 
movimientos de cuerpo rígido. Los modos del 7 en adelante serán modos de deformación de la estructura. 
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5 Capítulo 5 

Modelos CAD 

5.1 Introducción 

Mecway puede abrir archivos STEP que puede ser la salida de la mayoría de las aplicaciones CAD. 
Muestra las piezas y puede generar una malla de ellos (automallador). En el grupo Geometry aparecen 
enlaces a los modelos CAD en el esquema de árbol. Cada elemento de geometría en este grupo debe 
contener una sola pieza por lo que se debe dividir los ensambles en un archivo separado para cada parte. 
Hay una herramienta, File→ Split STEP assembly para hacer esto. Si desea agregar un archivo CAD 
sin sustituir el modelo actualmente abierto, utilice File→ Import en lugar de Open. 

Los archivos con formato de estéreo litografía (STL) también pueden ser abiertos y guardados por 
Mecway. Un archivo STL sólo contiene un conjunto de triángulos, de manera que se importan como 
elementos tri3 en Mecway sin hacer automallado. Normalmente, los ficheros STL generados por 
aplicaciones CAD contienen elementos altamente distorsionado por lo que debe utilizar Automesh 3D 
desde el menú Mesh tools para mejorar la forma y convertir las cáscaras en elementos sólidos. 

 

5.2 Cargas y restricciones 

Para archivos importados STEP, las cargas y restricciones deberían aplicarse a las superficies de la 
geometría en lugar de la malla de forma que queden vinculadas a la geometría y se pueda regenerar la 
malla sin perderlos. Para ello, cambie la 
vista haciendo clic en Geometry en el 
esquema de árbol y, a continuación, 
haga clic derecho en una superficie y 
seleccione Loads & Constraints. 

Para seleccionar varias superficies para 
una sola carga o restricción, mantenga 
presionada la tecla Ctrl y haga clic en 
las superficies. 

 

5.3 Mallado 

Parámetros de mallado (Meshing parameters) permite el refinamiento local (Local refinements) o global 
limitando el tamaño máximo de elemento (Max. Element size) dentro de regiones esféricas o en toda la 
geometría. También puede controlarse el gradiente de tamaño (Size Grading) de los elementos. Un 
gradiente de tamaño agresivo significa que cada elemento puede ser mucho más grande o más pequeño 
que sus vecinos inmediatos produciendo a una baja densidad de malla en grandes regiones sin rasgos 
distintivos y una alta densidad cerca de detalles pequeños. Un gradiente de tamaño gradual significa que 
cada elemento debe ser de un tamaño similar a sus vecinos inmediatos. 
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La opción Fit midside nodes to 
geometry hace que los nodos 
intermedios de elementos 
cuadráticos se ubiquen en la 
superficie de la geometría en lugar 
de en los puntos medios de los 
nodos esquina. Esto normalmente 
mejora la precisión, pero a veces el 
nodo intermedio se encuentra 
demasiado lejos del punto medio y 
produce un elemento malformado que da errónea una alta tensión o 
falla al resolver. Para excluir el ajuste de estos elementos a la 
geometría, active Enderezar elementos defectuosos (Straighten 
bad elements). 

Para generar una malla de cáscaras, marque la opción Surface mesh 
bajo Meshing parameters. Si el archivo STEP contiene sólo 
superficies, esto puede funcionar directamente. Si contiene un cuerpo 
sólido, producirá elementos cáscara en la forma de la superficie del 
cuerpo sólido. 

 

5.4 Gmsh 

Puede utilizar el mallador de código abierto Gmsh desde Mecway. Éste suele ser más rápido y puede 
mallar algunos archivos que el mallador NetGen incorporado no puede. Descargue e instale Gmsh, luego 
establezca su ruta en Herramientas → Opciones → Gmsh. Puede utilizarlo seleccionando la opción 
Gmsh en Meshing parameters. 

5.5 Ensamblajes 

Sólo se permite un único objeto en cada archivo CAD. Para modelar un ensamblaje, importe cada parte 
como un archivo independiente, a continuación, utilice una restricción de contacto unido (Bonded contact) 
para unir sus superficies adyacentes. Al abrir los archivos con el comando File→ Import o Geometry→ 
Import CAD file, puede seleccionar varios archivos a la vez, mantenga presionada la tecla Ctrl mientras 
los selecciona. 

5.6 Alibre Design 

Si tiene instalada y licenciada la versiones 25-28 de Alibre Design o algunos otros instalados y cion 
licencia, puede abrir el ensamblaje (. AD_ASM), parte (. AD_PRT) o pieza de chapa metálica (. AD_SMP) 
directamente en Mecway. En el caso de los ensamblajes, se importa el árbol de ensamblajes para que 
pueda mallar cada pieza o subensamblaje de forma independiente o todos juntos. Es solo para geometría 
sólida, no para piezas de superficie. 

Para configurar el soporte de Alibre Design, clique Link to Alibre Design or Atom3D … en Tools→

Options →Alibre. Seleccione una de las versiones instaladas mostradas en la lista y clique OK. 
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6 Capítulo 6 

Tipos de análisis 

El tipo de análisis determina qué fenómenos físicos son modelados. Mecway 
arranca con 3D estática como predeterminado. Haga doble clic en Analysis o 
haga clic derecho y seleccione Analysis settings para cambiar a otro tipo de 
análisis como térmico o de frecuencia. 

6.1 Estático 

Análisis estático considera la deformación y el estrés en estado estacionario en una estructura cuyo 
material tiene una relación esfuerzo-deformación lineal. 

Para 3D, puede también modelar campos electrostáticos en material dieléctrico aislante. En este caso, 
cada nodo tiene un GDL de potencial eléctrico, de manera que el potencial eléctrico debe restringirse al 
menos en un nodo para garantizar una solución única. El Solucionador utiliza entonces el valor del campo 
potencial eléctrico para obtener el campo eléctrico y la densidad de flujo. 

6.1.1 Estático 2D (Static 2D) 

En análisis estático 2D, todos los nodos deben estar en el plano XY porque el solucionador ignora las 
coordenadas Z. Cada nodo tiene 2 o 3 GDL: 

Los nodos de vigas tienen desplazamiento en X, desplazamiento en Y y rotación alrededor de Z, mientras 
que los nodos de elementos planos, barra y resorte tienen solo los dos GDL de desplazamiento. 

6.1.2 Estático 3D (Static 3D) 

En el análisis estático 3D, los elementos sólidos, barra y resorte tienen 3 GDL en cada nodo: 
desplazamiento en X, Y y Z. Las cáscaras y vigas tienen 6 GDL en cada nodo: 3 desplazamientos y 
también rotación sobre X, Y y Z. Puede combinar todos los diferentes tipos de elementos en el mismo 
modelo. 

Efecto piezoeléctrico 

Los elementos sólidos pueden incorporar el efecto piezoeléctrico en análisis estático 3D. Para utilizarlo, 
debe especificar 3 propiedades del material: 

• Elasticidad - ya sea como una matriz de rigidez del material de 6x6, una matriz de cumplimiento 
de 6x6, 9 constantes ortotrópicas o módulo de Young isótropo y coeficiente de Poisson. Estos se 
miden con campo eléctrico constante (cortocircuito). 

• Permisividad - ya sea una matriz de 3x3, 3 constantes ortotrópicas o una constante isótropa. 
Pueden medirse en tensión constante o estrés constante. 

• Constantes de acoplamiento piezoeléctrico - sea una matriz de estrés (e) de 3x6 o una matriz de 
deformación (d) de 3x6 

Las matrices con términos de cizalladura están en forma Voigt, ordenadas mediante el popular mapeo de 
índices tensoriales 11,22,33,23,31,12 a índices de matriz 1,2,3,4,5,6, respectivamente. Precaución: otros 
programas usan diferentes convenciones de ordenamiento, por lo que puede ser necesario intercambiar 
filas y columnas si se transcriben datos de ellos. 

El efecto piezoeléctrico no puede utilizarse en el mismo modelo que el estrés térmico o simetría cíclica. 
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6.1.3 Estático axisimétrico (Static Axisymmetric) 

Aquí solo se pueden usar elementos planos y se tratarán como elementos axisimétricos. El eje Y es el 
eje de simetría y el eje X es la dirección radial. Cada nodo debe estar en los dos cuadrantes X positivos 
del plano XY y tener coordenadas Z cero. 

Todos los nodos tienen dos GDL: desplazamiento en X y desplazamiento en Y. 

6.2 Estático no lineal 3D (Nonlinear Static 3D) 

6.2.1 Capacidades 

El análisis estático no lineal puede modelar comportamientos más complejos que el análisis estático lineal. 
Permite que el desplazamiento sea una función no lineal de la carga mientras que, en análisis lineal, el 
desplazamiento de cada nodo está siempre alineado y es proporcional a la carga aplicada. Esta mayor 
capacidad viene a expensas de un mayor tiempo de resolución. Sólo está disponible con el solucionador 
CCX. Algunos ejemplos donde el análisis no lineal es útil son: 

Grandes desplazamientos y rotaciones. Por ejemplo, una tira delgada 
puede ser enrollada en forma circular o los miembros de un varillaje 
mecánico pueden rotar a través de diferentes configuraciones. 

Acción de membrana. Una placa plana 
inicialmente fijada en los bordes y 
soportando una carga de presión se 
deformará a una forma curva que se vuelve 
más rígida debido al estrés de membrana en 
la placa. 

Contacto entre partes 

Materiales plásticos e hiperelásticos. 

Estructuras precargadas. Por ejemplo, 
una viga vertical colgando bajo la influencia 
de la gravedad está en tensión. Esto le da 
una mayor rigidez lateral que la misma viga 
orientada horizontalmente. 

Cables. Un cable o cuerda doblándose bajo el efecto de la gravedad tiene una rigidez flexional que es 
función de su fuerza tensora y casi independiente de las propiedades del material. Este es un concepto 
similar al de la acción de la membrana. Un cable también puede tener cero o casi nula rigidez a la 
compresión al doblarse, pero una gran rigidez a la tensión. Si utiliza una cadena de elementos barra para 
modelar un cable, debe ser inicialmente recta y bajo tensión para evitar movimiento del cuerpo rígido. 

Pandeo son posibles casos de pandeo más generales que con análisis lineal de pandeo. Por ejemplo, 
una carga descentrada sobre una columna de Euler o una estructura doblada inicialmente puede 
experimentar una combinación de flexión y pandeo. Una estructura también puede experimentar grandes 
desplazamientos o rotaciones antes de llegar a una configuración en la que se vuelve inestable y entonces 
pandearse. Mecway con CCX no puede modelar la respuesta post-pandeo de cambio instantáneo. 

Cargas dependientes de la deformación (cargas seguidoras). Por ejemplo, una carga de presión 
aplica una presión normal constante, lo que significa que la fuerza total cambia si el área o la orientación 
de la superficie cambian. 

Carga dependiente del tiempo. Las cargas pueden cambiar con el tiempo o encenderse y apagarse en 
diferentes momentos. 

6.2.2 Uso 

No son necesarios ajustes especiales para utilizar análisis no lineal en Mecway. Sólo cambiar el tipo de 
análisis bajo Analysis→ Edit y seleccionar el solucionador CCX. 

Si desea cargas dependientes del tiempo marque la casilla Quasi-static y especifique el período de 
tiempo (Time period) y el tamaño de los escalones de tiempo (Time step) bajo Analysis→ Edit. El tiempo 
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aquí es una pseudovariable que sólo se usa para controlar la secuencia de las cargas aplicadas. No hay 
efectos dependientes del tiempo como la inercia o arrastre que se modelen. 

Con Quasi-static desactivado, la mayoría de las cargas se incrementan automáticamente en rampa 
desde cero y solo se muestra en el postprocesador la solución final con la carga completa. Con Quasi-
static activado, las cargas que se especifican como constantes no se incrementan y debe definir 
explícitamente cualquier dependencia de tiempo requerida mediante fórmulas o tablas. 

6.2.3 Fallas de convergencia 

Cuando el solucionador falla en converger, hay varios cursos de acción posibles: 

• Asegúrese de que haya suficientes restricciones para evitar movimiento de cuerpo rígido en cada 
paso de tiempo. Los contactos pueden estar abiertos inicialmente, por lo que no confíe en ellos 
para actuar como restricciones contra movimiento de cuerpo rígido. Para las piezas que solo están 
soportadas por contacto, agregue resortes débiles artificiales para sostenerlos suavemente hasta 
que los contactos se cierren. Puede hacer esto usando soporte elástico. 

• Puede obtener información sobre cómo se producen los fallos activando la función Quasi-static y 
definiendo las cargas como fórmulas en función del tiempo (t) para que aumenten gradualmente 
a lo largo del período. Eso mostrará la solución convergente hasta la carga en la que falla y es 
posible que vea un desplazamiento inesperado. 

• Si el modelo contiene muchas características no lineales, elimine o elimine temporalmente algunas 
de ellas para aislar la causa del problema. 

• Active Automatic time stepping en Analysis settings. 

6.3 Frecuencia 

Se llamaba Vibración Modal 3D en las versiones 1-22 de Mecway 

Las vibraciones libres de una estructura ocurren debido a sus propiedades elásticas cuando se perturba 
su estado de equilibrio. Estas vibraciones sólo ocurren en intervalos de frecuencias naturales. Las dos 
propiedades necesarias para el movimiento vibratorio son: 

• elasticidad que devuelve la estructura perturbada al estado de equilibrio, y 

• inercia (de la masa) de la estructura que hace se sobrepase el estado de equilibrio. 

El análisis de frecuencia encuentra las frecuencias naturales de una estructura y las correspondientes 
formas desviadas (formas modales). Esto se hace sin tener en cuenta cómo se inició la vibración. Todos 
los nodos se mueven con un movimiento armónico simple en fase entre sí y a la misma frecuencia. Por 
lo tanto, todos los desplazamientos dependientes del tiempo alcanzan sus magnitudes máximas en el 
mismo instante de tiempo. 

Las magnitudes de todas las variables de campo de la solución son sólo en relación a los otros valores 
en el mismo modo. Su magnitud absoluta no tiene significado. 

El número máximo de modos es igual al número de GDL no restringidos en el modelo. Por ejemplo, si un 
modelo es un único elemento hex8 con un soporte fijo aplicado a una cara, el número máximo de modos 
será 12, que es el número de GDL por nodo (3) multiplicado por el número de nodos no restringidos (4). 
A menos que exista una carga de choque, sólo los modos de las frecuencias más bajas son importantes 
en la respuesta estructural. 

Permite elementos 3D como sólidos, cáscaras y vigas. 

Rigidización por tensión. 

El estado de tensión de una estructura puede influir en sus modos de rigidez y vibración. Este efecto, 
llamado rigidización por tensión, es particularmente evidente en un cable o una cuerda de guitarra 
tensados. 

Cuando hay cargas presentes, Mecway primero realiza un análisis estático lineal para determinar el 
estado de tensión y luego procede con el análisis de frecuencia utilizando una matriz de rigidez modificada. 
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La tensión de tracción tiende a endurecer una estructura y aumentar las frecuencias naturales. La tensión 
de compresión tiende a reducir las frecuencias. Si la tensión de compresión es demasiado alta, puede 
exceder la carga de pandeo de una estructura. En estos casos, Mecway puede producir modos no físicos 
con frecuencias cero. 

Las siguientes características no están permitidas con cargas de rigidización por tensión: 

• Solucionador interno: cáscaras que utilizan material laminado. 

• Ambos solucionadores: restricciones de desplazamiento distintas de cero, restricciones de 
rotación distintas de cero, variables de campos de tensión en la solución 

 

Masa modal efectiva 

Solo solucionador interno. 

Advertencia: Actualmente no está disponible si hay MPCs en el modelo. Las MPCs existen para 
restricciones de desplazamiento y rotación que no están alineadas con los ejes globales, contacto unido, 
simetría cíclica, acoplamiento nodo-superficie y ecuaciones de restricción con más de una variable. 

Para cada modo, Mecway puede proporcionar la masa efectiva asociada a cada una de las seis 
direcciones de movimiento de cuerpos rígido: traslación y rotación alrededor de los ejes globales X, Y y 
Z. 

𝑚𝑒𝑓𝑓.𝑖 = 𝛤𝑖
2 

𝛤𝑖 es el factor de participación del modo i, definido como 

𝛤𝑖 = 𝜱𝒊
𝑻𝑴𝑹 

𝜱𝒊 es el vector propio normalizado respecto a la masa del modo i. 

𝑴 es la matriz de masa. 

𝑹 es el vector de desplazamientos que describe el movimiento del cuerpo rígido (traslación o rotación 
unitaria) 

Mecway también puede generar la fracción de masa efectiva modal (Modal effective mass fraction), 
que es la masa efectiva modal expresada como una facción de la masa libre total: 

𝑚𝑒𝑓𝑓.𝑖

𝑀𝑡𝑜𝑡
 

𝑀𝑡𝑜𝑡 es la masa libre total del movimiento de cuerpo rígido, definida como 

𝑀𝑡𝑜𝑡 = 𝑹𝑇𝑴𝑹 

Si se extrajeran todos los modos, la suma de sus fracciones de masa efectiva modal sería igual a 1. 

 

6.4 Respuesta Dinámica (Dynamic Response) 

Cuando una pieza o estructura está sometido a una carga que varía con el tiempo, las tensiones son 
amplificadas por una vibración inducida. El análisis de respuesta dinámica toma en cuenta esta vibración 
al calcular las tensiones y las deformaciones. También calcula las velocidades y aceleraciones en la 
respuesta del modelo a la vibración de la carga. 

Las condiciones iniciales predeterminadas son cero desplazamiento y velocidad. Puede imponer una 
aceleración inicial mediante la aplicación de una carga en el tiempo cero. Con el Solucionador CCX puede 
especificar desplazamientos iniciales. 

Paso de tiempo (Time step) afecta la precisión de la solución con paso de tiempo más pequeño serán 
más precisa. Puede elegir un tamaño de paso de tiempo adecuado realizando primero un análisis de 
frecuencia para determinar el período (1/f) del modo más alto de interés y, a partir de ese valor, resolver 
el problema repetidamente reduciéndolo hasta que la solución no cambia significativamente. El período 



37 

 

de tiempo (Time period) total debe ser, como mínimo, el período del modo de vibración más bajo. Esto 
garantiza que todos los modos oscilan al menos una vez. 

Se dispone de dos algoritmos de resolución - el valor predeterminado es el método de Newmark con 
aceleración promedio constante que es incondicionalmente estable. También puede elegir Mode 
superposition que busca primero las frecuencias naturales y formas de modo resolviendo un problema 
de autovalores y luego genera desplazamientos nodales, rotaciones y velocidades en cada etapa. Hay 
varias otras diferencias en la opción superposición de modos: 

• Debe elegir el número de modos a incluir. Normalmente sólo los primeros modos son importantes, 
pero para una carga de choque hasta 2/3 de ellos puede ser necesarios. Demasiados modos 
pueden enlentecer el Solucionador o causar que se quede sin memoria. 

• Puede ser mucho más rápido cuando se requiere un gran número de escalones. 

• No está disponible en el tipo de análisis Axisimétrico. 

• Los elementos amortiguador no pueden utilizarse. 

• Cualquier amortiguamiento de Rayleigh debe aplicarse uniformemente a todo el modelo en lugar 
de a elementos seleccionados, y deberán tener un coeficiente de amortiguamiento menor a 1 en 
todos los modos a resolver. 

• No se permite movimiento de cuerpo rígido por tanto el modelo debe ser totalmente restringido. 

• Las aceleraciones no se incluyen en los resultados. 

Para reducir la cantidad de pasos de tiempo almacenados en los resultados, especifique un valor entero 
para Generar solución en: cada __ pasos de tiempo (Generate solution at: every __ time steps). 
Esto reduce el uso de memoria y el tamaño del archivo. 

 

6.5 Respuesta Dinámica No Lineal 3D (Nonlinear Dynamic Response 3D) 

Es similar a la Respuesta Dinámica 3D pero permite comportamiento no lineal como grandes 
desplazamientos, contacto y materiales plásticos e hiperelásticos. Sólo puede usarse con los 
solucionadores CCX y OpenRadioss. 

 

6.6 Pandeo (Buckling) 

El análisis lineal de pandeo por autovalores, tal como el proporcionado por Mecway, sólo es capaz de 
describir el pandeo de bifurcación, con una relación carga-deflexión constante y simétrica como se 
muestra a continuación. Se utiliza como ejemplo una columna de Euler, pero la misma curva puede ser 
aplicada a otras estructuras. Aquí, la deflexión es el desplazamiento perpendicular a la dirección de la 
carga. Simétrico significa que la estructura debe ser igualmente capaz de pandearse en ambas 
direcciones opuestas. Además, el desplazamiento en cualquier dirección antes de pandeo debería ser 
insignificante. Si no se cumplen estas condiciones, se debe utilizar análisis estático no lineal en lugar de 
Pandeo lineal. 
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A medida que la carga aumenta de 0 a la carga crítica λc, la estructura permanece en su configuración 
original sin ninguna desviación. Cuando la carga alcanza λc, la deflexión es indeterminada y aumenta sin 
que aumente la carga. 

Algunas estructuras reales se aproximan a este comportamiento, mientras que otras son tan diferentes 
que el análisis de pandeo por autovalores no sirve de nada. Usted debe tener cuidado de asegurarse de 
que estas hipótesis son adecuadas al problema de lo contrario los factores de pandeo pueden ser 
manifiestamente erróneos incluso si las formas de modos son razonables. 

Una clase importante de problemas para los cuales el análisis de pandeo por autovalores es generalmente 
inadecuado es la inestabilidad de punto límite. Aquí, la estructura de flexiona continuamente en una 
cantidad finita debido a una carga que aumenta, hasta que se alcanza un 'punto límite' de carga, donde 
"cambia instantáneamente" a una configuración diferente. Un ejemplo es un mecanismo de conmutador 
de palanca. 

Estas y otras estructuras que parecen ser problemas de pandeo son en realidad problemas generales no 
lineales. Otro ejemplo es el de una columna con carga axial excéntrica. La desviación no es cero para 
cualquier carga finita y no hay punto de bifurcación. 

El análisis de pandeo por autovalores supone que no hay ningún tipo de imperfección en el material o la 
carga. Por eso, no es conservador y típicamente sobrestima las verdaderas cargas de pandeo. 

Cada modo tiene asociado un factor de pandeo. Se puede pensar en esto como un factor de seguridad. 
La inestabilidad se produce cuando todas las fuerzas se multiplican por el factor de pandeo. Para cargas 
térmicas, la inestabilidad se produce cuando la temperatura de cada nodo es 

Tcr = (Tnodo - Treferencia) × factor de pandeo + Treferencia. 

Las cargas de fuerza centrífuga son proporcionales al cuadrado de la velocidad angular. Por lo tanto, la 
velocidad angular crítica ωcr, es  

𝜔𝑐𝑟 = 𝜔𝑒𝑠𝑝𝑒𝑐𝑖𝑓𝑖𝑐𝑎𝑑𝑎 × √(𝑓𝑎𝑐𝑡𝑜𝑟 𝑑𝑒 𝑝𝑎𝑛𝑑𝑒𝑜). 

Puede ser conveniente especificar cargas unitarias en el modelo, de manera que el factor de pandeo es 
igual a la carga crítica para las fuerzas. Si algunas cargas son constantes, tales como la gravedad, 
entonces puede que necesite realizar varias iteraciones para ajustar las cargas desconocidas hasta que 
el factor de pandeo da 1. 

La forma de modo representa el movimiento relativo de los nodos inmediatamente después de que se 
produce el pandeo. La forma de equilibrio real de una estructura después de pandear no se puede 
encontrar mediante el análisis lineal de pandeo por autovalores. 

Debe especificar el número de modos (Number of modes) y un punto de cambio (Shift point) (solo 
con solucionador interno). El punto de cambio controla la estabilidad del solucionador de valores propios. 
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No debe ser cero y debe estar entre cero y el factor de pandeo más bajo. Cuanto más cerca esté de los 
factores de pandeo, mayor será su precisión. Sin embargo, no se encontrarán modos con factores de 
pandeo por debajo del punto de cambio. 

6.7 Térmico (Thermal) 

El análisis térmico usa un solo GDL de temperatura para cada nodo. El Solucionador calcula el flujo de 
calor a partir del campo de temperatura. Todos los tipos de análisis térmico son 3D. No obstante, puede 
hacer un modelo 2D mediante elementos cáscara de cualquier grosor sobre un plano. 

6.7.1 Estado estacionario térmico (Thermal Steady State) 

Encuentra la distribución de temperatura de equilibrio en una estructura después de que se haya disipado 
cualquier transitorio. 

6.7.2 Térmico transitorio (Thermal Transient) 

El análisis térmico transitorio produce una historia temporal del campo temperatura a través de una 
estructura. Puede especificar cargas y restricciones de temperatura dependientes del tiempo, así como 
una distribución de temperatura inicial. Para nodos sin temperatura inicial especificada, Mecway aplica un 
valor predeterminado de 0 K. 

Para reducir la cantidad de pasos de tiempo almacenados en los resultados, especifique un valor entero 
para Generar solución en: cada: __ pasos de tiempo (Generate solution at: every __ time steps). 
Esto reduce el uso de memoria y el tamaño del archivo. 

6.8 Flujo de corriente continua (DC Current Flow) 

Este tipo de análisis busca la distribución del potencial eléctrico (voltaje relativo a un cero arbitrario) a lo 
largo de una estructura. Este potencial eléctrico que es el único GDL en cada nodo, se utiliza para obtener 
la densidad de corriente, la disipación resistiva de potencia (calentamiento de Joule o calentamiento 
óhmico) y la corriente en elementos de resistencia. 

La conductividad puede depender de la temperatura en todos los tipos de elemento. Debe especificarse 
una temperatura en cada elemento de material dependiente de la temperatura. Pueden aplicarse 
temperaturas constantes escalonadas con la restricción Temperature o puede obtener un campo de 
temperatura no uniforme resolviendo primero el mismo modelo con análisis térmico y luego haciendo clic 
derecho en cargas y restricciones y seleccionando Transfer temperatures from solution. 

Para hacer el análisis térmico con la calentamiento de Joule, resuelva como flujo de la corriente de C.C., 
después cambie el tipo de análisis a análisis térmico y use Transfer internal heat generation from 
solution bajo cargas y restricciones, a continuación, resuelva el modelo térmico. 

 

6.9 Resonancia acústica 

Este tipo de análisis puede encontrar modos de vibración de un fluido en una cavidad cerrada como la 
resonancia del sonido en una sala o la cabina de un vehículo.  

6.9.1 Real 

Si no hay condiciones de contorno de impedancia en el modelo, los modos son soluciones a la ecuación 
de Helmholtz. 

p+(c)2p=0 

donde p es la presión relativa al ambiente,  es la frecuencia angular del modo, y c la velocidad del sonido 
en el medio. 

Se representa el medio en el interior de la cavidad con elementos continuos. Las caras externas sin ningún 
tipo de restricción se comportan como superficies duras con la siguiente condición de frontera de 
Neumann  
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p·n = 0 

 

 Donde n es el vector normal a la superficie 

Las formas de modos (presión) que se muestra en la solución son la presión acústica de las ondas 
estacionarias que oscilará sinusoidalmente con el tiempo. Sus amplitudes son arbitrarias. 

 

6.9.2 Compleja 

Si hay condiciones de contorno de impedancia en el modelo, Mecway resuelve un problema de valores 
propios complejos cuadrático y genera la frecuencia, tasa de decaimiento y amplitud compleja de presión 
(P) para cada modo. El escalado de P es arbitrario entre modos. 

 

 Presión acústica instantánea 𝑝(𝑡) = ℜ(𝑃𝑒(𝑖𝜔−𝜏)𝑡) 

 

 Amplitud compleja P 

 

 Frecuencia /(2) 

 

 Tasa de decaimiento  

 

Los modos que encuentra no son, en general, aquellos con las frecuencias más pequeñas (reales) sino 

con el módulo más pequeño de (i - ). Estos a veces son equivalentes, pero los modos con una alta tasa 
de decaimiento pueden omitirse si no solicita lo suficiente. También omite o duplica aleatoriamente los 
modos de cuerpo rígido de 0 Hz debido a error numérico. 

No se pueden utilizar contacto unido ni ecuaciones de restricción con análisis acústicos complejos. 
El problema de valores propios cuadrático que resuelve es 

 

(𝐾 + 𝜆𝐶 + 𝜆2𝑀)𝜙 = 0 

 

K es la matriz de rigidez 𝐾 = ∫ 
𝑉

∇𝑁𝑇∇𝑁𝑑𝑉 

C es la matriz de amortiguación 𝐶 = ∫ 
𝐴

𝜌

𝑍
𝑁𝑁𝑇𝑑𝐴 

M es la matriz de masa 𝑀 = ∫ 
𝑉

1

𝑐2
𝑁𝑁𝑇𝑑𝑉 

 

𝜆 = 𝑖𝜔 − 𝜏 

 

 es un vector de P en cada nodo. 
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7 Capítulo 7 

Elementos 

7.1 Elementos Planos Continuos 

 

Los elementos planos pueden ser utilizados para diversos tipos de análisis 2D para representar 
estructuras tales como placas planas o barras prismáticas. Sus nodos deben recaer en el plano XY. 

Los elementos cuadráticos (aquellos con nodos intermedios) pueden tener lados curvos parabólicos, 
aunque se muestran como rectos. Puede ver la forma curvada al refinar el elemento como se muestra a 
continuación. 

 

Los elementos cuadráticos normalmente funcionan mejor que los elementos lineales porque las variables 
de campo de los GDL pueden variar cuadráticamente a lo largo del elemento, mientras que los elementos 
lineales sólo permiten una variación lineal. En los análisis de tipo mecánico los elementos lineales, 
especialmente tri3 (triángulo de tensión constante), tienen la limitación adicional de ser demasiado rígidos 
a la flexión. Para modelar flexión con precisión con elementos lineales debe refinarse la malla de manera 
que cada elemento individual experimente principalmente tensión o compresión y menos flexión. 

7.2 Elementos Continuos Axisimétricos  

 

Tri3

 

Tri6

 

Quad4

 

Quad8

 

Tri3

 

Tri6

 

Quad4

 

Quad8
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Aunque parecen ser los mismos elementos continuos planos, cada elemento axisimétrico realmente 
representa todo un sólido circular como se muestra a continuación. El eje de simetría es el eje Y, los 
elementos deben estar ubicados en el plano X-Y con todas las coordenadas X no negativas. Los 
elementos axisimétrico sólo puede utilizarse en tipos de análisis el axisimétricos. 

    

En los tipos mecánicos de análisis, cada nodo tiene 2 GDL: desplazamiento en X (radial) y desplazamiento 
en Y (axial). Los nodos que se encuentran en X=0 deben ser restringidos a no ser desplazado en la 
dirección X porque físicamente es irrazonable que el material se superponga a sí mismo o que aparezca 
una brecha. Además, el movimiento del cuerpo rígido sólo puede producirse por traslación a lo largo del 
eje Y, de manera que sólo hay que restringir el movimiento traslacional en sentido Y para evitar el 
movimiento del cuerpo rígido. 

7.3 Elementos sólidos continuos  

 

 

Los elementos sólidos son los más generales y, en principio, se pueden usar para crear un modelo de 
estructura de cualquier forma. Sin embargo, algunas geometrías como vigas delgadas o placas pueden 
requerir un número tan grande de elementos sólidos que se agota la memoria de Solucionador o tarda 
demasiado tiempo. En estos casos, usted puede idealizar el modelo usando cáscaras, vigas, aletas, 
resistencias, etc., en lugar de elementos sólidos. 

Hex20 usualmente es el más preciso. Sin embargo, hex8 también funciona bien con los análisis de tipo 
mecánico. Utiliza una formulación de modo incompatible que está libre de bloqueo por cizallamiento y, 
por lo tanto, tiene una precisión mejorada en flexión en comparación con un elemento hexagonal estándar 
de 8 nodos. Es descrita en Análisis tridimensional estático y dinámico de estructuras: un enfoque físico 
con énfasis en la ingeniería sísmica de Edward L. Wilson. 

Tet4

 

Pyr5

 

Wedge6

 

Hex8

 

Tet10

 

Pyr13

 

Wedge15

 

Hex20
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7.4 Cáscara (Shell) 

 

Las cáscaras son elementos 3D que puede modelar el estrés, el calor o el flujo de corriente eléctrica en 
el plano del elemento, pero no a través de su espesor. Son útiles para piezas finas donde los elementos 
sólidos son demasiado caros computacionalmente o en lugar de elementos 2D donde estos no están 
disponibles. Algunas estructuras típicas modelados con elementos cáscara incluyen abrazaderas y 
armarios de chapa, plataformas metálicas delgadas, recipientes a presión, y piezas de carrocería de 
vehículos. 

7.4.1 Formulación 

En los tipos de análisis mecánico, los elementos de carcasas son los descritos en los siguientes 
documentos: 

1. Tri3: MITC3 (doi:10.1016/j.compstruc.2004.02.004) 

2. Tri6: MITC6-a (doi:10.1016/j.compstruc.2004.02.004) 

3. Quad4: MITC4 (doi:10.1108/eb023562) 

4. Quad8: MITC8 (doi:10.1002/nme.1620220312) 

Los elementos cuadriláteros (quad4 y quad8) son los más precisos y los elementos triangulares deben 

ser restringidos a áreas que no se pueden mallar con cuadriláteros. Los cuatro elementos evitan el 
bloqueo por corte y los elementos cuadráticos (tri6 y quad8) también evitan el bloqueo de membrana. 

Cada nodo tiene 6 GDL - Desplazamiento en X, Y y Z y rotación sobre X, Y y Z. Sin embargo, no hay GDL 
de taladro, lo que significa cada nodo es libre para girar sobre la normal a la cáscara y sólo es resistido 
por una pequeña rigidez arbitraria para asegurar la estabilidad numérica. 

Los GDL de rotación de las cáscaras significan que usted puede unir dos elementos cáscara por un borde 
común y se transmitirán los momentos de flexión entre ellos. Esto es distinto en los elementos sólidos 
que no pueden transmitir los momentos de flexión, cuando sólo están conectados por una arista. Si el 
borde recto de una cáscara se une al borde de un elemento sólido, entonces se forma una articulación. 
Para hacer una unión rígida, utilice contacto unido. 

Las cáscaras utilizan matrices de masa consistente con inercia rotacional ficticia casi cero en los nodos.  

7.4.2 La orientación de los ejes locales 

Cada elemento tiene un sistema de coordenadas de mano derecha, U, V, W que se utiliza para la 
orientación de materiales ortótropos y laminados y para mostrar algunos resultados de tensión. El eje W 
es normal a la superficie del elemento en cada punto. Puede definir la dirección del eje U especificando 
un vector en coordenadas globales X,Y,Z. La dirección del eje U es la proyección de este vector en el 
plano normal a W. Si no se especifica, la dirección predeterminada de este vector es paralela a la arista 
de los nodos 1 a 2, o de 1 a 3 para elementos lineales o cuadráticos respectivamente. El eje V es 
mutuamente perpendicular a U y W. 

Puede especificar la orientación en dos lugares: Element properties y Loads & Constraints→ Element 

orientation.. Especificar orientación mediante Loads & Constraints le permite ingresar una fórmula para 
definir la orientación como una función de la posición central del elemento, y se aplica a una selección de 
elementos. La orientación especificada a través de Element propertie se aplica a elementos individuales 
y, por lo general, no es tan conveniente a menos que importe datos con una orientación diferente para 
cada elemento. 

Tri3

 

Tri6

 

Quad4

 

Quad8
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Con el solucionador CCX, las orientaciones de los elementos no están disponibles en la solución si hay 
elementos de carcasa laminada. 

7.4.3 Desplazamiento 

De forma predeterminada, los nodos de un elemento cáscara está situada en su superficie media. Sin 
embargo, en el análisis estático, puede especificar Element offset en Loads & Constraints para localizar 
el plano medio lejos de los nodos. Este es una distancia que se desplaza la cáscara en la dirección +W 
en su sistema local de coordenadas. Las cargas se siguen transmitiendo al elemento en la ubicación de 
los nodos, por tanto, las fuerzas extensionales pueden resultar en flexión y viceversa. 

 

Offset = 0      Offset > 0. 

Una cáscara desplazada se comporta como si hubiera vigas rígidas conectadas entre los nodos y la 
cáscara situada en la superficie media. 

 

El desplazamiento de una carcasa curva cambia su forma y tamaño porque la dirección +W varía en la 
superficie del elemento. Esto afecta a su rigidez y las cargas que dependen del área de la superficie o 
volumen. 

Con el solucionador interno, Desplazamiento (Displacement), Simetría cíclica (Cyclic symmetry), 
Contacto (Contact) con restricciones tipo Ecuaciones de restricción (Constraint equations) y 
Acoplamiento nodo-superficie (Node-surface coupling) sin acoplamiento de GDL rotacionales de 
nodos de superficie (Couple surface node rotational DOFs) no se pueden aplicar a caras o elementos 
cáscara desplazados. Utilice sus nodos en su lugar, siempre que sea posible. 

7.4.4 Elementos curvos 

Los elementos de la cáscara se pueden curvar fuera de su plano, pero el radio de curvatura debe ser 
grande en comparación con el grosor. Solo los elementos cuadráticos (tri6 y quad8) pueden representar 
bien la curvatura porque tienen suficientes nodos a lo largo de cada borde para definir una forma 
cuadrática. 

7.4.5 Resultados 

Mecway informa de la tensión y la deformación en la parte superior, media e inferior de cada elemento o 
capa laminada. La superficie superior es la que tiene coordenada W más positiva. Si selecciona el nodo 
del grupo Stress en el esquema de árbol, la gráfica muestra los tres valores simultáneamente en sus 
respectivas ubicaciones para no laminados o solo las dos superficies externas para laminados. Seleccione 
la rama superior, media o inferior para mostrar solo una. 

Momento por longitud y Fuerza por longitud son el momento y la fuerza resultante respectivamente. 
Están en referencia al sistema de coordenadas local del elemento y definidas como se muestra más abajo 
en elementos diferenciales dentro de un elemento cáscara. 
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7.5 Viga (Beam) 

  

 

Los elementos viga de Mecway usan la teoría de vigas de Euler lo que significa que se puede modelar la 
flexión de vigas delgadas, uniformes e isótropas. También tienen rigidez longitudinal y torsional, 
permitiéndoles actuar como columnas o ejes. Cada nodo tiene GDL tanto de desplazamiento como de 
rotación, de manera que pueden transmitir momentos de torsión y flexión momentos entre elementos. 

Se puede aplicar cargas y restricciones a las caras frontales o la cara lateral. 

Se puede definir una sección transversal arbitraria (General section) por sus propiedades geométricas o 
pueden utilizarse diversas formas predefinidas en función del tipo de análisis como se muestra en la tabla 
más abajo. 

Las formas de sección asimétricas (C, T, L) no tienen en cuenta que el centro de corte esté desplazado 
respecto al centroide, por lo que no pueden modelar correctamente el acoplamiento flexión-torsión. 

 

 

 

 

 

 

Line2 Line3 (CCX) 
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Solucionador interno 

Estático 3D 

Frecuencia 

 Respuesta Dinámica 3D 

C, T, I, Barra Rectangular, Tubo Rectangular, Barra Circular, Tubo 
Circular, Sección General 

Pandeo 
I, Barra Rectangular, Tubo Rectangular, Barra Circular, Tubo Circular, 

Sección General 

Estático 2D 
C, T, I, Barra Rectangular, Tubo Rectangular, Barra Circular, Tubo 

Circular, Sección General 

Respuesta Dinámica 2D Sección general 

 

Solucionador CCX 

Estático 3D 

Estático no lineal 3D 

Frecuencia 

 Respuesta Dinámica 3D 

Respuesta Dinámica no 
lineal 3D 

Pandeo 

Barra Rectangular, Tubo Rectangular, Barra Circular, Tubo Circular 

 

Solucionador OpenRadioss 

Respuesta Dinámica no 
lineal 3D 

C, T, L. I, Barra Rectangular, Tubo Rectangular, Barra Circular, Tubo 
Circular, Sección General 

 

La orientación de la viga no puede definirse totalmente por las ubicaciones de los nodos solamente, por 
eso hay otras opciones para controlar cómo gira la sección transversal alrededor del eje longitudinal de 
la viga. Puede especificar esto en dos lugares: Element properties y Loads & Constraints → Element 
orientation. Especificar orientación a través de Loads & Constraints le permite ingresar una fórmula 
para definir la orientación como una función de la posición central del elemento, y se aplica a una selección 
de elementos. 

La orientación especificada a través de Element properties se aplica a elementos individuales y, por lo 
general, no es tan conveniente a menos que importe datos con una orientación diferente para cada 
elemento. 

En 3D, el sistema de coordenadas local del elemento, U, V, W define la orientación de la sección 
transversal. 
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El eje U es paralelo a la longitud del elemento, el eje V es perpendicular a los ejes U y W es mutuamente 
perpendicular a U y V según W=U×V. Estas restricciones dejan el eje V libre para girar sobre el eje 
longitudinal del elemento. Hay dos opciones para definir la dirección del eje V: 

• Default / none. El eje V es perpendicular al eje Z global y paralelo al plano XY. Si el elemento es 
casi paralelo al eje Z (gradiente <0.01%), entonces el eje V también se hace paralelo al eje Y. 

• Direction of element V axis. El eje V puede ser definido por un vector en el sistema de 
coordenadas global X, Y, Z. El vector especificado podría no cumplir con el requisito de ser 
perpendicular al eje U, de modo que el eje V es la proyección de este vector sobre un plano 
perpendicular a U. Esto permite que casi cualquier vector se pueda utilizar siempre que no sea 
cero (0, 0, 0) ni paralelo a U. La magnitud del vector no es utilizada por Mecway. 

 

Tras definir el vector también puede aplicar una rotación adicional de V sobre U en un ángulo especificado 
(Rotate by angle). Esta característica es útil si conoce el ángulo en el que desea colocar la viga, pero no 
desea convertirlo manualmente en forma vectorial. También puede ser útil si desea especificar una 
dirección común de W para muchos elementos en diferentes orientaciones. Puede establecer el vector 
en la dirección de W y luego girarla -90°. 

En 2D, el sistema de coordenadas del elemento U, V y W queda totalmente definido por las ubicaciones 
de los nodos del elemento, con W paralelo al eje Z global y en la misma dirección. Puede voltear la sección 

al revés invirtiendo los nodos del elemento con Mesh tools → Invert. 

Los esfuerzos longitudinales (stress in element coordinates) se evalúan en cada uno de los 4 puntos 
predefinidos en la sección transversal y un punto de recuperación de esfuerzo definido por el usuario en 
coordenadas principales (Stress recovery point in principal coordinates). Estos valores de tensión se 
calculan solo a partir de la fuerza normal y los momentos flectores. No incorporan tensión de cizallamiento 
causada por torsión o fuerzas de corte. 

Las fuerzas y los momentos internos de la solución siguen la convención de signos que se muestra en el 
diagrama más abajo. 

 

 

En el caso de vigas 3D, puede mostrar estos valores como diagramas de esfuerzos cortantes o diagramas 
de momentos flectores superpuestos a la malla haciendo clic en el elemento de esfuerzo cortante (shear 
forcé) o momento flector (bending moment) en el esquema de árbol. Estos diagramas utilizan valores 
elementales si están disponibles (es decir, solucionador interno) o valores nodales en caso contrario (es 
decir, solucionador CCX). Con CCX, su orientación puede ser incorrecta si hay elementos de carcasa 
laminada presentes. 
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Debería evitar usar valores nodales para tensión, fuerzas y momentos internos porque se promedian a 
partir de los valores de cada elemento adyacente, por lo que pueden carecer de sentido si los elementos 
adyacentes tienen diferentes orientaciones, formas de sección, desplazamientos, etc. 

Con el solucionador CCX, las vigas aparecen con sección rectangular en la solución, independientemente 
de la forma real. Los valores de estrés solo son válidos en los nodos que se encuentran en la sección 
real. Para secciones circulares, eso es solo los nodos del lado medio de las caras finales. 

El solucionador CCX (2.23) tiene algunos errores con los elementos viga. Las restricciones de 
desplazamiento distintas de cero en las vigas pueden causar una tensión incorrecta, y en algunos casos 
las restricciones de GDL rotacionales o las cargas de momento en vigas que no son paralelas a ninguno 
de los 3 ejes globales se comportan incorrectamente. Mecway mostrará una advertencia en el esquema 
de árbol si se cumplen las condiciones para estos errores. 

7.5.1 Desplazamiento de vigas (Beam offset) 

Con Análisis Estático 3D (Static 3D) y el solucionador interno, una viga se puede desplazar en relación 
con sus posiciones de nodo utilizando Desplazamiento de elementos (vigas) (Element offset (beams)) 
en Cargas y restricciones. 

Desplazamiento (Displacement), Simetría cíclica (Cyclic symmetry), Contacto (Contact) con 
restricciones tipo Ecuaciones de restricción (Constraint equations) y Acoplamiento nodo-superficie 
(Node-surface coupling) sin acoplamiento de GDL rotacionales de nodos de superficie (Couple 
surface node rotational DOFs) no se pueden aplicar a caras o elementos viga desplazados. Utilice sus 
nodos en su lugar, siempre que sea posible. 

Las variables solución con valores elementales como fuerzas internas, momentos y tensión se localizan 
en la posición desplazada de su elemento. Las variables de solución con solo valores nodales como 
desplazamiento, rotación, fuerza y momento de reacción están en las posiciones de los nodos sin 
desplazar. 

7.6 Barra (Truss) 

 

Un elemento barra es una viga articulada en ambos extremos, de modo que sólo puede resistir las fuerzas 
de tracción o compresión axial sin rigidez a la flexión o torsional. Cada nodo tiene grados de libertad 
traslacional en direcciones X, Y y Z (en 3D). 

Los elementos barra pueden usarse para modelar estructuras reticulares donde no se produce flexión de 
los miembros individuales, así como para transmitir fuerzas entre objetos o crear uniones articuladas entre 
elementos viga o cáscara. 

Line2 
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Para convertir un elemento viga en una barra, seleccione los elementos que desee, haga clic con el botón 
derecho en uno de ellos, haga clic en Element properties y marque Truss. 

Sólo los modelos 3D pueden utilizar todas las formas de sección (C, T, L, I barra rectangular, tubo 
rectangular, barra circular, tubo circular y sección general) para armazones. En 2D Estático se deshabilita 
la Sección L, y en otros tipos de análisis sólo se puede usar la sección general. No es necesario especificar 
la orientación como en los elementos viga. 

7.7 Muelle (Spring) 

  

El elemento muelle tiene rigidez sólo en la dirección de su longitud y es articulada en sus extremos. Puede 
utilizarse en cualquier lugar en que un elemento puede usarse un elemento barra. Cada nodo tiene 2 o 3 
grados de libertad traslacional a lo largo de los ejes X, Y, Z en función del número de dimensiones (2D o 
3D). 

Puede definir un muelle aplicando el tipo de material mecánico Spring a un elemento line2. También 
puede especificar la constante de muelle, la longitud libre y el coeficiente de amortiguación viscosa. 

Spring constant k es la rigidez de la ley de Hooke 

F = -k u 

donde F es la fuerza ejercida por el muelle y u es el aumento en la longitud respecto a e la longitud libre. 

Un elemento de resorte se comporta de la misma forma que un elemento barra con densidad cero. El 
elemento barra equivalente satisface la ecuación 

Área transversal x módulo de Young = constante de muelle x longitud  

 

7.8 Amortiguador (Damper) 

  

Line2 

El elemento amortiguador tiene amortiguación sólo en la dirección de su longitud y está articulado en 
sus extremos. Cada nodo tiene 2 o 3 traslacionales grados de libertad a lo largo de los ejes X, Y y Z 
según el número de dimensiones (2D o 3D). Puede definir un amortiguador aplicando el tipo de material 
mecánico Damper a un elemento line2. 

Viscous damping coefficient (c) Provoca una fuerza de amortiguación 

𝐹 = −𝑐𝑢̇ 

Donde 𝑢̇ es la velocidad axial relativa de los dos nodos. 

 

Line2 

 



50 

 

7.9 Separación (Gap) 

Line2 

 

El elemento de separación es un contacto unilateral entre dos nodos. Para definir un elemento de 
separación, aplique el Tipo de material mecánico Gap a un elemento line2. 

Solo transmite la fuerza paralela a la dirección de la separación, que es la del eje U del elemento. La 
dirección U predeterminada va desde el nodo 1 del elemento hasta el nodo 2, pero en su lugar puede 
especificar una dirección arbitraria con element orientation. En cualquier caso, la dirección de la 
separación no gira con grandes desplazamientos. 

 

Especificar la dirección de la separación con element orientation permite: 

• Nodos coincidentes. 

• Desplazamiento lateral (normal a U) entre las posiciones de los nodos. Este desplazamiento no 
afecta a su comportamiento, pero debe ser pequeño porque el elemento de separación no 
transfiere momentos. 

• Comportamiento de solo tensión especificando una dirección de separación opuesta a la dirección 
desde el nodo 1 del elemento hasta el nodo 2. 

 

7.9.1 Solucionador interno 

Solo puede utilizarse con tipo de análisis estático 3D donde provoca una solución iterativa. 

La rigidez tiene el valor constante Stiffness of closed gap cuando la separación está cerrada y cero 
cuando está abierta. Para aproximarse a un contacto duro, Stiffness of closed gap debe ser típicamente 
un valor grande como 1e12 N/m. 

En la solución la variable de fuerza axial es la fuerza de tensión a través de la separación. No puede ser 
positiva porque la separación no tiene rigidez en tensión. 

 

7.9.2 Solucionador CCX 

Solo se puede utilizar con los tipos de análisis estático no lineal 3D y respuesta dinámica no lineal 3D. 

La rigidez es una función suave que se aproxima a una rigidez constante a medida que aumenta la 
penetración y a una fuerza constante a medida que aumenta la holgura. Debe especificarlas como los 
dos parámetros Stiffness of closed gap y Force of open gap. Para aproximarse al contacto duro, la 
rigidez del espacio cerrado debe ser grande como 1e12 N/m y Force of open gap debe ser pequeña 
como 1e-3 N. 

También puede definir una holgura inicial (Initial clearance) o un valor negativo para penetración inicial. 
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7.10 Sólo Tensión (Tension only) 

 

El elemento de solo tensión es una versión más limitada del elemento Gap. Sus diferencias son: La 
dirección de la separación es siempre desde el nodo 2 del elemento hasta el nodo 1 (opuesto al valor 
predeterminado del elemento Gap); los nodos no pueden ser coincidentes; la fuerza axial para una 
separación cerrada es positiva en lugar de negativa; la rigidez la separación cerrada está definida por el 
módulo de Young, el área de la sección transversal y la longitud; la tensión axial está disponible en la 
solución; Y solo se puede usar con el solucionador interno. 

El elemento de sólo tensión es un elemento de armadura que tiene una rigidez especificado cuando se 
cargan en tensión, pero rigidez nula cuando se comprime. Sólo se puede utilizar en el tipo de análisis 
Estático3D donde provoca una solución iterativa que puede tardar más que resolver sin elementos de 
sólo tensión. 

Para definir un elemento de sólo tensión, aplique el tipo de material mecánico Tension only a un elemento 
line2 y elija una de las formas de sección d en los tipos de material geométricos. También debe identificar 
el elemento como una barra. Para ello, seleccione los elementos que desee, haga clic con el botón 
derecho en uno de ellos, haga clic en Element properties y marque Truss. 

7.11 Aleta (Fin) 

 

La tasa de calor disipado por convección de una superficie se incrementa al aumentar la superficie de 
transferencia de calor con superficies extendidas llamadas aletas. Un ejemplo sencillo es una cuchara de 
metal se coloca en un vaso de agua caliente, el calor es conducido a través de la cuchara causando que 
el mango se caliente más que el aire circundante. El calor se transmite desde el mango de la cuchara al 
aire por convección. Asimismo, las aplicaciones industriales utilizar aletas en radiadores de automóviles, 
intercambiadores de calor de doble tubo, compresores y equipos electrónicos. 

Un elemento aleta modela la conducción de calor a lo largo de su longitud, pero en su anchura. También 
puede haber transferencia de calor por radiación y convección aplicada en sus caras laterales y/o frontales.  

7.12 Elemento de red fluida 

 

Este es un elemento especial para usar con convección forzada y el solucionador CCX. Representa el 
fluido que fluye y transfiere calor aguas abajo a lo largo de la red, así como por convección con elementos 
sólidos o de cáscara vecinos. No debe compartir nodos con ningún otro tipo de elemento. 

Se debe especificar el calor específico a presión constante del fluido (cp) como propiedad del material, y 
su caudal másico como una restricción en cada elemento de red de fluido. También se debe especificar 
la temperatura de entrada del fluido como una restricción de temperatura en los nodos más aguas arriba 
de la red. La posición del nodo de medio lado no importa, y las posiciones de los nodos finales solo son 
relevantes para determinar con qué caras están asociados en la convección forzada. 

 

Line2

 

Line2 
Line3 

Line3 
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7.13 Resistencia (Resistor) 

 

Line2 

Un elemento de resistencia tiene un cambio lineal de potencial en toda su longitud, de acuerdo a la ley 
de Ohm V=IR. Su resistencia puede definirse mediante la   propiedad Resistance del material Resistor, 
o por conductivity junto con la geometría de una viga. Pueden utilizarse cualquiera de las formas de 
sección uniforme (C, T, L, I barra rectangular, tubo rectangular, barra circular, tubo circular, sección 
general). Las resistencias pueden ser útiles para modelar circuitos eléctricos lineales, así como para la 
medición de valores de corriente en modelos 3D continuos o de cáscaras. Para encontrar la corriente que 
fluye a través de un objeto complejo, puede colocar un elemento de resistencia prácticamente sin 
resistencia en serie con el objeto. La solución entonces mostrará la corriente que fluye en la resistencia.  
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8 Capítulo 8 

Materiales 

Los elementos están diseñados para representar matemáticamente los diversos tipos de materiales 
tanto en sus propiedades físicas como sus formas geométricas. 

8.1 Biblioteca 

Mecway no incluye una base de datos de materiales, pero hacer una usted mismo. Cree un archivo vacío 
Mecway con sólo un material definido en él, entonces cuando necesite es material, ábralo utilizando 
Import en el menú File. Esto creará los materiales en el modelo abierto actualmente. 

Para facilitar la administración de dichos archivos, puede definir una ubicación común en File → Import 

from library → Set library location ... y cualquier archivo .liml que aparezca allí aparecerá en ese 

submenú, así como debajo del menú Assign material from library al hacer clic derecho en un 
componente. Estos archivos de biblioteca pueden contener otros datos, como mallas de partes comunes 
o fórmulas de solución. Un acceso directo para guardar un material individual en un nuevo archivo de 
biblioteca es el botón Save to library... en la ventana Material Properties. 

8.2 Definir un nuevo material 

 

Haga clic derecho en un componente en el esquema de árbol para Asignar 
nuevo material (Assign new material) 

 

 

8.3 Materiales mixtos 

 

A fin de tener más de un material diferente en un modelo, los elementos 
con diferentes materiales deben estar en diferentes componentes. 

 

 

 

8.4 Mezcla de Elementos 

Los distintos tipos de elemento se pueden mezclar en el 
mismo modelo, pero cada uno debe tener su propia 
definición de material porque sus propiedades geométricas 
no son las mismas. 
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8.5 Materiales anisótropos 

Los materiales ortótropos tienen propiedades mecánicas diferentes según direcciones que son 
perpendiculares entre sí. En Mecway se pueden utilizar materiales ortótropos en elementos sólidos 3D, o 
elementos membrana y cáscara 2D. En los elementos cáscara, un eje (W) está siempre en la dirección 
del espesor transversal (normal a la superficie). 

Existen dos convenciones para definir los coeficientes de Poisson ortótropos de materiales. Mecway 
define vxy como la relación negativa de la deformación en la dirección Y y la deformación en la dirección 
x, debido a la tensión en la dirección x. Esto se denomina a veces el coeficiente de Poisson principal. 
Algunas viejas fuentes de datos transponen los subíndices (coeficiente de Poisson menor). Puede 
comprobar que la convención de Mecway es la que se está usando asegurándose de que esta ecuación 
se cumple:𝜈𝑥𝑦 

𝜈𝑥𝑦

𝜈𝑦𝑥
=

𝐸𝑥

𝐸𝑦
 

Las direcciones de los ejes ortótropos son los ejes locales del elemento (U, V, W). Para elementos sólidos, 
estos son los mismos que los ejes globales X, Y y Z. por defecto. Puede cambiar este valor para cada 
elemento mediante la definición de los ejes U y V locales en Propiedades del elemento (Element 
properties) o bien en Cargas y restricciones→ Orientación de elemento (Loads & Constraints→ 
Element orientation). 

. La dirección que se especifique para el eje U es la misma dirección que el elemento va a utilizar. También 
debe especificar el eje V para definir plenamente la orientación en el espacio 3D. A menudo no es fácil 
elegir un eje V que sea perfectamente ortogonal al eje U así que Mecway obtendrá el eje V ortogonal al 
proyectar el vector que especifique en el plano normal al eje U. 

Los ejes locales de los elementos se pueden mostrar gráficamente usando el botón herramienta   con 
líneas rojas, verdes y azules que representan los ejes U, V y W, respectivamente. 

Los materiales anisótropos tienen propiedades mecánicas diferentes según direcciones arbitrarias que no 
son perpendiculares una a la otra. Puede utilizarlos con elementos sólidos en análisis tipo estático3D 
especificando una matriz de rigidez del material o una matriz de cumplimiento (matriz inversa de la matriz 
de rigidez del material). 

8.6 Propiedades dependientes de la temperatura 

Puede especificar valores de conductividades térmicas y calor específico dependientes de la temperatura. 
El Solucionador interpola linealmente entre los puntos de datos especificados. Si la temperatura está fuera 
del rango, el Solucionador utiliza el punto de datos más cercano en lugar de intentar extrapolar.  

8.7 Criterios de falla (Failure criteria) 

Si especifica un criterio de falla para un material con los tipos de análisis estático, o de respuesta dinámica, 
la solución incluye un factor de seguridad en la variable de campo. 

El criterio de falla Von Mises sólo puede utilizarse en elementos continuos 2D, axisimétricos, cáscara 3D 
y sólidos 3D. 

El criterio de falla Tsai-Wu sólo puede utilizarse con elementos cáscara 3D y se supone que el estrés es 
plano, ignorando cizalladura fuera del plano. Requiere 6 parámetros: resistencia a la tracción (tensile 
strength) y resistencia a la compresión (compressive strength) en dos direcciones, resistencia a la 
cizalladura (shear strength) y un coeficiente de interacción (interaction coefficient) F*12 entre -1 y 1. Para 
materiales isótropos y ortótropos, el factor de seguridad se evalúa en ambos lados de la cáscara (superior 
e inferior) y para cada nodo se informa el menor de estos dos factores de seguridad. Para laminados, el 
factor de seguridad se evalúa en ambos lados de cada capa y se informa el factor de seguridad mínimo 
en cada nodo (primera capa en fallar) junto con el número de la capa (First Layer to Fail) y la posición 
dentro de la capa en la que se produce el fallo (Failure Position in Layer). Una posición 1 significa que 
el lado superior (dirección +W) y posición -1 significa el lado inferior (dirección -W) y estas son las únicas 
dos posiciones donde se evalúa. 
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El Factor of Safety (factor de seguridad) informado en la solución es el valor por el que todos los 
componentes de tensión pueden ser multiplicados para que el estado de tensión llegue a la falla. Por 
ejemplo, un valor de entre 0 y 1 indica una falla y un valor de 2 indica que la estructura puede soportar 
dos veces la tensión antes de fallar. El factor de seguridad es también el valor por el cual todas las cargas 
se pueden multiplicar para causar fallas. La escala está limitada a un máximo de 15 de forma 

predeterminada, pero puede cambiarlo en Tools→ Options→ Contour plot→ Factor of safety scale 

maximum. 

8.8 Materiales no lineales 

Con los tipos de análisis es Estático No lineal 3D y Respuesta dinámica no lineal 3D se vuelven 
disponibles varios materiales no lineales. Ellos son: 

Neo Hooke 

Mooney-Rivlin 

Plastic with isotropic hardening 

Plastic with kinematic hardening 

Ramberg-Osgood 
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9 Capítulo 9 

Cargas y restricciones 

Para aplicar una carga o restricción, haga clic con el botón derecho en la rama del esquema de árbol 
Loads & Constraints y elija qué añadir. La mayoría de las cargas y restricciones deben ser aplicadas a 
nodos, caras, elementos o selecciones con nombre. Algunas pueden aplicarse sólo a nodos, sólo a caras 
u otras combinaciones. Si selecciona algunos de estos elementos antes de crear la nueva carga o 
restricción, se aplicará a ellos automáticamente por defecto. 

Cuando las cargas o restricciones se distribuyen sobre superficies, aplíquelas a las caras en lugar de a 
los nodos. Las operaciones de refinamientos de malla transferirán automáticamente las cargas y 
restricciones a los nuevos elementos creados, mientras que las cargas y restricciones aplicadas a nodos 
permanecen en los mismos nodos. 

Para deshabilitar temporalmente una carga o restricción para que sea ignorada por el Solucionador y no 
aparezca en el área de gráficos, haga clic con el botón secundario y seleccione Suprimir (Suppress). Su 
nombre será atenuado hasta que la Des-suprimir (Unsuppress). 

Algunas cargas y restricciones pueden variar en función del tiempo. Hay dos formas de hacerlo: con una 
tabla o con una fórmula. Usando una Tabla, puede especificar pares tiempo-valor que se pueden 
introducir directamente o pegarse desde una hoja de cálculo. El Solucionador realiza una interpolación 
lineal entre los datos de la tabla para determinar el valor en cada paso de tiempo. Si el paso de tiempo 
está fuera del rango de la tabla entonces se realiza una extrapolación constante de modo que el valor 
final se aplicará en todos los tiempos siguientes y el primer valor se aplica a todos los tiempos anteriores. 
También puede introducir una Fórmula con la variable t para representar el tiempo y será evaluada en 
cada paso de tiempo.  

Para los Solucionadores CCX y OpenRadioss las fórmulas se convierten en funciones lineales a trozos. 
Muestrea cada función en 10001 valores temporales igualmente espaciados y sólo retiene aquellos que 
definen una función lineal a trozos cuyo error es no mayor a 0.01% del rango de la función. La 
determinación del error y del rango se hacen usando 10001 muestras. 

Puede asignar un nombre a cada carga o restricción. Son ordenadas por nombre en el esquema de árbol 
y los nombres permiten acceder a ellas mediante scripts usando la API de Python. Para establecer el 
nombre, haga clic derecho en el elemento en el esquema de árbol y elija Rename. 

Puede organizar las cargas y restricciones en grupos. Los grupos se pueden suprimir o contraer para 
facilitar el trabajo con grandes cantidades de cargas y restricciones. Para crear un grupo y colocar una 

carga o restricción en él, haga clic con el botón derecho y elija Move to group → New group. 

9.1  Soporte fijo (Fixed support) 

Tipos de análisis: Estático, estático no lineal, Frecuencia, Respuesta Dinámica, 
Respuesta dinámica no lineal, Pandeo. 

Solucionadores: Interno, CCX, OpenRadioss 

Un soporte fijo limita totalmente los nodos, caras o elementos contra el desplazamiento y rotación en 
cualquier dirección. Puede ser aplicado a nodos que tienen todos los GDL (nodos de elementos viga y 
nodos de referencia de acoplamientos nodo-superficie) o cualquier elemento o cara excepto las caras 
frontales de elementos barra, muelle y amortiguador. Sólo aquellos GDL admitidos por cada cara o nodo 
serán limitados, por tanto, un soporte fijo en la cara de un elemento sólido no limita el GDL rotación de un 
elemento cáscara adyacente a él. 
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9.2  Soporte sin fricción (Frictionless support) 

Tipos de análisis: estático 3D, Estático no lineal, Frecuencia, Respuesta 
Dinámica3D, Respuesta dinámica no lineal, Pandeo 

Solucionadores: Interno, CCX, OpenRadioss. 

Un soporte sin fricción limita el desplazamiento en la dirección normal a las caras en que se aplica. Esto 
permite a los nodos deslizarse a lo largo de la superficie, pero no levantarse o penetrarla. 

Sobre superficies curvas, la dirección normal en cada nodo es el promedio de las normales de todas las 
caras adyacentes a las que se aplica el soporte sin fricción. 

En las caras frontales de cáscaras y caras extremas de vigas, el soporte sin fricción también restringe la 
rotación de los nodos alrededor de cualquiera de los ejes en el plano de la superficie. 

En caras laterales de elementos vigas y elementos barra, el soporte sin fricción limita los elementos como 
si pudieran deslizarse dentro de un tubo. Se puede deslizar a lo largo y girar alrededor de su eje 
longitudinal, pero no moverse ni doblarse lateralmente. 

En el análisis estático lineal, puede especificar Normal displacement, que es una distancia que la 
superficie se desplaza. Un valor positivo significa desplazamiento en dirección entrando en la superficie, 
como indican las flechas rojas símbolos de la restricción. 

 

9.3  Soporte clavado (Pinned support) 

Tipos de análisis: Estático 3D, Estático no lineal, Frecuencia, Respuesta Dinámica 
3D, Respuesta Dinámica no Lineal, Pandeo 

Solucionadores: Interno, CCX 

Un soporte clavado limita el desplazamiento medio a cero en las tres direcciones. Esto permite que los 
nodos o caras giren libremente sobre su centroide. 

Las caras o múltiples nodos con soporte clavado en algunos casos no pueden tener otras restricciones. 

Solo se puede aplicar a caras de elementos sólidos o nodos de cualquier tipo de elemento. 

 

9.4  Soporte elástico (Elastic support) 

Tipos de análisis: Estático 3D, Estático no lineal, Frecuencia, Respuesta Dinámica 
3D, Respuesta Dinámica no Lineal, Pandeo 

Solucionadores: Interno, CCX 

Un soporte elástico restringe cada cara mediante una rigidez finita distribuida sobre la superficie. Puede 
especificar independientemente la rigidez normal y tangencial por unidad de área. Con solo una rigidez 
normal, esto también se llama una base Winkler. 

Solo se puede aplicar a las caras con un área definida por sus nodos, es decir, las caras de los elementos 
sólidos y la parte frontal y posterior de los elementos cáscara. 

 

9.5  Soporte de sólo compresión (Compression only support) 

Tipos de análisis: Estático 3D, estático no lineal 

Solucionadores: Interno, CCX 

Un soporte de sólo compresión se comporta similar a un soporte sin rozamiento en los nodos donde el 
soporte se encuentra en compresión, y no aplica ninguna restricción a los nodos que pondrían el soporte 
en tensión. Esta es una característica no lineal, por tanto, el Solucionador llevará a cabo varias iteraciones 
para determinar qué nodos deben ser limitados y cuáles quedar libres para desplazarse.  
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Sólo se puede aplicar a caras 2D, esto incluye caras de elementos sólidos y las superficies de las cáscaras. 

Con el solucionador interno, la convergencia se logra cuando ninguna restricción cambia de estado entre 
iteraciones sucesivas o cuando la norma L2 del cambio en el desplazamiento en todos los nodos es 
pequeña en comparación con la norma L2 del desplazamiento. La tolerancia predeterminada es     10-11 
y se cambia en Analysis settings. 

Con el solucionador CCX, el soporte se hace a través de resortes no lineales y debe especificar la rigidez 
por unidad de área en compresión (cuanto más alto mejor), así como una tensión máxima no nula en 
tensión (cuanto menor mejor). 

Las limitaciones del soporte de compresión solo con el solucionador CCX son: 

• El solucionador puede no converger, especialmente con elementos cuadráticos o alta rigidez por 
unidad de área. 

• Las fuerzas externas no están disponibles en ninguno de sus nodos que también compartidos con 
elementos cáscara, viga o barra. 

• No es adecuado para grandes rotaciones de superficies curvas porque las direcciones del resorte 
no giran con la deformación. 

• Requiere tipo de análisis 3D estático no lineal. 

9.6 Desplazamiento (Displacement) 

Tipos de análisis: Estático, estático no lineal, Frecuencia, Respuesta Dinámica, 
Respuesta dinámica no lineal, pandeo. 

Solucionadores: Interno, CCX, OpenRadioss. 

Una restricción de desplazamiento o condición inicial establece el componente del vector de 
desplazamiento en la dirección especificada en cada nodo al que se aplica. Los componentes 
perpendiculares a esa dirección permanecen libres, por lo que se requieren 3 restricciones de 
desplazamiento para restringir completamente el desplazamiento en 3D. Cuando se utiliza como 
condición inicial, las componentes perpendiculares libres se establecen de forma predeterminada en cero, 
por lo que solo se requiere una condición inicial de desplazamiento 

El desplazamiento puede ser aplicado a nodos, caras o elementos. 

Para limitar el desplazamiento en una dirección arbitraria, especifique las componentes X, Y y Z de un 
vector que describe la dirección. Cada nodo puede tener cualquier número de restricciones en todos los 
sentidos. Mecway las reduce internamente a un conjunto equivalentes mínimo de restricciones 
ortogonales en un sistema de coordenadas rotado. 

Las componentes del vector dirección pueden ser funciones de la posición. Esto permite, por ejemplo, 
desplazamiento radial o tangencial en un sistema de coordenadas cilíndrico. Con tipos de análisis no 
lineal, la posición es la posición inicial modelada de cada nodo, incluso si se mueven durante la solución. 

El desplazamiento debe ser cero cuando se usa el Solucionador interno con cualquier tipo de análisis, 
excepto Estático. Puede ser no nulo y función del tiempo con los solucionadores CCX y OpenRadioss. 

9.7 Rotación de nodo (Node rotation) 

Tipos de análisis: Estático 2D, Estático 3D, Estático no lineal, Respuesta dinámica 
2D, Respuesta dinámica 3D, Respuesta dinámica no lineal, Frecuencia, Pandeo 

Solucionadores: Interno, CCX, OpenRadioss. 

La rotación del nodo fija el ángulo de rotación de cada nodo sobre el eje especificado. Sólo se puede 
utilizar en los nodos o caras de elementos con el correspondiente GDL rotacional. Esto incluye elementos 
viga y cáscara, pero no elementos sólidos, planos continuos, barras, muelle o amortiguador. Si usted 
necesita restringir la rotación de estos tipos de elementos sin restringir también desplazamientos, use 
Acoplamiento nodo-superficie (Node-surface coupling) y aplique restricciones de rotación de nodo al 
nodo de referencia. 
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Para restringir la rotación alrededor de un eje arbitrario, especifique la X, Y y Z de los componentes de un 
vector que describe la dirección del eje. Cada nodo puede tener cualquier número de restricciones sobre 
cualquier eje. Mecway las reduce internamente a un conjunto equivalentes mínimo de restricciones 
ortogonales en un sistema de coordenadas rotado. 

El ángulo de rotación del nodo debe ser cero cuando se usa el solucionador interno con cualquier tipo de 
análisis, excepto Estático. 

9.8 Velocidad (Velocity) 

Tipos de análisis: Respuesta dinámica  3D, Respuesta dinámica no lineal 

Solucionadores: CCX, OpenRadioss. 

Con el solucionador CCX, la velocidad solo puede ser una condición inicial. 

Una restricción de velocidad o condición inicial establece el componente del vector de velocidad en la 
dirección especificada en cada nodo al que se aplica. Los componentes perpendiculares a esa dirección 
permanecen libres, por lo que se requieren 3 restricciones de velocidad para restringir completamente la 
velocidad en 3D. Cuando se utiliza como condición inicial, las componentes perpendiculares libres se 
establecen de forma predeterminada en cero, por lo que solo se requiere una condición inicial de velocidad.  

Una velocidad se puede aplicar a nodos, caras o elementos. 

Cada nodo puede tener cualquier número de restricciones de velocidad o condiciones iniciales en 
cualquier dirección. 

Los componentes del vector de dirección y su valor escalare pueden ser funciones de la posición. La 
posición es la posición inicial modelada de cada nodo, incluso si se mueven durante la solución. 

 

9.9 Contacto (Contact) 

Tipos de análisis: Estático 3D, estático no lineal, Frecuencia, Respuesta dinámica 
3D, Respuesta dinámica no lineal, Pandeo, Térmico, Flujo de corriente continua, 
Resonancia acústica 3D 

Solucionadores: Interno, CCX, OpenRadioss. 

El contacto entre dos conjuntos de caras puede ser unido (Bonded) (fijadas juntas) o unilateral (Unilateral) 
(capaces de separarse, pero no de penetrarse). 

 

9.9.1 Unido (Bonded) 

El contacto unido puede ser útil para conectar las piezas de un ensamble que tengan mallas no conformes 
o para conectar elementos cáscara y viga con elementos sólidos sin crear una junta articulada. Las caras 
del conjunto principal deben ser 2D como las caras de elementos sólidos 3D o las superficies de una 
cáscara. Las caras en el conjunto esclavo pueden ser de cualquier tipo, incluyendo extremos de vigas o 
bordes laterales de cáscaras. 

 

Position tolerance es la distancia máxima a la que pueden estar los nodos de la superficie esclava de la 
superficie maestra para que se conecten. Automatic significa que se elige un valor pequeño en función 
del tamaño de los elementos. 

Hay tres formulaciones disponibles: Constraint equations, Tie y Elastic que tienen diferentes 
limitaciones en cada solucionador como se muestra en la siguiente tabla: 
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 Cara de 
elemento 

sólido 

Superficie de 
cáscara 

Borde de 
cáscara 

Extremo de 
viga 

Borde de 
viga 

Grandes 
rotaciones no 

lineales 

Constraint 
equations 

CCX e 
interno 

interno 
Interno (sólo 

esclavo) 
Interno (sólo 

esclavo) 
Interno (sólo 

esclavo) 
ninguno 

Tie 
CCX y 

OpenRadioss 
OpenRadioss 

OpenRadioss 
(solo 

esclavo) 

OpenRadioss 
(solo 

esclavo) 

OpenRadioss 
(solo 

esclavo) 

CCX y 
OpenRadioss 

Elastic 
CCX y 

OpenRadioss 
CCX y 

OpenRadioss 
CCX CCX ninguno 

CCX y 
OpenRadioss 

 

Ecuaciones de restricción (Constraint equations) 

Se implementa como un contacto nodo a cara mediante ecuaciones de restricción. Una superficie es 
designada la superficie principal (Master face) (también llamadas superficie principal, independiente o de 
destino) y la otra es la superficie esclava (Slave face) (también llamada superficie secundaria, 
dependiente o de contacto).  Se permiten huecos y penetraciones entre las superficies. Mecway proyecta 
cada nodo esclavo como máximo en una cara principal. El nodo esclavo está obligado a moverse y rotar 
junto con su punto proyectado. Estas restricciones no introducen ninguna rigidez artificial paralela a la 
superficie principal y son rígidas en el sentido normal, impidiendo la separación de las dos superficies. 
Para otros tipos de análisis (térmico, flujo de corriente continua y resonancia acústica), el único GDL del 
nodo esclavo está limitado a ser igual al valor en su punto proyectado en la superficie principal.  

Hay varios factores que se deben considerar a la hora de decidir qué superficie hacer maestra y cuál 
esclava: 

• La superficie con la malla más gruesa debe ser la principal. Si la densidad de la malla principal es 
demasiado fina en comparación con la esclava entonces alguna cara de elemento de la superficie 
maestra podría no tener nodos esclavos proyectados sobre ella y se desconectará. 

 

• La superficie con el área más grande debe ser la principal. Si la superficie esclava sobresale del 
borde de la superficie principal, entonces los nodos esclavos que están demasiado lejos del borde 
no van a estar conectados. Sin embargo, se permite una pequeña tolerancia de alrededor del 4% 
del ancho de la cara de un elemento en la dirección en el plano. Los nodos esclavos dentro de 
esta distancia del borde de una superficie maestra se mantendrán aún conectados. 

 

• No se permiten GDL dependientes de otras restricciones en los nodos de la superficie esclava.  Si 
desea soporte fijo o soporte sin fricción puede usar soporte elástico con una gran rigidez. 
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Para ayudar a identificar los nodos desconectados, agregue la variable de campo contact state a la 
solución antes de resolverla. Muestra un valor en cada nodo de 1 (en contacto), 0 (no en contacto) o nada 
(desconocido). Con el solucionador CCX, los nodos pueden aparecer como desconocidos por varias 
razones, incluida la presencia de contacto *TIE, la presencia de laminados, elementos de viga o carcasa 
no expandidos a sólidos o pasos de tiempo. 

 

Tie 

Es similar a Constraint equations, excepto que las separaciones y las penetraciones deben ser 
pequeñas porque el solucionador CCX mueve los nodos de la superficie esclava de una manera libre de 
deformación, por lo que se encuentran en la superficie maestra, y el solucionador OpenRadioss desprecia 
el brazo de momento debido a su separación. 

Elastic, solucionador CCX 

Esto crea muelles elásticos entre las superficies. Al igual que con Tie, los nodos de la superficie esclava 
se mueven de forma sin deformaciones para que se apoyen en la superficie maestra. 

Con los análisis de tipos mecánico, debe especificar Rigidez normal por unidad de área (Normal stiffness 
per unit area) y Rigidez tangencial por unidad de área (Tangential stiffness per unit area). Estos definen 
una capa de material elástico entre las partes que no tiene flexión o rigidez en el plano y  

𝑁𝑜𝑟𝑚𝑎𝑙 𝑠𝑡𝑖𝑓𝑓𝑛𝑒𝑠𝑠 𝑝𝑒𝑟 𝑢𝑛𝑖𝑡 𝑎𝑟𝑒𝑎 =
𝐸

𝑡
 

𝑇𝑎𝑛𝑔𝑒𝑛𝑡𝑖𝑎𝑙 𝑠𝑡𝑖𝑓𝑓𝑛𝑒𝑠𝑠 𝑝𝑒𝑟 𝑢𝑛𝑖𝑡 𝑎𝑟𝑒𝑎 =
𝐺

𝑡
 

=
𝐸

2𝑡
 

donde E es el módulo de Young y t es el espesor de la capa. 

En un contacto rígido ideal, estos serían infinitos, así que elija un valor finito que sea lo suficientemente 
alto como para mantener bajos los desplazamientos elásticos espurios pero no tan altos como para que 
el solucionador no converja. Una regla general para comenzar para ambos valores es 

10
𝐸

𝑡
 

donde E y t aquí son el módulo de Young y el espesor respectivamente de las partes que tienen contacto. 
Verifique la solución buscando desplazamientos excesivos y aumente en un factor de 10-1000 cada vez 
hasta que sea satisfactoria. 

En el análisis térmico, el contacto unido elástico pone una capa térmicamente resistiva entre las 
superficies. Puede usar esto para representar una almohadilla térmica o una resistencia de contacto o 
establecer la conductancia térmica por unidad de área (Thermal conductance per unit area) en un valor 
alto arbitrario para aproximarse a una conexión ideal. 

 

Elastic, solucionador OpenRadioss 

Esto crea resortes elásticos entre las superficies. Su rigidez se elige automáticamente en función de las 
propiedades de los elementos de la superficie. Sin embargo, puede aumentarla con un factor de rigidez 
(Stiffness factor) más alto para reducir la penetración, o reducirlo para aumentar el paso de tiempo y 
acelerar la solución. 

 

9.9.2 Unilateral 

Solo para tipos de análisis mecánicos no lineales, el contacto unilateral permite detectar el contacto entre 
dos superficies para que no se pasen a través entre sí, pero puedan separarse y deslizarse, 
opcionalmente con fricción. 
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La opción Self contact (autocontacto) requiere solo un conjunto de caras (maestro) que contenga todas 
las caras que puedan entrar en contacto entre sí. 

Solucionador CCX 

Debe especificar Rigidez normal por unidad de área (Normal stiffness per unit area) descrita 
anteriormente en Elástico y, si utiliza fricción, también Rigidez tangencial por unidad de área (Tangential 
stiffness per unit area). 

La tensión de contacto (Contact stress), que incluye presión de contacto (contact pressure), y 
desplazamiento de contacto (contact displacement) están disponibles en la solución. Solo aparecen 
en los nodos esclavos y son cero en todos lados. Las componentes tangenciales del desplazamiento de 
contacto solo están presentes si se define la fricción, de lo contrario, aparecen como cero. El componente 
normal del desplazamiento de contacto (holgura) solo está presente donde hay penetración y es nulo en 
los nodos esclavos que no penetran en la superficie maestra. Eso significa que solo aparecen espacios 
libres negativos. 

Self contact no es muy fiable, especialmente en bordes bien alineados. 

Solucionador OpenRadioss 

El contacto unilateral se limita a las caras 2D de los elementos sólidos y de carcasa y no debe tener 
penetraciones iniciales. 

 

9.10 Acoplamiento nodo-superficie (Node-surface coupling) 

 

Tipos de análisis: Estático 3D, Estático no lineal, Frecuencia, Respuesta dinámica 
3D, Respuesta dinámica no lineal, Pandeo, Térmico, Flujo de corriente continua. 

Solucionadores: Interno, CCX, OpenRadioss. 

 

El acoplamiento nodo-superficie conecta un nodo de referencia en una ubicación arbitraria a una 
superficie mediante restricciones multipunto (MPCs) en lugar de elementos elásticos. Hay dos opciones 
para definir esta conexión: Rígido (RBE2) y Distribución (RBE3), que se describen a continuación. 

Las fuerzas y momentos de reacción incluyen los aplicados a los nodos por los MPCs. Esto significa que, 
normalmente, no se pueden leer las fuerzas de reacción de las restricciones en el nodo de referencia 
porque están equilibradas por las fuerzas de los MPCs y aparecen como cero. 

Con el solucionador OpenRadioss, la masa de los nodos dependientes pasa a los nodos independientes. 

9.10.1 Rígido (RBE2) 

En el análisis mecánico, esto fija todos los nodos de la superficie y un nodo de referencia juntos para que 
se comporten como un solo cuerpo rígido con 6 grados de libertad, que son los 6 GDL del nodo de 
referencia. 

La superficie puede ser especificada como nodos o caras. En el caso de nodos, no necesitan definir una 
superficie real. 

Con los solucionadores interno y OpenRadioss, existe la opción de acoplar GDL rotacionales de nodos 
de superficie (Couple surface node rotational DOFs). Esto restringe los GDL rotacionales de los 
elementos en la superficie para que sean iguales a los del nodo de referencia. Si la superficie incluye 
caras de elementos cáscara o viga, debe activarlo para hacerlo completamente rígido o desactivarlo para 
dejar libres sus rotaciones sobre sus propios nodos. En cualquier caso, la rotación del nodo de referencia 
sigue estando acoplada a los desplazamientos de los nodos de superficie. 

En el análisis térmico, de flujo de corriente continua y electrostático, el único GDL de cada nodo de la 
superficie se restringe para igualar al del nodo de referencia, por lo que es un conductor perfecto. 
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Aplicaciones 

• Aplicación remota de fuerza, masa o restricciones a una superficie. 

• Unión de dos o más piezas que pueden tener diferentes geometrías, ubicaciones y tipos de 
elementos. 

• Hacer que una superficie sea infinitamente rígida sin restringir su movimiento general. 

Limitaciones 

• Los nodos de la superficie son los nodos dependientes y no deben ser nodos dependientes de 
otras restricciones. 

Con el solucionador CCX hay limitaciones adicionales: 

• No se permiten restricciones en los nodos de la superficie. 

• Las restricciones en los nodos de referencia deben estar alineadas con los ejes principales. 

• No deben conectarse directamente a elementos viga o cáscara. 

• El nodo de referencia no debe ser compartido por más de un acoplamiento nodo-superficie. 

 

9.10.2 Distribución (RBE3) 

En el análisis mecánico, esto distribuye las fuerzas y los momentos en el nodo de referencia a las fuerzas 
en la superficie sin agregar rigidez a la superficie. También mantiene los GDLs de desplazamiento y 
rotación del nodo de referencia para reflejar el desplazamiento y la rotación generales de la superficie.  

En el análisis térmico, de flujo de corriente continua y electrostático, el único GDL del nodo de referencia 
se restringe para igualar el valor medio de ese GDL sobre la superficie para no alterar la conductividad 
de la superficie. 

 

Aplicaciones 

• Aplicación remota de fuerza o masa a una superficie. 

• Como araña para conectar un sujetador modelado por un elemento de viga a la superficie de una 
placa. 

• Conexión de elementos sólidos al extremo de un elemento de viga sin rigidizar artificialmente 
ninguna de las partes ni crear una bisagra. 

• Aunque puede aplicar un momento al nodo de referencia para distribuirlo sobre la superficie, 
puede ser más conveniente aplicar el momento directamente a la superficie, especialmente con 
elementos cuadráticos. Consulte las limitaciones a continuación. 

Limitaciones: 

• No disponible para el solucionador CCX. 

• El nodo de referencia es el nodo dependiente y no debe ser nodo dependiente de otras 
restricciones. 

• Los nodos de superficie no deben ser todos colineales. 

• El nodo de referencia no debe pertenecer a la superficie. 

• En los elementos cuadráticos, las ecuaciones MPC contienen factores de ponderación que 
suponen que la fuerza se distribuye uniformemente sobre la cara de cada elemento. En caso de 
que no sea uniforme, como cuando se aplica un momento al nodo de referencia sobre un eje 
tangente a la superficie, puede causar un patrón espurio de zigzag en la forma deformada. Este 
error se reduce refinando la malla. 
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9.11 Sección con Pre-tensión (Pre-tension section) 

Tipos de análisis: Estático 2D, Estático 3D, Estático no lineal, Frecuencia, 
Respuesta dinámica 3D, Respuesta dinámica no lineal, Pandeo. 

Solucionadores: Interno, CCX. 

La sección con pre-tensión aplica una tracción o compresión axial a una malla prismática hecha de 
elementos de volumen (solo solucionador CCX) o un único elemento de resorte (solo solucionador interno). 
Una aplicación típica es la tensión previa de pernos. Puede definir la carga como una fuerza o como un 
ajuste de longitud: 

Fuerza 

Aplica la tracción (positiva) o compresión (negativa) especificada al prisma. Puede ser constante o 
dependiente del tiempo. 

Ajuste de longitud 

La longitud libre del prisma o resorte cambia en la cantidad especificada, donde un valor positivo es un 
acortamiento. Puede ser constante o dependiente del tiempo. 

Malla prismática 

Aplíquelo en al menos dos caras exteriores orientadas en diferentes ángulos en la superficie. Estas 
definen la orientación del eje del prisma, su extensión en la dirección axial y cuáles elementos le 
pertenecen. El eje del prisma es la dirección mutuamente ortogonal a sus vectores normales. Si 
selecciona más de 2 caras, Mecway busca los ejes definidos por cada par de caras hasta un máximo de 
1000 caras y usa su mediana como orientación del eje. Por lo general, está bien seleccionar toda la 
superficie prismática, lo cual puede ser más fácil que elegir caras individuales. La extensión axial del 
prisma se define por la extensión axial máxima de estas caras, por lo que debe elegir las dos caras en los 
extremos opuestos de la región que contendrá la pre-tensión. Los elementos del prisma son todos los 
elementos de volumen dentro de su extensión axial y conectados a cualquiera de las caras seleccionadas 
o a cualquier otro elemento dentro del prisma. 

 

Mecway encuentra una superficie a través de la sección transversal del prisma y CCX la usa para separar 
la malla en dos partes conectadas por restricciones multipunto. Mecway también inserta una capa delgada 
de elementos hexagonales o cuñas en la superficie para garantizar el cumplimiento del requisito de CCX 
de que ningún elemento de una parte esté conectado a la superficie solo por un borde o nodo. 
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Las limitaciones incluyen: 

• Todos los elementos del prisma deben pertenecer al mismo componente, tener las mismas cargas 
y restricciones y tener la misma orientación de ejes de elemento especificada en las Propiedades 
de elemento. 

• Las cargas y restricciones en caras o nodos no se extienden a la capa de elementos insertada. 
Por lo general, el error que esto causa es insignificante porque la capa insertada es muy delgada. 

• Es posible que Mecway no pueda encontrar una superficie a través de la sección transversal si la 
malla es demasiado irregular. Esto puede ocurrir en mallas no estructuradas de tetraedros con 
gran cantidad de elementos. 

• Esta no es una carga seguidora, por lo que, si el prisma sufre una gran rotación, la dirección de la 
pre-tensión no girará con él. 

• Solo está disponible con el solucionador CCX y los siguientes tipos de análisis: estático3D, estático 
no lineal3D, respuesta dinámica3D, respuesta dinámica no lineal 3D. 

 
Elemento muelle 

Aplíquelo a la cara lateral del elemento. Solo se puede usar con la opción Length adjustment, el 
solucionador interno y los siguientes tipos de análisis: estático2D, estático3D, Frecuencia, pandeo. 

 

9.12 Junta flexible en viga (Flexible joint on beam) 

Tipos de análisis: Estático 3D, Frecuencia, respuesta dinámica 3D, respuesta 
dinámica no lineal 

Solucionadores: Interno, OpenRadioss 

Esta junta libera la rigidez rotacional del extremo de un elemento viga permitiendo que gire libremente, 
incluso cuando está conectado a otro elemento o se ha restringido la rotación. 

Flexible joint on beam sólo puede aplicarse a las superficies extremas de elementos viga. 

La junta puede permitir la rotación sobre cualquier combinación de los tres ejes locales (U,V,W) del 
elemento viga. Los significados de algunas combinaciones son: 

• U - el elemento puede girar alrededor de su propio eje, como si estuviera conectado a un cojinete 
de rodillos. 

• V o W - una junta de bisagra que permite que el elemento pivote sobre un eje. 

• V y W - una junta universal que transmite el par de torsión, pero no los momentos de flexión. 

• U, V y W - una rótula que permite que el elemento gire en cualquier dirección. 

Para poner una junta flexible en un nodo interno como este 

 

 

active Show element surfaces, cambie a modo de selección de caras y utilice el deslizador plano de 
corte para ocultar los elementos en primer plano. A continuación, haga clic con el botón derecho en la 
cara final expuesta y seleccione Loads & Constraints→ Flexible joint on beam. 
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El área gráfica mostrará entonces los pines que representan los ejes de rotación libre. 

 

9.13 Fuerza (Force) 

Tipos de análisis: Estático, estático no lineal, Frecuencia, Respuesta Dinámica, 
Pandeo 

Solucionadores: Interno, CCX, OpenRadioss. 

Force aplicada a caras o elementos se distribuye uniformemente sobre ellas. Force aplicada a nodos se 
divide por igual entre los nodos. 

Puede ser constante o dependiente del tiempo. El vector de fuerza se debe especificar en coordenadas 
globales X, Y, Z. 

9.14 Presión (Pressure) 

Tipos de análisis: Estático, estático no lineal, Frecuencia, Respuesta Dinámica, 
Respuesta dinámica no lineal, Pandeo. 

Solucionadores: Interno, CCX, OpenRadioss. 

Pressure aplica una fuerza normal proporcional al área de la cara. El signo de la presión es positivo para 
fuerza dirigida hacia el elemento. 
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Pressure sólo puede aplicarse a caras. Puede ser constante o dependiente del tiempo. Puede utilizarse 
con la mayoría de los tipos de elemento utilizado en los tipos de análisis mecánico: plano 
continuo, sólido continuo, axisimétrico continuo, cáscara, viga y barra, pero no a 
elementos muelle o amortiguador porque no tienen ninguna superficie. 

En el análisis no lineal, la presión uniforme es una carga seguidora, lo que significa que, 
si la orientación o el área de las caras cambian, la fuerza total cambiará para mantener 
una presión constante. 

Con los solucionadores interno y CCX, la presión también puede ser definida como una 
función matemática de la posición. Para ello, introduzca una fórmula por su valor 
utilizando las variables x, y y z para la posición. Por ejemplo, aplicar una carga de presión 
cuadrática para una pared vertical (+Y), donde la presión varía de 0 psi en Y=0 a 12 psi 
en Y=2 ft, introduzca una presión de: 

3*y^2 

Y seleccionar las unidades de pies de posición y libras/pulg2 de presión. 

Si define la presión con una fórmula entonces en cada cara del elemento se evalúa en función de la 
presión de 1,7 o 9 puntos de muestreo para las caras línea/punto, triángulo o cuadrilátero, 
respectivamente. Esto significa que los cambios rápidos en la presión podrían no ser reflejados con 
precisión y puede necesitar el refinamiento de malla. 

9.15 Tracción (Traction) 

Tipos de análisis: Estático, Estático no lineal, Frecuencia, Respuesta Dinámica, 
Respuesta dinámica no lineal, Pandeo. 

Solucionadores: interno, CCX. 

Traction aplica una fuerza proporcional al área de la superficie y en una dirección especificada en 
coordenadas globales X, Y, Z. 

 

Puede ser constante o dependiente del tiempo y se puede utilizar con la mayoría de los tipos de elementos 
utilizados en los tipos de análisis mecánico: plano continuo, sólido continuo, axisimétrico continuo, 
cáscara, viga y barra, pero no elementos resorte o amortiguador porque no tienen área de superficie. Al 
igual que la presión, también se puede definir como una función matemática de la posición. 

En un elemento cáscara, la cara está desplazada de la superficie media en la mitad del grosor del 
elemento, por lo que una tracción aplicada a la cara genera momentos en los nodos, además de fuerzas. 

 

Si no desea estos momentos, aplique Traction a los elementos en lugar de a las caras. Entonces actúa 
sobre la superficie media. Siempre deberá hacer esto para las cáscaras curvas con el solucionador CCX 
porque esos momentos generalmente incluyen un componente normal que no está permitido por CCX. 
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9.16 Presión de línea (Line pressure) 

Tipos de análisis: Estático, Frecuencia, Respuesta Dinámica, Pandeo. 

Solucionadores: Interno. 

Line pressure aplica una fuerza uniforme por unidad de longitud para cada arista o elemento line. La 
dirección de la fuerza puede ser especificada en coordenadas globales (X, Y, Z) o en coordenadas del 
elemento (U, V, W) para elementos viga o barra. 

Line pressure en las coordenadas del elemento es una carga seguidora para los tipos de análisis no 
lineal, por lo que la dirección y la magnitud de la fuerza se ajustan con la rotación y deformación del 
elemento. Con el solucionador CCX solo se pueden utilizar los componentes V y W. 

Line pressure sólo se puede aplicar a elementos de line2 o line3 o caras que son localmente 
unidimensionales. Esto incluye los bordes de elementos plano y línea tales como cáscaras y vigas. Puede 
ser constante o dependiente del tiempo. 

9.17 Presión hidrostática (Hydrostatic Pressure) 

Tipos de análisis: Estático 3D, Frecuencia, Respuesta Dinámica 3D, Pandeo 
Solucionadores: Interno. 

Solucionadores: Interno, CCX. 

Hydrostatic pressure es una carga triangular o trapezoidal que simula el gradiente de presión ejercida 
sobre una superficie por un cuerpo de líquido bajo la influencia de la gravedad. 

 

Para utilizarla, debe especificar un punto en la superficie libre (A point in the free Surface), la densidad 
del líquido (fluid density) y una carga de gravedad por separado. 

Mecway convierte la presión en las fuerzas nodales equivalentes integrando numéricamente la función 
de presión sobre el área de cada cara a la que se aplica. Si la superficie está por encima de la superficie 
libre, entonces no se aplica presión. Si la superficie está por debajo de la superficie libre entonces la 
integración dará fuerzas nodales exactas. Sin embargo, si la cara se interseca con la superficie libre 
entonces la integración suele presentar un pequeño error inferior al 1% para esa cara. Para reducir el 
efecto de este error, puede refinar la malla en la superficie libre o alinear los bordes de los elementos con 
la superficie libre. 

Hydrostatic pressure sólo se puede aplicar a elementos con caras que son localmente bidimensionales. 
Esto incluye las superficies de cáscaras y todas las caras de elementos sólidos. 

Se puede lograr el mismo efecto que la presión hidrostática mediante una carga de presión con una 
fórmula para definir la presión como en función de la posición. La principal diferencia es que la presión 
hidrostática puede capturar con mayor precisión el cambio brusco de presión que se produce si la 
superficie libre se cruza con una cara del elemento porque usa más puntos de muestreo y una función de 
presión lineal a trozos. 
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9.18 Momento (Moment) 

Tipos de análisis: Estático 2D, Estático 3D, Estático no lineal, Respuesta   
dinámica 2D, Respuesta Dinámica 3D, Frecuencia, Respuesta dinámica no lineal, 
Pandeo. 

Solucionadores: Interno, CCX, OpenRadioss. 

Moment aplica un momento o bien en un nodo solo con grados de libertad rotacionales (nodo viga o 
cáscara), o bien distribuido sobre una selección de caras 2D (caras de cáscara o de sólido). La dirección 
del vector de momento está especificada en coordenadas globales X, Y, Z. El eje sobre el que actúa pasa 
por la posición del nodo o el centroide de las caras. 

Cada componente puede ser constante o dependiente del tiempo. 

9.19 Gravedad (Gravity) 

Tipos de análisis: Estático, estático no lineal, Frecuencia, Respuesta Dinámica, 
Respuesta dinámica no lineal, Pandeo. 

Solucionadores: Interno, CCX, OpenRadioss. 

Gravity da una fuerza distribuida a todas las partes de un modelo masivo. Esto incluye elementos cuyo 
material tiene densidad y nodos con cargas masivas aplicada a ellos. También incluye el líquido en 
cualquier carga de presión hidrostática. 

Especifica un vector que es la fuerza por unidad de masa o la aceleración debida a la gravedad. Para la 
gravedad de la tierra puede utilizar Y=-9.81 m/s2. Puede ser constante o dependiente del tiempo. 

9.20 Fuerza centrífuga (Centrifugal force) 

Tipos de análisis: Estático, estático no lineal, Frecuencia, Pandeo. 

Solucionadores: Interno, CCX. 

Centrifugal force pone el modelo en un marco de referencia giratorio para simular la rotación de todo el 
modelo junto con el sistema de coordenadas globales. Esto le da a cada parte masiva (nodo o elemento) 
una fuerza exterior cuya magnitud es 

𝐹 = 𝑚𝜔2𝑟 

Donde m es la masa del elemento, ω es la velocidad angular y r es la distancia desde el eje de rotación. 
El eje de rotación debe ser uno de X, Y o Z. 

La velocidad angular (Angular velocity) puede ser constante o dependiente del tiempo en análisis 
estático no lineal. Sin embargo, dado que se trata de una simulación cuasi-estática, no puede modelar las 
fuerzas inducidas por la aceleración angular. 

Centrifugal force puede aumentar el radio de giro de parte de una estructura, aumentando así aún más 
la fuerza centrífuga. Este efecto se denomina ablandamiento por centrifugación (spin softening) y a veces 
pueden tener un efecto significativo sobre las frecuencias naturales y cargas de pandeo crítica. Se tienen 
en cuenta de forma automática en los tipos de análisis Frecuencia, pandeo y estático no lineal pero no en 
estático lineal. 

Puede incluir una segunda Centrifugal force en el tipo de análisis Estático 3D con Solucionador interno. 
Esto aplica sus propias cargas como se describió anteriormente, pero la combinación de los dos también 
provoca el efecto giroscópico de un momento distribuidos alrededor de sus ejes mutuamente 
perpendiculares. La carga total en cada punto con el vector de posición r es 

𝐹 = −𝑚[𝜔 × (𝜔 × 𝑟) + 2𝛺 × (𝜔 × 𝑟) + 𝛺 × (𝛺 × 𝑟)] 

Donde Ω es la velocidad angular vector de la carga de fuerza centrífuga "exterior" y ω es el vector 
velocidad angular de la carga de fuerza centrífuga interior. Usted debe identificar a uno de ellos como 
exterior (Outer). El significado de exterior e interior es que el modelo gira alrededor del eje de rotación 
interior y el eje de rotación interior gira alrededor del eje de rotación exterior. 
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Los elementos viga que tienen densidad no nula no pueden ser usados en el mismo modelo con dos 
cargas de fuerza centrífuga. 

9.21 Masa (Mass) 

Tipos de análisis: Estático, Estático no lineal, Frecuencia, Respuesta Dinámica, 
Respuesta Dinámica no Lineal, Pandeo. 

Solucionadores: Interno, CCX 

Mass es una masa concentrada en un nodo. Puede ser utilizado en lugar de la densidad o para idealizar 
un objeto masivo sin usar elementos. Esta masa contribuye al comportamiento dinámico, la gravedad y 
la fuerza centrífuga. Cuando se aplica Mass a varios nodos, la masa especificada se divide a partes 
iguales entre los nodos. 

  

9.22 Inercia rotacional (Rotational inertia) 

Tipos de análisis: Respuesta Dinámica, Frecuencia. 

Solucionadores: Interno. 

Una carga Rotational inertia es un punto con inercia rotacional alrededor de uno de los ejes X, Y o Z. 
Sólo se puede aplicar a los nodos de elementos viga y cáscara. Puede utilizar la inercia rotacional para 
idealizar grandes piezas tales como volantes sin usar elementos. 

  

9.23 Temperatura (Temperature) 

Tipos de análisis: Estático, Estático no lineal, Respuesta dinámica no lineal, 
Frecuencia, Pandeo, Térmico, flujo de corriente continua. 

Solucionadores: Interno, CCX. 

En un análisis térmico una restricción Temperature limita la temperatura al valor especificado en los 
elementos en que se aplica. El calor puede fluir dentro o fuera del modelo a estas ubicaciones para 
mantener la temperatura especificada. 

En un análisis mecánico, Temperature se utiliza para el estrés térmico donde también se debe aplicar 
una carga de estrés térmico. 

Temperature puede aplicarse a nodos, caras o elementos. 

Con el solucionador interno, la temperatura se puede restringir dentro de un intervalo de tiempo 
especificado en un análisis transitorio térmico. 

Se pueden especificar valores dependientes del tiempo y la posición como una fórmula o como una tabla 
si solo hay dependencia del tiempo. Con el solucionador CCX, no puede ser función de tiempo y posición 
en la misma fórmula. 

9.24 Temperatura de nodo (Node temperature) 

Tipos de análisis: Estático, Estático no lineal, Frecuencia, Pandeo, Térmico, flujo 
de corriente continua. 

Solucionadores: Interno, CCX 

Node temperature fija la temperatura de cada nodo individual. No se puede aplicar a selecciones con 
nombre y es adecuada para campos de temperatura con valor diferente en cada nodo. 
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Un uso común de Node temperature es el análisis de estrés térmico donde los valores son generados 
por el Solucionador en un análisis térmico utilizado como dato para un análisis estático. 

9.25 Estrés térmico (Thermal stress) 

Tipos de análisis: Estático, Estático no lineal, Respuesta dinámica no lineal, 
Frecuencia, Pandeo. 

Solucionadores: Interno, CCX. 

Cuando está presente, Thermal stress permite cargas térmicas. Se debe especificar una temperatura de 
referencia (reference temperature), así como las temperaturas en las partes del modelo y los 
coeficientes de expansión térmica de los materiales. 

La diferencia en cada elemento entre la temperatura promedio especificada y la temperatura de referencia 
se utiliza para determinar la carga de expansión/contracción térmica. Todos los nodos que no tienen una 
temperatura especificada se suponen estar a la temperatura de referencia. 

Sólo se puede aplicar un estrés térmico en un modelo. 

9.26 Amortiguación de Rayleigh (Rayleigh damping) 

Tipos de análisis: Respuesta Dinámica, Respuesta Dinámica no Lineal. 

Solucionadores: Interno, CCX, OpenRadioss. 

Rayleigh damping, también llamada amortiguación proporcional, es un tipo de amortiguación viscosa 
que se distribuye a lo largo de los elementos. Se utiliza una matriz de amortiguación (C) formada a partir 
de una combinación lineal de las matrices masa (M) y rigidez (K). 

𝐶 = 𝛼𝑀 + 𝛽𝐾 

Puede especificar valores de α y β para controlar su comportamiento. Un α no nulo causa cada que nodo 
que se conecte a un punto externo fijo a través de un amortiguador cuyo coeficiente de amortiguación 
está relacionado con la masa asociada a ese nodo. Un β no nulo causa una amortiguación interna de la 
deformación de los elementos. 

Puede aplicar Rayleigh damping para todo el modelo o una selección de elementos. Esto le permite 
asignar diferentes propiedades de amortiguación para diferentes materiales o regiones de una estructura. 
Sin embargo, con el solucionador CCX o la opción Mode superposition, sólo se permite el modelo 
completo. Si se aplica más de una carga de amortiguación de Rayleigh al mismo elemento, las matrices 
de amortiguación se suman, lo que equivale a la sumar los coeficientes de amortiguamiento. 

En análisis de frecuencia el Solucionador utiliza un coeficiente de amortiguamiento para cada modo en 
lugar de una matriz de amortiguación. La matriz de amortiguación definida anteriormente es equivalente 
a un conjunto de coeficientes de amortiguamiento modal 

𝜁𝑖 =
1

2
(
𝛼

𝜔𝑖
+ 𝛽𝜔𝑖) 

Donde i es el número de modo y ω es la frecuencia angular de ese modo. ζi debe ser inferior a 1 para 
cada modo en la solución. 

Puede elegir los valores de α y β resolviendo la ecuación anterior en dos puntos con coeficientes de 
amortiguación ζ1 y ζ2 y frecuencias ω1 y ω2 respectivamente, como se muestra a continuación. Con la 
opción superposición de modos, ζ para cada modo debe ser inferior a 1, es decir, la estructura debe ser 
subamortiguada. 

𝛼 =
2𝜔1𝜔2(𝜁2𝜔1 − 𝜁1𝜔2)

𝜔1
2 − 𝜔2

2 𝛽 =
2(𝜁1𝜔1 − 𝜁2𝜔2)

𝜔1
2 − 𝜔2

2  
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9.27 Tasa de flujo de calor (Heat flow rate) 

Tipos de análisis: Térmico. 

Solucionadores: Interno, CCX. 

Agrega calor al modelo a la velocidad especificada. Se distribuye de manera uniforme en todo el volumen 
o superficies a las que se aplica. Si se aplica a los nodos entonces el flujo de calor especificado se divide 
en partes iguales entre cada nodo. 

Heat flow rate puede ser aplicada a nodos, caras o elementos. 

Puede especificarse Heat flow rate dependiente del tiempo, mediante una fórmula o una tabla de pares 
valor-tiempo. 

9.28 Flujo de calor (Heat flux) 

Tipos de análisis: Térmico. 

Solucionadores: Interno, CCX. 

Agrega calor al modelo a la tasa especificada por unidad de área. Se distribuye uniformemente a través 
de las superficies las que se aplica. Flujo de calor sólo puede aplicarse a caras.  

Puede especificarse un valor dependiente del tiempo y la posición como fórmula o mediante una tabla 
para la dependencia solo del tiempo.  

9.29 Generación interna de calor (Internal heat generation) 

Tipos de análisis: Térmico. 

Solucionadores: Interno, CCX. 

Agrega calor al modelo a una tasa uniforme sobre el volumen al que se aplica. El valor especifica la tasa 
a la cual se añade calor al modelo por unidad de volumen. 

Internal heat generation sólo puede aplicarse a elementos. 

Puede especificarse un valor dependiente del tiempo y la posición, mediante una fórmula o una tabla para 
dependencia solo del tiempo.  

9.30 Convección (Convection) 

Tipos de análisis: Térmico 

Solucionadores: interno, CCX 

La convección permite el flujo de calor hacia o desde una cara de acuerdo con un coeficiente de 
transferencia de calor y temperatura ambiente especificados.  

Pueden especificarse valores dependientes del tiempo y la posición como fórmula o como tabla para la 
dependencia solo del tiempo. Con el solucionador CCX, no pueden ser simultáneamente función del 
tiempo y la posición en la misma fórmula. 

9.31 Convección forzada (Forced convection) 

Tipos de análisis: Térmico 

Solucionadores: interno, CCX 

Es lo mismo que la convección, excepto que en lugar de transferir calor con un depósito a temperatura 
ambiente, transfiere calor con un fluido móvil de temperatura variable definida por elementos de un red 
de fluido. 

Además de las caras que tienen convección, también debe especificar los elementos de red de fluido con 
los que transferir calor. Mecway asocia automáticamente cada cara con el nodo final del elemento más 
cercano entre los elementos de red de fluido especificados. La malla de red de fluido no tiene que ser 
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compatible con la malla frontal, ya que cada nodo de red de fluidos puede asociarse con 0, 1 o muchas 
caras. 

9.32 Radiación (Radiation) 

Tipos de análisis: Térmico 

Solucionadores: interno, CCX 

La radiación permite el flujo de calor dentro o fuera de una cara de acuerdo con una emisividad y 
temperatura ambiente especificadas. No puede modelar la transferencia de calor entre dos partes de un 
modelo. 

Pueden especificarse valores dependientes del tiempo y la posición como fórmula o como tabla para la 
dependencia solo del tiempo. Con el solucionador CCX, no pueden ser simultáneamente función del 
tiempo y la posición en la misma fórmula. 

9.33 Caudal de masa (Mass flow rate) 

Tipos de análisis: Térmico 

Solucionadores: interno, CCX 

Esta restricción prescribe el caudal másico a través de un elemento de red de fluido. Un valor positivo va 
en la dirección del nodo 1 al nodo 3 

 

9.34 Presión de fluido (Fluid pressure) 

Tipos de análisis:Resonancia acústica. 

Solucionadores: Interno. 

 

En el tipo de análisis de resonancia acústica, puede utilizar Fluid pressure =0 para fijar un nodo de 
presión. Nodo significa aquí un lugar donde la presión es cero durante todo el ciclo de la onda. 

 

9.35 Impedancia (Impedance) 

Tipos de análisis: Estático 2D, estático3D, flujo de corriente continua. 

Solucionadores: Interno. 

 

Puede aplicar la condición de contorno de impedancia a las caras de los elementos para modelar un 
absorbedor con Impedancia acústica específica compleja. 

No admite impedancia dependiente de la frecuencia, sin embargo, puede configurar una configuración 
para cada de varios valores de impedancia y elegir modos de la solución de cada configuración según 
sus frecuencias. 

La impedancia no se puede utilizar en el mismo modelo que contacto unido o ecuaciones de restricción. 

 

9.36 Potencial eléctrico (Electric potential) 

Tipos de análisis: Estático 2D, estático3D, flujo de corriente continua. 

Solucionadores: Interno. 

Fija un potencial uniforme sobre cada ítem a que se aplica. En el análisis del flujo de corriente continua, 
la corriente puede fluir dentro o fuera del modelo según sea necesario para mantener ese potencial. Es 
una fuente de tensión relativa a una tierra común. 
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9.37 Carga (Charge) 

Tipos de análisis: Estático 2D, Estático3D 

Solucionadores: Interno. 

Define una carga eléctrica distribuida uniformemente en todo el volumen o la superficie a la que se aplica. 
Si se aplica a los nodos entonces la carga especificada se divide en partes iguales entre los nodos. 
Pueden aplicarse cargas a nodos, caras o elementos. 

 

9.38 Corriente (Current) 

Tipos de análisis: el flujo de corriente continua. 

Solucionadores: Interno. 

Define una corriente eléctrica que fluye uniformemente distribuida a través del modelo en toda la superficie 
a la que se aplica. Si se aplica a los nodos entonces la corriente especificada se divide en partes iguales 
entre los nodos. 

La corriente puede ser aplicada a caras o nodos. 

Un valor positivo en la cara de un elemento representa una corriente que fluye entrando al elemento. 

 

9.39 Condición de frontera de Robin (Robin boundary condition) 

Tipos de análisis: Estático 2D, estático3D, flujo de corriente continua. 

Solucionadores: Interno. 

Robin boundary condition impone la siguiente ecuación en una cara 

K ∂u/∂n + c0u + c1 = 0 

Donde 

• u es el potencial eléctrico 

• K es la conductividad eléctrica o permisividad absoluta del material 

• ∂u/∂n es la derivada de u normal a la cara 

• c0 y c1 son parámetros especificados por el usuario. Si c0 = 0 es una condición de frontera de 
Neumann, que fija el valor del gradiente de la variable de campo normal a la cara. 

 

9.40 Simetría (Symmetry) 

Tipos de análisis: Estático 3D, Estático no lineal, Frecuencia, Respuesta Dinámica 
3D, Respuesta Dinámica no Lineal 

Solucionadores: Interno, CCX, OpenRadioss. 

La restricción de simetría aplica una restricción de simetría mediante la aplicación de restricciones de 
desplazamiento y rotación a los nodos de las caras. Las restricciones de desplazamiento se orientan de 
forma normal al plano de simetría y las restricciones de rotación (para los nodos de viga y cáscara) son 
tangentes a él. 

Solo se puede aplicar a las caras de elementos sólidos, bordes de cáscaras y caras extremas de 
elementos viga/barra/resorte/amortiguador. 

Puede optar por definir el plano de simetría con un vector o utilizar plano de simetría definido por nodos. 
Para plano de simetría definido por nodos, las caras deben tener al menos 3 nodos no colineales y 
todos los nodos deben ser coplanares. 
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En los lados de elementos cáscara, solo se restringe el GDL de rotación tangente al lado. La restricción 
de rotación en la otra dirección (normal tanto a la normal del plano de simetría como a la tangente del 
lado de la cáscara) viene dada por las restricciones de desplazamiento en los nodos adyacentes. La razón 
para omitir esta restricción es que no funciona de forma confiable con el solucionador CCX. 

Aunque también puede utilizar soporte sin fricción como condición de contorno de simetría, la ventaja 
de la simetría es que todas las restricciones de nodo que genera están alineadas con el mismo plano, 
incluso si las normales de cara individuales son diferentes. Esto es particularmente útil en los lados de 
cáscaras y los extremos de las vigas, donde la normal de la cara a menudo no es la misma que la normal 
del plano de simetría. 

 

9.41 Simetría cíclica (Cyclic symmetry) 

Tipos de análisis: Estático 3D, Estático no lineal, Frecuencia, Estado estacionario 
térmico 

Solucionadores: Interno, CCX. 

Si la geometría y las cargas se repiten regularmente alrededor de un eje de rotación, puede utilizarse 
Cyclic symmetry (periodicidad de rotación) para reducir el modelo a un solo segmento, permitiendo una 
malla menor y mejorando el rendimiento de Solucionador. 

En el análisis térmico, la simetría cíclica equivale a aplicar ecuaciones de restricción acoplando los 
correspondientes pares de nodos en las superficies de corte. 

En el análisis estático, la simetría cíclica es equivalente a aplicar ecuaciones de restricción que equiparan 
los desplazamientos radiales, circunferenciales y axiales de los pares de nodos correspondientes en las 
superficies de corte. 

En análisis de frecuencia la simetría cíclica aplica coordenadas transformadas y acopla los grados de 
libertad usando restricciones complejas especiales descritas en (D. L. Thomas, Dynamics of Rotationally 
Periodic Structures, 1979). Este método puede encontrar modos que no son simétricas cíclicamente. El 
número de modos especificado para la solución no es el número total de modos, sino el número de modos 
que tengan el mismo número de diámetros nodales. Por ejemplo, si se especifican 5 modos en un modelo 
con 7 segmentos, el Solucionador encontrará los 5 modos menores con diámetros nodales 0, 1, 2 y 3, 
resultando un total de 20 modos. 

Diferencias entre el solucionador interno y el CCX. 

CCX Interno 

Las mallas principal y esclava no tienen por qué ser 
compatibles. 

Las distribuciones de los nodos principal y esclavo 
deben coincidir una con otra. La superficie con la malla más fina debe ser la esclava 

para asegurar que todas las caras principales tienen 
sus correspondientes nodos esclavos. 

No se permiten cáscaras ni vigas en ningún tipo de 
análisis. 

No se permiten cáscaras ni vigas en análisis de 
frecuencia. 

No se permiten restricciones en la superficie esclava. 
Las restricciones en las superficies de corte se limitan 
a: 

-Desplazamiento en la dirección del eje de simetría 

-Desplazamiento cero normal al eje de simetría 

-Temperatura 

Se permite cualquier restricción de un punto en la 
superficie principal. 

La solución muestra el número de segmentos 
requeridos. 

La solución solo muestra un segmento con tipo de 
análisis estático y térmico. 
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9.42 Ecuación de restricción (Constraint equation) 

Tipos de análisis: Estático, frecuencia, Respuesta Dinámica, Pandeo, térmico en 
estado estacionario, flujo de corriente continua, resonancia acústica. 

Solucionadores: Interno, CCX 

Una ecuación de restricción (también llamadas restricción multipunto o MPC) es un tipo de restricción 
más general que impone una relación lineal entre varios GDL (grados de libertad). Algunos ejemplos de 
usos son: 

• El desplazamiento X de un nodo puede ser igual al desplazamiento Y de otro nodo, de forma que 
actúan como si estuvieran conectados por una palanca acodada 90° como ux1 - uy2 = 0. 

• En flujo de corriente continua, puede hacerse una fuente de tensión estableciendo una diferencia 
constante en el potencial de dos nodos como V2 - V1 = 5V. 

Una ecuación de restricción tiene la forma 

A × GDL1 + B × GDL2 + … = C 

Donde A, B y C son constantes. El primer GDL, con coeficiente A es el GDL dependiente. 

 

Con algunas excepciones, las ecuaciones de restricción deben cumplir ciertas restricciones como: 

• El GDL dependiente no debe ser un GDL dependiente en cualquier otra restricción o ecuación de 
restricción. 

• El coeficiente del GDL no debe ser cero. 

• Cada GDL sólo puede aparecer una vez en la misma ecuación de restricción. 

• La constante (C) debe ser cero en análisis de frecuencia, respuesta dinámica, pandeo, resonancia 
acústica y todos los tipos de análisis con el solucionador CCX. 

• Con el solucionador CCX, usualmente no pueden referirse a los GDL rotacionales de elementos 
viga o cáscara. 
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10 Capítulo 10 

Resultados 

10.1 Mostrar 

 

Seleccione un elemento bajo Soluction para mostrar una variable de campo 
como un gráfico de contorno codificado por colores. Estos sólo están 
disponibles después de resolver el modelo. Puede agregar variables de 
campo adicionales haciendo clic derecho en la rama Solution. 

 

 

El gráfico de contorno se puede configurar seleccionando Tools→ Options→ Contour plot. Aquí puede 
cambiar la combinación de colores, el número de colores y la resolución. Una mayor resolución es más 
lenta para procesar, pero da los límites entre los colores más suaves por lo que puede ser útil para su 
presentación. La opción Gradient da una imagen más suave que es también más rápida para generar 
con mallas grandes sin embargo no muestra con precisión los cambios de color dentro de una cara de 
elemento. 

A veces aparecen regiones negras en 
el gráfico de contorno. Esto sucede 
cuando no hay color correcto que se 
pueda utilizarse. Una razón es que el 
valor está fuera del rango de valores 
que se asignan a los colores. 
También puede ocurrir si el valor del 
campo que se muestra no existe en 
ese elemento. Por ejemplo, 
elementos sólidos no tienen ningún 
momento flector así los momentos de 
flexión aparecen en negro. Puede 
cambiar este valor de negro a otro 
color mediante Tools→ Options→ 
Contour plot y Above range color, Below range color y No value color, para definir colores para 
valores por encima o por debajo del rango o sin valor respectivamente. 
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Node values mostrará los resultados en cada nodo como el promedio de los 
valores de todos sus elementos adyacentes. Esto produce un gráfico continuo.  

 

 

 

Element values mostrará los resultados sin promediado nodal. Los valores de 
elementos viga y cáscara que se expresan en coordenadas locales (U, V, W) 
deben mostrarse de esta forma porque el significado de los valores en elementos 
adyacentes puede ser diferente. No disponible con el solucionador CCX. 

Para desactivar el gráfico de contorno, haga clic en la rama Components bajo 
Solution en el esquema de árbol. 

Haga clic en un nodo para mostrar sus valores nodales tanto promediados como los no promediados 
individuales de todos sus elementos adyacentes. Si hay escalones de tiempo en la solución, la línea de 
tiempo también mostrará un gráfico del valor nodal. 

Puede exportar los datos del gráfico a un archivo de texto haciendo clic derecho en la gráfica y clicando 
Export to CSV file.... o copiarlo en el portapapeles con Copiar datos (Copy data). 

 

 

Puede controlar el rango de valores que se muestra en el gráfico de 
contornos moviendo los controles deslizantes a la izquierda de la 
escala de color. Las partes del modelo fuera del rango 
especificado se mostrarán utilizando Above range color o 
Bellow range color, según corresponda, que por defecto son negro. 

Una forma automática para configurar el intervalo de valores es 
haciendo clic derecho en algunos elementos seleccionados y 
clicando Fit contour plot max/min to selection. Esto ajusta la 
escala para que coincida con los elementos seleccionados, 
ignorando todo lo demás.  

 Vista deformada muestra una deformación exagerada. 
Un factor predeterminado es seleccionado automáticamente 
para mostrar un cambio claramente visible. El factor de escala 
mínimo es 1 a excepción de para formas de los modos. 
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 Vista sin deformar superpone el perfil sin deformar sobre 
la vista deformada. El menú desplegable le permite mostrar 
como bordes de elementos o del modelo. 

Los campos vectoriales se muestran como flechas si se selecciona 
el nombre del grupo en elesquema de arbol, por ejemplo, 
displacement o velocity. 

 Animación anima la deformación. Esto sólo funciona para los 
resultados sin escalones de tiempo como análisis estático y de 
frecuencia. Para resultados con escalones de tiempo como 
respuesta dinámica, utilice la línea de tiempo que se describen a 
continuación. 

Los escalones de tiempo en problemas transitorios aparecen en la 
línea de tiempo, cuya longitud es el período total del análisis. El 
resultado en el gráfico corresponde a la posición del control 
deslizante.  

Para animar la pantalla, haga clic en Reproducir/Pausa. El menú desplegable se puede utilizar para 
controlar la velocidad. Puede utilizar esto junto con Vista deformada para mostrar el movimiento. 

Para mover el cursor de a un paso, haga clic en su mango y pulse las flechas izquierda y derecha. 

Para guardar la animación como un archivo MPEG, haga clic en la flecha abajo que aparece junto al botón 
de animación y elija Save video to file. 

 Tabla muestra los resultados en una tabla que se puede copiar y pegar en una hoja de cálculo. Las 
opciones que establezca aquí se guardan con el modelo así puede generar la misma tabla al resolver de 
nuevo. Si introduce un nombre de archivo en Write to csv file after solving Mecway va a guardar la tabla 
en el archivo de texto especificado cada vez que resuelve el modelo. Si omite la extensión en el nombre 
del archivo, Mecway no agregará ninguna y el archivo se guardará sin extensión. Este archivo se puede 
abrir con una aplicación de hoja de cálculo u otro software para su posterior procesamiento. Puede 
agregar varias tablas para guardar diferentes partes de la solución en diferentes archivos y puede suprimir 
diferentes tablas en diferentes configuraciones. 

Solution → Find max/min muestra líneas apuntando a los valores máximos y mínimos en toda la malla 
si no se selecciona nada, o en los nodos o elementos seleccionados si se seleccionaron algunos. 

10.2 Archivos de salida 

Pueden grabarse diversos resultados en archivos cuando se ejecuta el Solucionador. La mayoría de estas 
opciones están disponibles en el ítem Analysis arriba en el esquema de árbol. Pero para grabar 
resultados de la solución en forma tabulada en un archivo csv, utilice el elemento Table bajo la rama 
Solution del esquema de árbol. Esto se describe en la sección anterior. 

Si incluye el código especial <f> en el nombre de archivo del archivo de salida, será reemplazado por el 
nombre de archivo del archivo actual sin extensión. Por ejemplo, un modelo denominado example.liml 
con save after solve establecido como <f> solved.liml guardará su solución en el archivo example 
solved.liml. 

Save after solve guarda el modelo y la solución en el archivo especificado.  

Export stiffness matrix guarda la matriz de rigidez en un archivo de texto. Puede ser almacenado en un 
formato denso o disperso. El formato Dense contiene toda la matriz cuadrada con una fila en cada línea 
del archivo.  El formato Sparse no contiene la mayoría de los elementos cero y sólo tiene el triángulo 
superior de la matriz simétrica. Cada línea del archivo contiene 3 números: el número de fila, el número 
de columna y el valor en esa ubicación de la matriz. 

Export mass matrix guarda la matriz de masa con las mismas dos opciones de formato como la matriz 
de rigidez. 
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Export load vector guarda el vector global de carga en un archivo con el valor en cada GDL en una línea 
separada.  

Export DOF ordering guarda la relación entre números de nodo y GDL y los números de la fila de la 
matriz de rigidez. Cada línea del archivo contiene el número de nodo, nombre del GDL y número de la fila 
de la matriz separados por comas. El número de fila de la matriz puede mostrarse como 0 donde el GDL 
global ha sido condensado fuera de la matriz debido a restricciones. 

10.3 Mantener monitor (Saved Monitor) 

Al agregar Saved Monitor a la solución, se mantienen los mensajes de progreso del solucionador 
almacenados con el modelo. 

Puede agregarlo antes de resolver o después de resolver y antes de cerrar la ventana del solucionador o 
del monitor. 

10.4 Linealización de tensión (Stress Linearization) 

Esta herramienta encuentra tensiones 
linearizadas a lo largo de una línea recta (línea de 
clasificación de tensiones) en un modelo sólido. 
Se puede utilizar para el diseño de recipientes a 
presión con ASME u otros códigos. Interpolar 101 
puntos espaciados uniformemente entre las dos 
superficies de la malla a lo largo de una línea de 
clasificación de tensión (SCL) definida por dos 
puntos extremos (SCL endpoints). A continuación, 
produce un gráfico y una tabla que muestra 
tensiones linealizadas de Von Mises, máxima de 

cizallamiento × 2 (intensidad de tensión), 

tensiones principales y/o componentes de tensón 
transformadas a coordenadas SLC. 

No es necesario que haya nodos de la malla en la 
SCL. Mecway interpola valores de tensión de los 
elementos que atraviesa la línea. 

Para crer un nuevo ítem de linealización de 
tensión haga clic en Soluton→ Stress 
linearization. Puede especificar los SCL 
endpoints ingresando 2 conjuntos de 
coordenadas o seleccionando dos nodos em la 
solución antes de abrir la herramienta Stress 
linearization. Los endpoints pueden estar afuera 
de la malla, en cuyo caso solo la selección dentro 
de la malla será usada como SCL. 

10.4.1 Coordenadas SCL 

La tensión se transforma primero en las coordenadas SCL x, y, z. x es paralela a la SCL, en la dirección 
que se aleja del origen global. y y z forman un sistema ortogonal de coordenadas diestras con x. De forma 
predeterminada, y y z se eligen automáticamente y esta opción no afecta a los resultados. 

Si desea aislar los componentes de tensión, debe especificar Direction of y axis. Mecway obtiene el eje 
y proyectando la dirección establecida en el plano normal al eje x. Las únicas direcciones disponibles son 
los 3 ejes globales por lo que es posible que tenga que orientar su modelo para estar alineado con ellos 
antes de resolverlos. 
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10.4.2 Linearization 

El campo de tensión 1-dimensional a lo largo del SCL se descompone en términos constantes, términos 
lineales y términos de orden superior: 

𝝈 = 𝝈𝒎 + 𝝈𝒃 + 𝝈𝒑𝒆𝒂𝒌 

La tensión total, 𝝈 es el tensor de la tensión no linealizada interpolado entre los nodos 

La tensión de membrana  (σm) es constante a lo largo de la SCL se determina mediante la evaluación de 
esta integral utilizando el método trapezoidal: 

𝝈𝒎 =
1

L
∫ 𝝈

𝐿 2⁄

−𝐿 2⁄

𝑑𝑥 

L es la longitud de la SCL 

Cada componente de la tensión de flexión (σb) varía linealmente a lo largo del SCL, pasando por cero en 
el centro. La tensión de flexión al comienzo del SCL se determina evaluando esta integral utilizando el 
método trapezoidal: 

𝜎𝑏(0) =
−6

𝐿2
∫ 𝜎

𝐿 2⁄

−𝐿 2⁄

𝑥 𝑑𝑥 

Sin embargo, si se marca Exclude σ_xx, σ_xy σ_zx bending stress, los componentes de la tensión de 
flexión paralelos al SCL se establecen en cero. 

𝜎𝑥𝑥
𝑏 = 0

𝜎𝑥𝑦
𝑏 = 0

𝜎𝑧𝑥
𝑏 = 0

 

Mecway no muestra la tensión de flexión directamente, sino la suma de tensión de membrana + la tensión 
de flexión en su lugar: 

𝝈𝒎+𝒃 = 𝝈𝒎 + 𝝈𝒎 

La tensión pico es la tensión restante entre la de membrana y de flexión: 

𝝈𝒑𝒆𝒂𝒌 = 𝝈 − 𝝈𝒎+𝒃 

 

10.5 Media de volumen (Volume Mean) 

Solution → Volume Mean evalúa la media de un campo escalar sobre un dominio definido por elementos 

sólidos 3D o planos 2D. Un ejemplo de uso es encontrar la temperatura promedio de un objeto calentado 
de manera no uniforme. 

Si desea utilizar un dominio que no es el modelo completo, debe definirlo como una selección de 
elementos o componente antes de resolverlo. 

10.6 Media de superficie (Surface Mean) 

Solution → Surface Mean evalúa la media de un campo escalar sobre una superficie definida por 

selecciones de caras. Un ejemplo de uso es encontrar la temperatura promedio de una superficie. 

10.7 Integral de volumen (Volume Integral) 

Solution → Volume Integral integra un valor de campo escalar sobre un dominio definido por elementos 

sólidos 3D o planos 2D. Un ejemplo de uso es encontrar la potencia total disipada en un conductor sólido 

integrando la densidad de potencia. 



82 

 

10.8 Integral de superficie (Surface Integral) 

Solution → Surface Integral Integra un campo escalar sobre una superficie definida por selecciones de 

caras. Un ejemplo de uso es calcular la corriente a partir de la densidad de corriente. 

10.9 Integral de normal a la superficie (Surface Normal Integral) 

Solution → Surface Normal Integral integra el producto entro entre un campo vectorial y el vector normal 

saliente de la superficie. Un ejemplo de uso es calcular el caudal de calor a partir del flujo de calor. 

10.10 uma (Sum) 

Solution → Sum las sumas de los valores de las variables de la solución en los nodos de selección 
nombre predefinido. Sólo se puede utilizar para los componentes de la fuerza de reacción, componentes 
de la fuerza externa, fórmulas y variables de campo desconocido importadas de problemas externos. 

10.11 Fórmula (Formula) 

Solution → Formula genera una nueva variable de campo en función de variables de campo existentes, 
posición, tiempo y algunas propiedades del material. Las variables y operadores disponibles se enumeran 
en la ventana de fórmula. Algunos ejemplos: 

10.11.1 Momento de reacción 

Los momentos de reacción compuestos por parejas de fuerza no se incluyen en la salida predeterminada 
de momento de reacción. Sin embargo, puede calcular el momento de cada fuerza de reacción sobre el 

origen utilizando las siguientes fórmulas y luego usar Solution→ Sum para sumarlas en un solo valor. 

 Reaction moment about X:  FR.z * y - FR.y * z + MR.x 

 Reaction moment about Y:  FR.x * z - FR.z * x + MR.y 

 Reaction moment about Z:  FR.y * x - FR.x * y + MR.z 

Los términos MR.x y MR.y no deben ser incluidos si no hay elementos con GDL rotacionales. 

10.11.2 Sistemas en coordenadas cilíndricas 

Los archivos DisplacementCylindrical liml. y StressCylindrical.liml en la carpeta de ejemplos 
contienen fórmulas que transforman los campos de desplazamiento y tensión de una solución a 

coordenadas cilíndricas con Z como el eje de simetría. Puede usar File→ Import ... para agregar estas 

fórmulas a un modelo existente. 

𝑟 ⋅ 𝑢

|𝑟|
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11 Capítulo 11 

Ejemplos y verificación 

11.1 BeamBendingAndTwisting.liml 

Tipo de análisis: 3D Estático 

Elementos: Viga (line2) 

Cargas y restricciones: soporte fijo, fuerza, momento 

Este ejemplo muestra como Mecway halla la tensión longitudinal debida a la flexión de una viga con una 
sección transversal predefinida. También muestra la rigidez torsional y que la torsión no influye en la 
tensión longitudinal. La viga está hecha de un tubo rectangular hueco con propiedades: 

Anchura: A=23mm 

Altura: B=50mm 

Grosor de la pared: t=2mm 

Longitud: l=2m 

Módulo de Young: E=200GPa 

Coeficiente de Poisson: 0,3 

 

La viga está orientada a 45 grados del eje Y y está totalmente restringida en un lado y en el otro extremo 
cargada con una fuerza lateral de 1N y un momento de torsión de 2 Nm. 

Mecway informa la tensión en 5 ubicaciones en la sección 
transversal: cada una de las cuatro esquinas exteriores y un 
punto p definido por el usuario en una esquina interior. Estos 
resultados se comparan con los cálculos a mano de abajo. 

La tensión longitudinal en la base de la viga en el punto 1 (W1 = 
12,5 mm) debe ser 

𝜎1 =
𝑀𝑉𝑊1

𝐼𝑉𝑉
= 0.844490𝑀𝑃𝑎 

La tensión longitudinal en el punto p definido por el usuario (Wp = -10.5mm) debe ser 

𝜎𝑝 =
𝑀𝑉𝑊𝑝

𝐼𝑉𝑉
= −0.709372𝑀𝑃𝑎 

El momento de flexión sobre el eje V (MV) es 2m×1N = 2Nm. El segundo momento de área respecto al 
eje V (IVV) puede ser hallado usando una fórmula fácilmente disponible y el teorema de ejes paralelos: 

𝐼𝑉𝑉 = 29603
2

3
𝑚𝑚4 

Mecway muestra los mismos valores de tensión: 
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El ángulo de torsión puede ser encontrada usando 

𝜃 =
𝑙𝑇

𝐺𝐽
 

Donde l es la longitud de la viga (2m), T es el par aplicado 

(2Nm), G es el módulo de rigidez (
200

2.6
𝐺𝑃𝑎), y J es la torsión 

constante que se aproxima por   

𝐽 ≈
2𝑡(𝑎 − 𝑡)2(𝑏 − 𝑡)2

𝑎 + 𝑏 − 2𝑡
= 6.86657 × 10−8𝑚4 

(Warren C. Young, Roark's Formulas for Stress & Strain) 

Esto da θ=7.5729×10-4 radianes que es igual al ángulo de 
torsión encontrado por Mecway, ya que Mecway utiliza la 
misma fórmula aproximada para J. 

11.2 CompositeBeam.liml 

Tipo de análisis: 3D Estático 

Elementos: Viga (line2), Cáscara (quad8), Sólido continuo (hex20) 

Cargas y restricciones: Soporte fijo, Fuerza, Momento, Desplazamiento de 
elemento 

Esta viga está hecha de dos materiales diferentes mediante una combinación de elementos viga y cáscara. 
El alma está hecha a partir de una línea de elementos viga, mientras que el ala está hecha de cáscaras 
conectadas a los elementos viga. Se especifica un Desplazamiento de elemento de 0.105m para ubicar 
los elementos cáscara en el borde del alma en lugar de en el centro. 

 



85 

 

Se incluye un modelo sólido equivalente en el mismo archivo para comparación. Las soluciones de ambos 
modelos muestran la viga que gira alrededor de un punto en la intersección del alma y el ala porque esta 
es la ubicación del centro de torsión. 

 

Ahora vamos a calcular el ángulo de torsión considerando la rigidez del alma y el ala 
independientemente: 

Constante de torsión del ala o el alma 

𝐽 =
𝐵𝑡3

3
=

0.2 × 0.013

3
= 6.6667 × 10−8𝑚4 

Módulo de cizalladura del ala 

𝐺𝑓𝑙𝑎𝑛𝑔𝑒 =
𝐸𝑓𝑙𝑎𝑛𝑔𝑒

2(1 + 0.3)
= 1 × 109𝑃𝑎 

Módulo de cizalladura del alma 

𝐺𝑤𝑒𝑏 =
𝐸𝑤𝑒𝑏

2(1 + 0.3)
= 2 × 109𝑃𝑎 

Ángulo de giro 

𝜃 =
𝑙𝑇

𝐽(𝐺𝑓𝑙𝑎𝑛𝑔𝑒 + 𝐺𝑤𝑒𝑏)
=

3.2𝑚 × 6𝑁𝑚

6.6667 × 10−8𝑚4(1 × 109𝑃𝑎 + 2 × 109𝑃𝑎)
= 0.108𝑟𝑎𝑑𝑖𝑎𝑛𝑠 

Esto casi coincide con el ángulo de 0,109 radianes dado por Mecway para la rotación sobre X en la 
punta de la viga. 
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11.3 CylinderLifting.liml 

Tipo de análisis: Estático 3D 

Elementos: cáscara (tri6, quad8) 

Cargas y restricciones: soporte fijo, Gravedad, Presión 

Este ejemplo muestra el uso de elementos cáscara, para un recipiente a presión en dos configuraciones 
diferentes – peso propio por gravedad, y el mismo con una carga de presión interna adicional. Se utiliza 
material de diferente espesor para las tapas de los extremos. 

 

En la configuración con presión, la tensión equivalente de von Mises en la superficie exterior del en el 
centro de cada tapa es de 1,64×106 Pa. Refinando la malla 16 veces el número de elementos muestra 
que esta tensión tener un error de aproximadamente 2%. La superficie externa se denomina superficie 
inferior en la solución. Usted puede ver esto activando Show element axes para mostrar la dirección del 
eje W azul de cada elemento.  
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11.4 PressureVesselAxisymmetric.liml 

Tipo de análisis: axisimétrico estático 

Elementos: Axisimétrico continuo (quad8) 

Cargas y restricciones: desplazamiento, presión 

 

Este es un recipiente a presión cilíndrico con cabezales semielipsoidales. Es modelado como axisimétrico 
porque la geometría y cargas todas tienen simetría axial sobre el eje longitudinal. Sólo una mitad se 
modela por la simetría de espejo y se aplica una restricción de desplazamiento en la dirección Y para 
hacer cumplir esta condición de contorno. 

Es de acero (E=200GPa, ν=0,3) con un grosor de pared 
t=20mm, un radio interno r=500mm y presión interna 
P=1MPa. 

Usaremos tres pruebas para validar los resultados: 

La fuerza de reacción longitudinal en la pared cilíndrica en 
la frontera de simetría de espejo  

FY = -P×πr2 = -785kN comparado a los -798 kN de 
Mecway 

La tensión axial en la pared cilíndrica es 

𝜎𝑌𝑌 =
𝐹𝑌

𝜋((𝑟+𝑡)2−𝑟2)
= 12.25𝑀𝑃𝑎 comparada con 12.44 

MPa de Mecway 

La tensión circunferencial en el medio de la pared cilíndrica 
es 

𝜎𝑍𝑍 =
𝑃𝑟

𝑡
= 25.00𝑀𝑃𝑎 comparada con 25.00 MPa de 

Mecway 

 

 

 

 

 

 

 

11.5 MembraneActionPlate.liml 

 

Tipo de análisis: estático no lineal 

Elementos: sólido continuo (hex20) 

Cargas y restricciones: soporte sin fricción, desplazamiento, presión  

 

En este ejemplo se muestra el efecto no lineal de la acción de membrana que rigidiza una placa circular 
apoyada en los bordes. Los soportes permiten la rotación alrededor del borde, pero no el desplazamiento 
en ninguna dirección. Como el desplazamiento radial está restringido, cuando se aplica una carga de 
presión a la superficie y la placa se flexiona, se desarrolla una tensión de tracción de membrana en ella 
que resiste mayores flexiones. 
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Sólo se modela una cuarta parte de la placa por la simetría. Se usan soportes sin fricción para forzar la 
simetría especular sobre dos superficies. 

La solución muestra que el desplazamiento en Z en el centro del círculo es -1,5mm, lo cual es significativo 
en comparación el espesor de la placa de 1mm. 

Cambiando el tipo de análisis de estático no lineal 3D a Estático 3D y resolviendo de nuevo se obtiene un 
desplazamiento mayor en el centro, de -7.8mm. Esta solución lineal está equivocada, porque está hecha 
con el supuesto de pequeños desplazamientos, por lo que omite la rigidez de membrana dominante que 
sólo aparece después de que la placa comienza a flexionarse. 

11.6 SaggingCable.liml 

 

Tipo de análisis; estático no lineal 

Elementos: Barra (line2) 

Cargas y restricciones: desplazamiento, fuerza, gravedad 

Un cable flexible o la cuerda está suspendida entre un punto fijo y un punto deslizante horizontalmente. 
Se aplica una fuerza en el punto de deslizamiento para mantener el cable en tensión. Encontraremos el 
desplazamiento vertical del centro. 

Como el cable sin tensión no tiene rigidez flexional y no puede soportar cualquier carga lateral, la fuerza 
de tracción se aplica primero. Esto le da rigidez para soportar la carga de gravedad que se aplica en el 
segundo paso de tiempo. 

En time=1s el cable se tensa (a la izquierda) en time=2s se aplica la gravedad causando que se doble 
(derecha). 
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La deformada es una catenaria con el vértice en el origen, que tiene fórmula 

Y=a cosh(x/a)-a 

a=F / (ρ A g) 

Fuerza de tracción F = 2000N 

ρ = densidad 8000kg/m3. 

Área de sección transversal A = 0,01 m2 

Gravedad g = 9.8N/kg. 

La solución muestra que la mitad de la longitud horizontal del cable deformado es x=3.63792m. 
Usando este valor, la fórmula da y=3.0645m que está dentro del 0.1% de la distancia en la 
solución (3.0680m). 

11.7 BucklingBeam.liml 

 

Tipo de análisis: Pandeo 

Elementos: Viga (line2) 

Cargas y restricciones: soporte fijo, fuerza 

 

Consideremos una columna fija en la base y libre en la parte superior, sujeta a una fuerza axial de 
compresión. Vamos a encontrar el valor de la fuerza en que pandea, la carga crítica. 

La columna es de longitud L = 100 mm, la sección transversal es de 
10mm×10mm cuadrados y el módulo de Young es E=200 GPa. 

El modelo está hecho con elementos line2. La cara inferior tiene un soporte fijo 
para limitar el desplazamiento y rotación. Se ha sido aplicada una carga puntual de 
1N en la parte superior. 

La ecuación de pandeo de Euler se usa para calcular la carga crítica: 

Pcr= 2E I / (K L)2 

K = 2 para estas condiciones de contorno 

E = 2× 105 N/m2 

I = 833.333mm4 

L = 100 mm 

Carga crítica, Pcr= 41123N 

 

El factor de pandeo para el modo 1 encontrados por Mecway es 41125 y se 
aproxima al valor teórico con el refinamiento de malla. Esto es igual a la carga de 
pandeo en Newtons porque en el modelo se aplicó una fuerza de 1N. La figura 
muestra la forma del modo del primer modo de pandeo. 

El punto de cambio se fijó en 1000 que suele ser razonable, un orden de 
magnitud inferior al menor factor de pandeo.  
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11.8 BucklingPlate.liml 

Tipo de análisis: Pandeo 

Elementos: sólido continuo (hex20) 

Cargas y restricciones: desplazamiento, presión 

Consideremos una placa simplemente apoyada con una carga de compresión en los dos extremos 
opuestos. Determinaremos las cargas críticas de los modos de pandeo más bajos. 

 

Se restringen los movimientos de traslación a lo largo del eje Z en todos los bordes, pero son libres de 
girar sobre la dirección del borde. Se permite movimiento traslacional en el plano X-Y, pero el borde 
inferior se limita a proporcionar una fuerza de reacción a la fuerza aplicada. Un único nodo escogido 
arbitrariamente se limita en la dirección X para evitar el movimiento de cuerpo rígido. 

La carga total aplicada es igual a 1, por lo que los factores de pandeo producidos por el Solucionador son 
iguales a las cargas críticas. 

Para placas finas como las usadas anteriormente, la siguiente ecuación analítica puede utilizarse para 
calcular las cuatro primeras cargas críticas: 

Fcr= b2a2D ([m/a]2+ [n/b]2)2/ m2 

Fcr: la crítica a la carga aplicada a un borde 
a=2: la longitud en la dirección de la carga 
b=1: Ancho 

D=E t3/ [12 (1-ν2)]: rigidez de la placa 

t=0,0125: Espesor 

ν =0.3: Coeficiente de Poisson 

E=1e6: módulo de Young 
m Número de medias ondas de pandeo en la dirección de la carga 
n: Número de medias ondas de pandero perpendicular a la carga 

Para m=1 y n=1, Fcr=11.0. El modelo de Mecway da 11.1 
Para m=2 y n=1, Fcr=7.06. El modelo de Mecway da 7.14 (imagen de abajo) 
Para m=3 y n=1, Fcr=8,29. El modelo de Mecway da 8,60 
Para m=4 y n=1, Fcr=11.0. El modelo de Mecway da 12.0 
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Observe que la menor carga crítica es para el modo con 2 medias ondas, este modo se desarrollará 
primero bajo una carga creciente. 

11.9 BucklingPlateNonlinear.liml 

Tipo de análisis: estático no lineal 

Elementos: sólido continuo (hex20) 

Cargas y restricciones: desplazamiento, fuerza 

 

Este es el mismo caso que BucklingPlate.liml más arriba, pero se resuelve mediante análisis estático no 
lineal en lugar de análisis de pandeo lineal. 

La carga aplicada se incrementa desde 6N a 8N que incluye la carga crítica esperada para el primer 
modo de pandeo. Si usted no sabe la carga crítica de antemano, tendría que aumentar la carga desde 
cero. 

Un modelo perfectamente simétrico no pandea en análisis no lineal por lo que debemos aplicar una 
imperfección que inicie el pandeo. Se aplica una pequeña fuerza fuera de plano de 0.0001N en una 
ubicación arbitraria que no esté en una línea nodal de la forma de modo. 

La solución para desplazamiento fuera del plano muestra que el pandeo se iniciada en una carga de 
7.0-7.1N que contiene la carga crítica teórica de 7.06N. En este gráfico, el tiempo = 0 corresponde a 
una carga de 6N y tiempo = 1 corresponde al 8N. 

 

 

 

11.10 PipeClip.liml 

 

Tipo de análisis; estático no lineal 3D 

Elementos: sólido continuo (tet10) 

Cargas y restricciones:  soporte fijo,  soporte sin fricción, Desplazamiento, 
Contacto 

 

Este ejemplo muestra contacto no-lineal entre dos partes diferentes: un tubo y una abrazadera usando el 
solucionador CCX.  

Las dos partes están definidas por geometría CAD en dos archivos .STEP clip.STEP y pipe.STEP que 
sólo se necesitan para reconstruir la malla. 

Las condiciones de frontera incluyen soporte sin fricción para forzar la simetría de espejo, soporte fijo en 
la base de la abrazadera donde estaría montada en otra parte y contacto (CCX) entre la superficie exterior 
del tubo y la interior de la abrazadera. 

El tubo se mueve dentro de la abrazadera con una restricción de desplazamiento dependiente del tiempo 
definida por la función uy = -12tmm/s. 
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La solución muestra una tensión máxima cuando la abrazadera es abierta completamente por el tubo, 
como se esperaba. 

11.11 BoltedJoint.liml 

Tipo de análisis: estático no lineal 3D 

Elementos: sólido continuo (hex20) 

Cargas y restricciones: Soporte fijo, Contacto unido, Contacto, Sección con pre-
tensión, Fuerza 

Este ejemplo muestra dos placas fijadas entre sí por un perno precargado con fricción entre las placas y 
una fuerza aplicada que se incrementa hasta que la conexión falla. 

 

La cabeza del perno está unida a una de las placas con contacto unido para hacer una conexión robusta. 
También se podría usar contacto en su lugar para permitir que se deslice o se separe. Las otras superficies 
están conectadas por contacto para que puedan separarse. 

La fuerza de precarga en el perno es constante de 10 kN y el coeficiente de fricción entre las placas es 

de 0,5 por lo que esperamos que la carga máxima que puede llevar la junta sea de 0,5 × 10 kN = 5 kN. 

El solucionador falla después de tiempo = 0.5 s con el mensaje 

*ERROR: solution seems to diverge; please try 

 automatic incrementation; program stops 

 best solution and residuals are in the frd file 
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0,5 s corresponde a una fuerza aplicada de 5 kN como se esperaba. Podemos tener idea de la causa del 
fallo observando la forma deformada final no convergente. Coloque el control deslizante de la línea de 
tiempo en 0.6 s y observe que la magnitud de desplazamiento de la placa cargada es muy grande, en 
este caso, del orden de 1011 m. Establezca Solution → Deformed view settings → Scale factor a una 
escala razonable de aproximadamente el 10% de la inversa de eso, que en este caso es 1e-12. Ahora 
podemos ver que hubo un movimiento de cuerpo rígido de la placa cargada, lo cual indica que se liberó 
de la fricción como se esperaba. 

 

También podemos ver la deflexión a cargas más bajas como t = 0,4 s con un factor de escala de 
deformación de 20. 
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11.12 FinConvection.liml 

Tipo de análisis: Estado Estacionario térmico 

Elementos: aleta (line2, line3) 

Cargas y restricciones: temperatura, convección 

Mecway encontrará la distribución de temperatura a lo largo de la longitud de la aleta térmica que se 

muestra abajo. Entra calor en la base de la aleta que se mantiene a una temperatura fija de 230°C y se 

disipa a través de los 4 lados por convección. El material tiene una conductividad térmica de k=380W/(mK). 
El modelo contiene dos mallas alternativas para la misma aleta, una usando un elemento line3 y el otro 
con dos elementos line2. 

 

La temperatura (Tx) a una distancia "X" desde la base de la aleta está dada por 

𝑇𝑥 − 𝑇𝑎

𝑇0 − 𝑇𝑎
=

𝑐𝑜𝑠ℎ(𝑚𝐿 − 𝑚𝑥)

𝑐𝑜𝑠ℎ(𝑚𝐿)
 

Donde 𝑚 = √
ℎ𝑃

𝑘𝐴
 

P es el perímetro de la sección transversal, 0.032m 

A es el área de la sección transversal, 0.000015m2 

La siguiente tabla muestra la coincidencia entre los resultados de Mecway y las temperaturas dadas por 
la fórmula anterior. 

Ubicación Tx de la fórmula 2 elementos line2 1 elemento line3 

Punto medio 
(x=0.005m) 

228.3306°C 228.3299°C 228.3306°C 

Final (x=0,01 m) 227.7752°C 227.7742°C 228.7752°C 

 

11.13 ConductionConvectionRadiation.liml 

Tipo de análisis: Estado Estacionario térmico 

Elementos: cáscara (quad4), sólido continuo (hex8), aleta (Line2) 

Cargas y restricciones: temperatura, radiación, convección 

Este modelo muestra la transferencia de calor en estado estacionario unidimensional, por conducción 
convección y radiación a través de una losa de 0.05 m de espesor. El calor fluye a través de la superficie 
del lado izquierdo que se mantiene s 500 K y fluye a través de la superficie del lado derecho por 
convección (coeficiente de transferencia de calor h = 37.5 W/(m2K)) y radiación (emisividad ε = 0.8) a una 
temperatura ambiente de 300 K. 



95 

 

 

Se incluyen tres versiones del modelo en el mismo archivo, usando elementos lamina, aleta y sólidos. Los 
tres proporcionan los mismos resultados excepto que el flujo de calor no está disponible para el elemento 
aleta. 

 

Para verificar el análisis haremos un simple balance térmico: 

qconducción = qconvección + qradiación 

El flujo de calor por conducción (qconducción) es dado por Mecway como el componente X del flujo de calor 
que es la misma en todo el modelo 

qconducción = 3591.65 W/m2 

El flujo de calor por convección se encuentra mediante la temperatura calculada por Mecway para la 
cara derecha (Tsuperficie=380.2783K) 

qconvección = h(Tsuperficie-Tambiente) = 3010.44 W/m2 

El flujo de calor por radiación se encuentra en forma similar, pero utilizando la ley de Stefan-Boltzmann 

qradiación = εσ(Tsuperficie
4-Tambiente

4) = 581.21 W/m2 

 Donde σ es la constante de Stefan-Boltzmann, 5.67037ͯ10-8 Wm-2K-4 

La ecuación de balance de calor se cumple: 

3591.65 W/m2 = 3010.44 W/m2 + 581.21 W/m2 

11.14 OscillatingHeatFlow.liml 

Tipo de análisis: transitorio térmico 

Elementos: cáscara (quad8) 

Cargas y restricciones: tasa de flujo de calor 

Una barra de aluminio aislada es calentada por una carga térmica oscilante aplicada a un extremo, y 
luego se retira. Mecway encontrará la temperatura en la barra en función del tiempo y la distancia a lo 
largo de la barra. Las propiedades del material son: 
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Capacidad calorífica específica, cp = 900 K/(kg.K) 

Densidad, ρ = 2700 kg/m3. 

Conductividad térmica, k = 200 W/(m.K) 

 

 

La carga de calor Q(t) es entrada en Mecway como una tabla de valores de tasa de flujo de calor cada 
0,2 segundos según esta función: 

 

𝑄(𝑡) = {
(100𝑐𝑜𝑠(𝑡) + 20)𝑊

0
 𝑡 ≤ 34.6𝑠
 𝑡 > 34.6𝑠

 

 

El siguiente gráfico muestra la variación de la temperatura con el tiempo, en dos puntos. La curva roja se 
mide en el extremo de la barra (x=0) y la curva amarilla es la temperatura medida en la profundidad 
pelicular (x=δ). 
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Estos resultados son verificados de dos maneras, en primer lugar, comparando la relación de amplitudes 
de onda de la temperatura en dos puntos con la relación teórica y, en segundo lugar, comparando la 
entrada neta de calor con el aumento total de la temperatura después de que se ha alcanzado el equilibrio. 

La profundidad pelicular δ es la distancia a la cual la amplitud de la variación de la temperatura es 1/e de 
la amplitud en x=0. Está dada por 

𝛿 = √
𝑘𝑃

𝜌𝑐𝑝𝜋
 

Donde P es el período de la onda de temperatura. P=2π        δ = 0.01283001m 

Se coloca un nodo de malla en x=δ para facilitar la medición. El gráfico anterior muestra que la amplitud 
pico-pico de temperatura en este nodo es de 21°C. También muestra que la amplitud pico-pico de la 
temperatura en x=0 es 57°C. 57/20 = 2,85 ≈ e como se esperaba. 

El aumento esperado de temperatura de t=0 a t=∞ es 

𝛥𝑇 =
𝑄𝑛𝑒𝑡

𝜌𝑐𝑝𝑉
 

V = volumen de la barra = 1.5625×10-5m3 

𝑄𝑛𝑒𝑡 = ∫ 𝑄
34.6

0

(𝑡)𝑑𝑡 = ∫ (100𝑐𝑜𝑠(𝑡) + 20)
34.6

0

𝑊𝑑𝑡 

= [100𝑠𝑖𝑛(𝑡) + 20𝑡]𝑎
𝑏𝐽 = 687.75𝐽 

𝛥𝑇 = 18°𝐶 

Esto concuerda con el último valor de temperatura dada por Mecway en toda la barra que está a 18°C. 

11.15 CoolantChannel.liml 

Tipo de análisis: térmico de estado estacionario 

Elementos: red de fluido (line3), Sólidos continuos (wedge15, hex20) 

Cargas y restricciones: temperatura, convección forzada, caudal másico, tasa de 
flujo de calor 

Una fuente de calor está siendo enfriada por agua bombeada a través de un canal en un bloque de 
fundición. Encontraremos la distribución de temperatura dentro de la fundición y confirmaremos que el 
calor es arrastrado por el agua a la misma velocidad que es generado por la fuente de calor. 

 

Después de resolver, podemos ver que el canal de agua enfría la fundición. 
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El caudal de calor arrastrado por el agua es 

Q̇ = ṁ cp ΔT 

Caudal másico, ṁ, se especifica como 0,04 kg/s. 

Calor específico a presión constante para el agua, cp = 4180 J/kg/K 

Diferencia de temperatura entre la entrada y la salida, ΔT = 22.990°C – 20.000°C = 2.990 K 

Entonces Q̇ = 499.9 W que casi coincide con el caudal de calor de entrada especificado de 500.0 W. 

 

11.16 VibratingFreePlate.liml 

Tipo de análisis: Frecuencia 

Elementos: cáscara (quad8) 

Cargas y restricciones: ninguna 

Este ejemplo muestra los modos de vibración naturales no amortiguados de una placa cuadrada sin 
soportes. Sus propiedades son: 

Longitud de lado, a = 0,1 m 

Espesor, h = 1mm 

Módulo de Young E = 200 GPa 

Coeficiente de Poisson, ν = 0,225 

Densidad, ρ = 8000 kg/m3. 

Los tres primeros modos de deformación encontrados por Mecway se muestran a continuación junto con 
sus frecuencias angulares. También Mecway produce 6 modos de cuerpo rígido porque la placa no está 
restringida. 
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ω1 = 2114 rad/s ω2 = 3122 rad/s ω3 = 3662 rad/s 

Estos resultados son verificados por comparación con las fórmulas analíticas de (William Weaver, Jr., 
Stephen P. Timoshenko, Donovan H. Young, Vibration Problems in Engineering, 1990): 

𝜔 =
𝛼

𝑎2
√

𝐷

𝜌ℎ
 

𝐷 =
𝐸ℎ3

12(1 − 𝜈 2)
 

α1 = 14.10, ω1 = 2089 rad/s 

α2 = 20.56, ω2 = 3046 rad/s 

α3 = 23.91, ω3 = 3542 rad/s 

Para los tres modos el error es inferior al 4% y puede ser reducido a menos del 1% refinando la malla. 

 

11.17 VibratingCantileverBeam.liml 

Tipo de análisis: Frecuencia 

Elementos: Viga (line2) 

Cargas y restricciones: soporte fijo 

Se utilizan elementos viga para modelar una viga vibrante en voladizo fijada en un extremo y libre en el 
otro. Se necesitan al menos cuatro elementos para capturar los modos de flexión superiores. Las 
propiedades de la viga son: 

Longitud L = 2,4 m 

Ancho, b = 0,1 m 

Altura h = 0,05 m 

Módulo de Young, E = 200 GPa 

Densidad, ρ = 7860 kg/m3. 

 

Las frecuencias de los primeros 3 modos para flexión en el plano XY son verificadas por la fórmula 
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𝑓𝑛 =
𝛼2

2𝜋
√

𝐸𝐼

𝜌𝑏ℎ𝐿4
 

α1 = 1.875 

α2 = 4.694 

α3 = 7.885 

𝐼 =
𝑏ℎ3

12
= 2.0833 × 10−6𝑚4 

Que da estas frecuencias en comparación con las de Mecway 

Modo Frecuencia de la 
fórmula 

Frecuencia de Mecway 

n=1 7.073 Hz 7.074 Hz 

n=2 44.33 Hz 44.38 Hz 

n=3 125,1 Hz 125,1 Hz 

La solución de Mecway es 3D y por tanto también incluye modos para flexión en la dirección Z que se 
desprecian en este cálculo 2D. 

11.18 VibratingCantileverSolid.liml 

Tipo de análisis: Frecuencia 

Elementos: sólido continuo (hex20) 

Cargas y restricciones: soporte fijo 

Este es un modelo de la misma viga descrita en VibratingCantileverBeam.liml, pero se hace mediante 
elementos sólidos hex20. La siguiente imagen muestra las mismas formas de modo que se muestran 
para VibratingCantileverBeam.liml. 

 

Modo Frecuencia de la 
fórmula 

Frecuencia de Mecway 

N=1 7.073 Hz 7.089 Hz 

N=2 44.33 Hz 44.99 Hz 

N=3 125,1 Hz 128.7 Hz 

- 
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11.19 VibratingTrussTower.liml 

Tipo de Análisis: frecuencia, Estático 3D 

Elementos: Barra (line2) 

Cargas y restricciones: desplazamiento, fuerza 

Una torre reticulada será analizada para encontrar el modo de 
vibración torsional fundamental. Es de 20m de alto y hecha de 10 
secciones idénticas de 1mx1mx2m conectadas extremo a extremo. 
Cada sección utiliza dos tipos de vigas de acero - las cerchas en las 
esquinas tienen 0.01m2 el área transversal y los miembros de 
arrostramiento que tienen 0,001 m2 de sección transversal. Todas las 
articulaciones son libres para girar en cualquier dirección. El módulo 
de Young del acero es de 200 GPa y la densidad es de 7800kg/m3. 
Los 4 nodos en la base están limitados contra el desplazamiento en 
todas las direcciones. 

Los dos primeros modos encontrados por Mecway son modos de 
flexión y el tercero es el modo de torsión fundamental mostrada abajo 
junto con su frecuencia 

fMecway=7.64 Hz 

 

Este resultado es validado mediante la fórmula del modo fundamental 
de torsión del eje uniforme con masa distribuida 

𝑓 =
1

4
√

𝐾

𝐼
 

I = 3640.54 kgm2 es la inercia rotacional de la estructura entera sobre su eje longitudinal. Se puede 
encontrar mediante la suma de la inercia rotacional de todos los 250 elementos de la armadura. 

K es la rigidez a la torsión de la estructura. Esta se halla utilizando Mecway para realizar un análisis 
estático con un momento aplicado de 1 Nm, y a continuación, midiendo la rotación resultante al final. El 
momento se aplica usando 4 fuerzas en los 4 nodos superiores. Si des suprime el grupo llamado Moment 
y cambia el tipo de análisis a Estático 3D para luego resolverlo, mostrará que los nodos superiores giran 
cada uno en θ = 2.92843×10-7 radianes alrededor del eje longitudinal de la torre. Esto da K = 1Nm / θ = 
3.41480×106 Nm/Radian. 

La frecuencia dada por esta fórmula coincide con el resultado de Mecway dentro de un 0,3%. 

f = 7,66 Hz 
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11.20 VibratingMembrane.liml 

Tipo de análisis: Frecuencia 

Elementos: cáscara (tri6) 

Cargas y restricciones: soporte fijo, desplazamiento, estrés térmico, temperatura 

Una hoja hexagonal de tejido se fija alrededor de su borde exterior y mantenida en estado de tensión 
isótropa uniforme biaxial. Puede vibrar como un tambor debido a la rigidez causada por su tensión. Vamos 
a encontrar sus primeros 3 frecuencias naturales y formas de modo. 

Densidad: 1000kg/m3. 

Grosor: 1 mm 

Distancia entre las esquinas opuestas: 600mm 

Tensión por unidad de longitud: 2N/m 

La tensión uniforme es aplicada mediante estrés térmico. Se utiliza un coeficiente de expansión térmica 
artificial de 1K-1 con un pequeño módulo de Young arbitrario de 0,001 N/m2 y un cambio de temperatura 
de -2×106K. Esto genera un estrés de 2000N/m2 que corresponde a una tensión de 

2000N/m2 × 1 mm = 2N/m. 

Puede confirmar la tensión de 2000N/m2 cambiando el tipo de análisis para 3D estático y resolviendo. 

Todos los elementos están restringidos contra el movimiento en las direcciones en el plano para acelerar 
la solución y evitar falsas modos en plano causado por la muy baja rigidez del material. 

Modo Forma de modo Frecuencia 

Modo 1 

0 diámetros nodales 

 

2.007 Hz 

Los modos 2 y 3 

1 diámetro nodal 

 

3.197 Hz 

Los modos 4 y 5 

2 diámetros nodales 

 

4.282 Hz 
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11.21 Impeller.liml 

Tipo de análisis: Frecuencia 

Elementos: Sólidos continuos (wedge15, hex20) 

Cargas y restricciones: Soporte fijo, Fuerza centrífuga, Simetría cíclica. 

 

Se encuentran los modos de vibración de un rotor de 17 álabes girando a 100.000 rpm. Las frecuencias 
de los modos dependen de la velocidad de rotación debido a que la fuerza centrífuga altera la rigidez a 
través de los efectos de rigidización por tensión y ablandamiento por rotación. 

La estructura se compone de 17 segmentos idénticos, de modo que sólo modelamos un segmento 
aprovechando la simetría cíclica. Como usa el solucionador interno, que los patrones nodo en ambas 
superficies del segmento son iguales. El solucionador CCX no tiene esta limitación. 

 

El material es acero (E=210GPa, ν=0,3, ρ=7800kg/m3) y la superficie interior está limitada en el marco 
de referencia giratorio para representar un eje rígido. Los resultados pueden ser inexactos para un eje 
flexible debido al efecto de Coriolis.  

El siguiente diagrama de Campbell muestra los 2 

primeros modos para 0, 1, 2 y 3 diámetros nodales 
(ND). Fue realizado resolviendo el modelo 6 veces, 

con 6 velocidades de rotación diferentes. 

El primer modo de álabe. La deformación de 
cada segmento es idéntica con 0 diámetros 
nodales. 

Un modo de disco con 2 diámetros nodales 
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11.22 VibratingString.liml 

Tipo de análisis: Frecuencia 

Elementos: sólido continuo (hex8) 

Cargas y restricciones: Desplazamiento, Fuerza 

Vamos a modelar la vibración transversal de un cable flexible recto tensado. El cable tiene las siguientes 
propiedades: 

• Longitud: L=60m 

• Densidad lineal: ρ=3kg/m 

• Fuerza de tracción: F=40N 

• Rigidez flexional: insignificante 

La solución es comparada con cálculos manuales utilizando la fórmula 

f = n/2 (F/ρ)1/2/L 

Donde f es la frecuencia y n es el número del modo de la onda estacionaria. El modelo de Mecway incluye 
los modos axiales que se omiten aquí porque son consecuencia de la rigidez arbitraria del material. 

Modo f (cálculo a mano). f (Mecway) 

n=1 0.03043 Hz 0.03042 Hz 

n=2 0.06086 Hz 0.06088 Hz 

n=3 0.09129 Hz 0.09141 Hz 

n=4 0.1349 Hz 0.1221 Hz 
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11.23 PandSWaves.liml 

Tipo de análisis: Respuesta Dinámica 2D 

Elementos: plano continuo (quad4) 

Cargas y restricciones: desplazamiento, fuerza 

Se utiliza análisis de respuesta dinámica para modelar la propagación de ondas a través de un 
medio elástico (roca). Se aplica una fuerza sinusoidal en el centro de un dominio infinito. Esto 
genera ondas de presión (ondas P) viajando hacia afuera en el sentido de la fuerza, y las ondas 
de cizalla (ondas S) viajando hacia afuera perpendicular a la fuerza. 

Dada la simetría, solo se modela un cuadrante del dominio. Hay simetría de espejo sobre el eje 
X que se impone al restringir el desplazamiento en Y a lo largo de los ejes. También hay anti-
simetría en la carga y el desplazamiento sobre el eje Y que se impone al restringir el 
desplazamiento en Y a lo largo del eje Y. Mecway no tiene condición de frontera en el infinito así 
que en su lugar se usa una frontera finita lejos de la fuente de las ondas. El análisis sólo se 
ejecuta hasta que las primeras ondas alcanzan la frontera para evitar las reflexiones en la frontera. 

Las propiedades del material son: 

Módulo de Young E = 7 GPa 

Coeficiente de Poisson ν = 0,2 

Densidad ρ = 3000 kg/m3 

Módulo de cizalladura 𝐺 =
𝐸

2(1+𝜈)
= 2.917𝐺𝑃𝑎 

Módulo de compresibilidad 𝐾 =
𝐸

3(1−2𝜈)
= 3.889𝐺𝑃𝑎 
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El gráfico de contorno en tiempo = 0,3 s muestra el desplazamiento en la dirección X utilizando únicamente 
2 colores (Tools→ Options→ Gráfico de contorno) para que las longitudes de onda se pueden leer 
fácilmente. Se usa la herramienta cinta métrica para medir la longitud de onda media de dos ondas P a 
lo largo del eje X resultando 406m/2 = 203m. De la misma manera, el promedio de la longitud de onda de 
2 ondas S se mide a lo largo del eje Y resultando 250m/2 = 125m. 

La solución es verificada comparando las longitudes de onda de las ondas P y las ondas S con sus valores 
teóricos. 

Las longitudes de onda teóricas son   𝜆𝑝 =
𝑐𝑝

𝑓
 y 𝜆𝑠 =

𝑐𝑠

𝑓
 

Donde 

𝑓 =
50

2𝜋
𝐻𝑧 Es la frecuencia de la fuerza aplicada 

𝑐𝑝 = √
4

3
𝐺+𝐾

𝜌
= 1610 𝑚 𝑠⁄  Es la velocidad de las ondas P. 

𝑐𝑠 = √
𝐺

𝜌
= 986.0𝑚 𝑠⁄  Es la velocidad de las ondas S. 

Esto da  𝜆𝑝 = 202𝑚 y 𝜆𝑠 = 124𝑚 

Que está dentro del 5% de los resultados de Mecway de 203m y 125m, respectivamente. 

11.24 DampedVibratingStrip.liml 

Tipo de análisis: Respuesta Dinámica 3D 

Elementos: cáscara (quad8) 

Cargas y restricciones: soporte fijo, fuerza, amortiguación de Rayleigh 

Este ejemplo muestra la amortiguación de Rayleigh aplicada a la vibración de una tira curvada. 

 

La carga estimula los modos de torsión y flexión lateral que tienen una frecuencia natural de ωn=6,91rad/s. 
La vibración es dejada decaer por amortiguación viscosa. Las constantes de amortiguación de Rayleigh 
se ajustan a α=1 y β=0,005 que dan una relación de amortiguamiento de ζ=0.08978 en ω=ωn. 

Alternativamente, esto puede expresarse como un factor  𝑄 =
1

2𝜁
= 5.569 
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Este coeficiente de amortiguamiento nos dice que la amplitud de la oscilación debe bajar con una 
constante de tiempo de 

𝜏 =
1

𝜔𝜁
=

1

6.91 𝑟𝑎𝑑 𝑠⁄ × 0.08978
= 1.61𝑠 

La medida de la constante de tiempo a partir de los picos de la curva de desplazamiento generados por 
Mecway también da 1.610s. 
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11.25 WheatstoneBridge.liml 

Tipo de análisis: el flujo de corriente continua 

Elementos: Resistencia (line2), sólido continuo (hex8) 

Cargas y restricciones: potencial eléctrico, Corriente 

Se modela en Mecway el circuito del puente de Wheatstone mostrado a continuación para encontrar la 
tensión V2 a través de R2 con una corriente aplicada de I=100mA. Tres de las resistencias son elementos 
de resistencia line2 y R4 se modela mediante elementos sólidos con terminales de alta conductividad 
para conectar l a los elementos resistencia. El nodo 3 se restringe a 0V y es el punto de referencia para 
los voltajes en los otros nodos. 

   

R1=750Ω 

R2=1000Ω 

R3=500Ω 

R4=1169.826Ω que fue encontrado por la integración de la forma curvada. 

Los cálculos a mano muestran que el voltaje en el nodo 2 es 

𝑉2 = 𝐼
(𝑅1 + 𝑅2)(𝑅3 + 𝑅4)

𝑅1 + 𝑅2 + 𝑅3 + 𝑅4

𝑅2

𝑅1 + 𝑅2
= 48.828𝑉 

Que coincide con el resultado de 48.823V de Mecway. La mayoría del error se debe a la tosquedad de la 
malla de elemento sólido de R4 y puede ser eliminada mediante su sustitución por un elemento de 
resistencia line2 con la resistencia indicada anteriormente. 

11.26 Capacitor.liml 

Tipo de análisis: 3D Estático 

Elementos: sólido continuo (pyr5, wedge6, hex8) 

Cargas y restricciones: potencial eléctrico 

Se modelará el campo eléctrico entre dos placas de un condensador. Las placas están separadas 
d=0.25m con un dieléctrico (εr=2,5) entre ellas y una diferencia de potencial de V=1.5V entre sí. Cada 
placa tiene un área A=0,2m×0,3 m. 
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El campo eléctrico esperado es 

E = V / d 

= 1,5 V / 0,25 m = 6 V/m. 

Lo que es consistente con los resultados de Mecway de 6.000000 V/m en cada nodo. 

La energía almacenada en el condensador espera es 

U = 1/2 C V2 

= 5.9766×10-12 J 

Donde  

C = A εr ε0 / d 

 ε0 = 8.854187818×10-12 F/m, la permeabilidad del vacío 

Esto corresponde a una densidad de energía U×A×d = 3.9844×10-10 J/m3. La densidad de energía dada 
por Mecway también es 3.9844×10-10 J/m3. 

Los efectos de borde no aparecen en este modelo porque la malla no tiene elementos fuera de la zona 
entre las placas. 

11.27 PiezoelectricStack.liml 

Tipo de Análisis: Estático 3D 

Elementos: Solido continuo (wedge15) 

Cargas y restricciones: Soporte sin fricción, Desplazamiento, Presión, Potencial 
eléctrico 

Una pila de 10 capas de discos cerámicos piezoeléctricos se analiza como actuador y como sensor de 
fuerza. Las capas se orientan con direcciones de polarización alternadas de + Z y -Z. Estos están definidos 
por la dirección del eje local W de cada elemento. La base de la pila tiene un soporte sin fricción para 
soportar la carga en el sensor y mantener el comportamiento unidimensional para que pueda ser 
fácilmente comparado con cálculos a mano. 
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Malla. Las flechas negras indican las direcciones de polarización. 

Las propiedades del material para PZT-5A son: 

Matriz de cumplimiento a campo eléctrico constante (cortocircuito) 

 

𝑠𝐸 =

[
 
 
 
 
 

16.4 −5.74 −7.22 0 0 0
−5.74 16.4 −7.22 0 0 0
−7.22 −7.22 18.8 0 0 0

0 0 0 47.5 0 0
0 0 0 0 47.5 0
0 0 0 0 0 44.3]

 
 
 
 
 

× 10−12
m2

N
 

 

Esto muestra que el material es isótropo transversalmente con los 3 ejes que son ejes de simetría. En 
Mecway, esto corresponde al eje local W del elemento. 

Matriz de coeficientes de acoplamiento d 

𝑑 = [
0 0 0 0 584 0
0 0 0 584 0 0

−171 −171 374 0 0 0
] × 10−12

m

V
 

Debido a la isotropía transversal, d32=d31 y d24=d15 algunas fuentes de datos de materiales pueden incluir 
sólo los 3 valores únicos d31, d33 y d15. 

Matriz de permeabilidad en tensión constante (sujetada) 

𝜀𝑇 = [
1730 0 0

0 1730 0
0 0 1700

] × 𝜀0 

Actuador 

El archivo de ejemplo está configurado para actuar como un actuador accionado por una fuente de tensión 
por tener dos conjuntos de restricciones de potenciales eléctricos en las caras entre las capas. La tensión 
se da por la ecuación de actuador: 

S = sE T + d E 

Para comportamiento 1D, esto se convierte en una ecuación escalar con 

Campo eléctrico E = EW = 200 V / 200 μm = 106 V/m 

Coeficiente de acoplamiento d = d33 = 3.74×10-10 m/V 

Tensión T = 0 porque no hay restricciones ni cargas mecánicas. 
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Esto da una tensión S = 0,000374. La longitud total de la pila es de 2 mm por lo que su cambio en longitud 
debe ser 2 mm x 0,000374 = 0,748 μm. La solución de Mecway está de acuerdo con este desplazamiento 
en Z = 0,748 μm en la superficie superior 

 

Sensor 

Si suprime las dos primeras restricciones de potencial eléctrico y Des suprime la carga de presión, el 
modelo se convierte en un sensor que produce una tensión eléctrica a través de cada capa en respuesta 
a la presión aplicada. El campo eléctrico está dado por la ecuación de sensor: 

D = d T + εT E 

Para comportamiento 1D, esto también se convierte en una ecuación escalar con 

Desplazamiento eléctrico D = 0 porque es un circuito abierto. 

Coeficiente de acoplamiento d = d33 = 3.74×10-10 m/V 

Tensión T = -3 MPa 

Permisividad en tensión constante εT = εT
33 =1700 × ε0 = 1.505×10-8 C/(Vm) 

Esto da un campo eléctrico E = 74500 N/C (o V/m) en la dirección 3. La solución de Mecway está de 
acuerdo con este campo eléctrico Z = 74.541 V/m en los elementos en los que la dirección 3 es la misma 
que el eje Z global y -74 541 V/m en los elementos invertidos. 
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A partir del componente Z del campo eléctrico, podemos encontrar la diferencia de potencial a través de 
una capa como  

V = -E d 

En la capa superior con un espesor de d = 0,2 mm y E positivo, V = -14,9 V que está de acuerdo con el 
resultado de Mecway de 14,91 V en la parte inferior de la capa y 0 V en la parte superior. 
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12 Capítulo 12 

Formatos de archivo 

Mecway puede abrir y guardar una amplia gama de formatos de archivo para intercambiar con otros 
softwares. Algunas de estos (dxf, msh, stl, vol y xyz) no contienen unidades físicas así se pedirá que elija 
la unidad de longitud al abrirlos. 

Para exportar la malla deformada de una solución, use Mesh tools→Transfer displacements from 
solution... para deformar la malla del modelo, luego expórtela. 

12.1 .liml 

Este es el formato de archivo nativo de Mecway. Utiliza XML, que es un formato de texto legible. Un 
ejemplo simple de un archivo que contiene dos nodos y un elemento viga 

<liml version="3"> 

  <node nid="1" x="0" y="0" z="0" /> 

  <node nid="2" x="1" y="1" z="0" /> 

  <elset> 

    <elem eid="1" shape="line2" nodes="1 2" /> 

  </elset> 

</liml> 

Los números sin unidades son o bien adimensionales, tales como números de nodo mostrados 
anteriormente, o se encuentran en unidades SI, como las coordenadas de nodo mostradas anteriormente 
que están en metros, independientemente de la unidad usada para mostrarlos en Mecway. Los símbolos 
de unidad se incluyen después del número o, en el caso de fórmulas, aparecen como atributos XML 
independientes. 

12.2 STEP (.step/.stp) 

Mecway puede abrir un archivo STEP que contiene un único cuerpo sólido. Cuando se abre un archivo 
STEP, aparece en la rama Geometría del esquema de árbol. Puede hacer clic en este elemento del menú 
para generar una malla. Consulte el Capítulo 5 Modelos CAD para obtener más detalles. Mecway no 
guarda en este formato. 

12.3 .dxf 

Mecway puede leer algunas características de la versión ASCII de archivos DXF R14. Los nodos en las 
mismas ubicaciones se combinan automáticamente juntos. Las curvas se convierten en elementos line3 
que son curvas parabólicas por lo que no se puede representar exactamente la geometría original, pero 
son lo suficientemente precisas para muchos propósitos. Si refina estos elementos line3 curvos o usa 
Automesh 2D con ellas, conservan su curvatura. Las capas se convierten en componentes con la capa 
0 convirtiéndose en el componente predeterminado. Mecway no guarda en formato DXF. 

POINT - se convierte en un nodo 

LINE - se convierte en un elemento de line2 

LWPOLYLINE - segmentos rectos se convierten en elementos de line2 y los segmentos de arco se 
convierten en cadenas de elementos line3 de la misma forma que ARC. 

CIRCLE - se convierte en 8 elementos line3. 

ELLIPSE - se convierte en una cadena de elementos line3 con cada elemento abarcando 
aproximadamente 45 grados. 
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ARC - se convierte en una cadena de elementos line3 de tamaño uniforme con cada elemento 
representando un arco de aproximadamente 45 grados. 

3DFACE- se convierte en un elemento tri3 o quad4. 

INSERT - importa el contenido de un BLOCK. Las filas y columnas se ignoran. 

BLOCK - los contenidos son importados en Mecway con cada entidad INSERT asociada, pero la definición 
de BLOCK se descarta. 

12.4 .stl 

Un archivo STL contiene una lista de triángulos en el espacio 3D. Cada triángulo es importado a Mecway 
como elemento tri3. Los vértices del triángulo coincidentes se combinan automáticamente en un mismo 
nodo para formar una malla continua. También puede convertir estos triángulos de superficie en una malla 
de volumen utilizando Mesh tools→ Automesh 3D. 

Los archivos STL generados por aplicaciones CAD a menudo contienen triángulos con relaciones de 
aspecto muy grandes (largas y delgadas). Estos son generalmente inadecuados para su uso en 
elementos finitos de manera que debe utilizar Automesh 3D para mejorar su forma. 

12.5 Gmsh (.msh) 

Gmsh es un automallador fuente abierta. Puede usarlo para generar mallas y luego importarlas en 
Mecway. Mecway pueden leer el formato de archivo ASCII versiones 2.0, 2.1, 2.2, 4.0 y 4.1. Si el archivo 
no contiene datos de soluciones Mecway supone que es una malla generada por Gmsh e importa sólo 
los elementos de más dimensión - por ejemplo, si hay tanto elementos de volumen y de superficie, sólo 
los elementos 3D aparecen en Mecway. Esto es porque Gmsh utiliza elementos de línea y de superficie 
para etiquetar las superficies y bordes de sólidos. 

Las entidades geométricas de elementos de superficie se usan para crear selecciones con nombre de 
superficies en Mecway. Si un elemento de volumen tiene un elemento de superficie una cara, entonces 
la ID de la entidad geométrica del elemento de superficie se utiliza para asignar la cara del elemento de 
volumen a la correspondiente selección con nombre. Esto preserva las distintas superficies de la 
geometría original. 

Las entidades geométricas de elementos de volumen se convierten en componentes en Mecway. Esto 
permite usar varios materiales en la misma malla con frontera claramente definida entre ellos. 

Mecway también pueden grabar una malla sin datos de solución en archivos Gmsh. Los componentes se 
almacenan como entidades geométricas y físicas. Las caras 2D en selecciones con nombres se 
almacenan como elementos de superficie con entidades geométricas y físicas para identificarlos. 

12.6 .unv 

Puede abrir archivos de malla .unv generados por software como Salomé, Gmsh y NX. Mecway lee nodos 
(dataset 2411), elementos (dataset 2412), grupos permanentes (dataset 2435, 2452, 2467, 2477), 
unidades (dataset 164) y nombres de tablas de propiedades físicas (dataset 2470). 

12.7 Netgen (.vol) 

Netgen es un automallador de fuente abierta. Puede usarlo para crear mallas y luego importarlas en 
Mecway. La mayor parte de la funcionalidad de Netgen ya está incluida en Mecway por lo que 
normalmente no es necesario usarlo. Mecway sólo lee los elementos originales de más dimensión – 
elementos de volumen o de superficie. Esto es porque Netgen utiliza elementos de superficie para 
etiquetar las superficies de las partes sólidas. 

12.8 Tetgen (.mesh) 

Tetgen es un automalladorr de código abierto. Puede usarlo para generar mallas y luego importarlas a 
Mecway 
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12.9 Polygon File Format (.ply) 

Mecway puede abrir mallas de superficie consistentes en elementos tri3 y quad4 tanto en versiones ASCII 
como binario de este formato de archivo. 

12.10 .jpeg, .png, .bmp 

Puede importar imágenes para mostrarlas junto al modelo. Consulte la sección Calcar una imagen para 
obtener más detalles. También puede guardar imágenes como archivos PNG. 

12.11 .xyz 

Un archivo XYZ es un archivo de texto que contiene una lista de puntos en el espacio 3D. Cada línea 
tiene las 3 coordenadas de un punto. Las coordenadas pueden separarse por espacios en blanco o comas. 
Las líneas que contienen texto o no exactamente 3 números generalmente son ignoradas. Una excepción 
es una sola palabra, seguidos de 3 números, lo que permite abrir archivos XYZ de geometría molecular. 
Mecway puede abrir archivos XYZ, pero no guardarlos. 

12.12 Paraview (.vtu y .pvd) 

Puede guardar la solución en formato VTU para su postprocesamiento con Paraview o software 
compatible. Si hay varios modos o pasos de tiempo, cada uno se guarda en un archivo VTU separado. 
También se crea un archivo PVD que hace referencia a los archivos VTU. 

12.13 ANSYS command file (.txt) 

Mecway puede guardar algunas partes del modelo como comandos de ANSYS APDL. Estos son: 

• Nodos: N 

• elementos mecánicos sólidos 3D: SOLID185 y SOLID186 

• elementos piezoeléctricos sólidos3D: SOLID5 y SOLID226 

• Restricciones de desplazamiento: D y NANG 

• Restricciones de potencial eléctricos: D 

• material isótropo: MP.EX y MP.PRXY 

• matriz de rigidez anisótropa: TB.ANEL y TBDATA 

• matriz de cumplimiento anisótropa: TB.ANEL y TBDATA 

• Matriz de permeabilidad anisótropa: TB.DPER y TBDATA 

• Matriz de estrés piezoeléctrica (e): TB.PIEZ y TBDATA 

• matriz de tensión piezoeléctrica (d): TB.PIEZ y TBDATA 

• Presión (normal, uniforme y constante): SFE 

12.14 CalculiX (.inp) 

12.14.1 Abrir archivos .inp 

Se soportan los siguientes parámetros y palabras clave. 

Palabra clave Parámetros Notas 

*BEAM GENERAL 
SECTION 

ELSET 

MATERIAL 

SECTION=PIPE 

 

*BEAM SECTION ELSET  
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MATERIAL 

SECTION=BOX / CIRC / I / L / 
PIPE / THICKPIPE / RECT. 

*BOUNDARY  Desplazamiento, rotación, presión de 
fluido, potencial eléctrico y temperatura 

*CFLUX   

*CLOAD   

*CONDUCTIVITY TYPE=ISO / ORTHO Puede ser dependiente de la temperatura 
con TYPE=ISO 

*DASHPOT ELSET  

*DENSITY   

*DLOAD  Cargar tipos P, Pn de sólidos y 2D/3D y 
cáscaras. No vigas. 

*DYNAMIC DIRECT 

DIRECT USER CONTROL 

 

*ELASTIC TYPE=ENGINEERING 
CONSTANTS 

TYPE=ISOTROPIC 

 

*ELEMENT TYPE 

ELSET 

INPUT 

 

*ELGEN ELSET  

*ELSET ELSET 

GENERATE 

 

*END STEP   

*FILM  Los números de cara en las cáscaras 
pueden utilizar formato Abaqus (FPOS, 
FNEG) o CalculiX (F1-F6). 

*FREQUENCY  Número de valores propios en la línea de 
datos 

*HEAT TRANSFER STEADY STATE  

*INCLUDE INPUT No puede aparecer dentro de otro bloque 
de palabras clave. 

*MATERIAL NAME  
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*MEMBRANE 
SECTION 

MATERIAL 

ELSET 

 

*NCOPY OLDSET 

CHANGENUMBER 

NEWSET 

SHIFT 

MULTIPLE 

 

*NFILL NSET 

BIAS 

TWO STEP 

 

*NGEN NSET 

LINE=P / C 

 

*NODE NSET 

SYSTEM=C / S / R 

INPUT 

 

*NSET NSET 

ELSET 

GENERATE 

UNSORTED 

 

*ORIENTATION NAME Sólo un sistema rectangular definido por 
las coordenadas de dos o tres puntos en 
elementos sólidos 3D y cáscara. Para 
elementos cáscara, Abaqus y CalculiX 
asignan distintos significados a las 
coordenadas. Si se especifica un tercer 
punto o una segunda línea de datos, 
entonces Mecway lo interpretará como 
formato Abaqus; de lo contrario, se 
interpretará como formato CalculiX. 

*PHYSICAL 
CONSTANTS 

ABSOLUTE ZERO  

*RADIATE  Los números de cara a las cáscaras 
pueden utilizar el formato Abaqus (FPOS, 
FNEG) o CalculiX (F1-F6). 

*SHELL SECTION MATERIAL 

ELSET 

 

*SOLID SECTION MATERIAL 

ELSET 

ORIENTATION 
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*SPECIFIC HEAT  Puede ser constante o dependiente de la 
temperatura 

*SPRING ELSET  

*STATIC DIRECT  

*STEP NLGEOM  

*SURFACE NAME 

TYPE=NODE / ELEMENT 

 

*TRANSFORM NSET 

TYPE=C / S / R 

 

 

Los tipos de elemento se convierten en diversas formas de elemento, propiedades de materiales y tipos 
de análisis de acuerdo a la siguiente tabla. Si hay conflictos, como una mezcla de elementos 2D y 3D o 
tipos de análisis no compatibles entonces sólo será elegido uno. Algunos tipos de elementos no son 
admitidos por el Solucionador de Mecway, pero aun así será importado. Estos incluyen vigas de 3 nodos, 
hexaedros colapsados en prismas, y cáscaras axisimétricas. Otras formas de elemento no existen en 
Mecway, como algunos elementos de los tipos cohesivo (COH), junta (GK) y cilíndricos (CCL). Estos se 
convertirán en la forma elemento más cercana disponible sin agregar nodos adicionales. 

 

Tipo de elemento en el 
archivo inp 

Cómo aparece en Mecway 

T2D2,... barra 2D 

T3D2,... Barra3D, viga 2D, viga 3D o aleta según el procedimiento de análisis 

SPRINGA,  Viga 3D con propiedad material muelle 

DASHPOTA Viga 3D con propiedad material amortiguador 

CPS3,... elemento continuo 2D con propiedad de material tensión plana 

CPE3,... Elemento continuo 2D con propiedad de material deformación plana 

CAX3,... Axisimétrico 

S8R,... Cáscara 3D. Los ejes locales del elemento se determinan por un bloque 
*ORIENTATION asociado si está presente. De lo contrario, el valor 
predeterminado es U paralelo a X a menos que la dirección normal del 
elemento esté a 0,1 grados del eje X, en cuyo caso U es paralelo a Z. 

C3D8,... sólidos3D 
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Limitaciones generales 

• No se distingue entre mayúsculas y minúsculas, incluyendo las etiquetas entre comillas. 

• Se ignoran todos los espacios. Esto significa que los nombres de archivo y las etiquetas entre 
comillas no se pueden leer correctamente. 

• Las palabras clave y la mayoría de los valores de parámetros deben estar completos, aunque se 
puede acortar los nombres de los parámetros, por ejemplo, ISO en lugar de ISOTROPIC. 

• Si los números de nodo o de elemento no son seguidos, se renumerarán para que lo sean. 

• Se supone que todas las cantidades físicas están en unidades SI (m kg, s, K) excepto los ángulos, 
que pueden estar el grados o radianes según las especificaciones del formato del archivo. Una 
excepción es que usted puede elegir las unidades de las coordenadas nodales al abrir el archivo. 

12.14.2 Guardar archivos .inp 

Este archivo está diseñado para usarlo con el Solucionador CCX y aunque es también mayormente 
compatible con Abaqus, algunos datos se interpretan diferente. 

Todas las cantidades son guardadas en unidades SI (kg, m, s, K) y radianes. Por lo tanto, si una longitud 
es de 1 pulgada en Mecway, aparecerá como 0.0254 en el archivo .INP. 

12.15  Resultados CalculiX (.frd) 

Mecway puede leer la mayoría de las formas de este archivo como son generados por CCX versiones 
2.8-2.23. Se supone que todas las cantidades están en unidades SI (m, kg, s). Este requisito se cumplirá 
si el archivo .frd es la solución a un archivo .inp generado por Mecway independientemente de las 
unidades que se utilizaron para definir el modelo de Mecway. 
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13 Capítulo 13 

Solucionador CalculiX 

Además, del Solucionador incorporado, Mecway también puede utilizar el Solucionador CalculiX de 
código abierto (CCX). Esto da acceso a funciones más avanzadas, como los roces y el comportamiento 
de los materiales plásticos. 

CCX 2.23 se instala junto con Mecway y está listo para usar. Si prefiere instalar otra versión, instálela y 
vaya a Tools→ Options→ CalculiX y Browse a la ubicación del ejecutable del Solucionador ccx.exe. 
En ambos casos, si prefiere mantener los archivos generados automáticamente en su propio directorio 
de trabajo, marque la casilla Use the same directory as the LIML file de lo contrario, se crean archivos 
temporales en una carpeta temporal y se eliminan al cerrar Mecway. 

Cambie la opción de solucionador del modelo de Internal a CCX en Analysis settings. Al resolver 
Mecway generará un archivo .in, ejecutará el Solucionador CCX con este nombre como un parámetro y 
luego leerá el archivo .frd generado y mostrará la solución. 

 

Si el Solucionador falla, haga clic en el botón CCX output para mostrar la salida estándar de CCX y los 
mensajes de error estándar, así como los mensajes de error generados por Mecway al grabar el 
archivo .inp. También puede inspeccionar el contenido del archivo .inp con el botón Input file. 

Las unidades se convierten en un sistema coherente (m, kg, s) como requiere CCX. Esto significa que 
puede utilizar cualquier combinación de unidades mientras se construye el modelo en Mecway y la 
solución tendrá valores correctos que se pueden presentar en cualquiera de las unidades disponibles. 

Mecway establece las variables de entorno MKL_PARDISO_OOC_MAX_CORE_SIZE y 
MKL_PARDISO_OOC_PATH para el proceso CCX. Estas habilitan la función fuera de núcleo de MKL 
PARDISO con la versión de CCX que se incluye con el código fuente. 

 

13.1 Material personalizado (Custom material) 

Puede proporcionar una definición de material que no esté disponible en Mecway utilizando el tipo de 
material Custom en la pestaña CCX de Material Properties. Por ejemplo, para definir un material de solo 
compresión con un módulo de Youngs de 30 GPa y una tensión de tracción máxima de 3 MPa, cree un 
material denominado COMPRESSION_ONLY y, en el cuadro de definición del material, escriba 

*USER MATERIAL, CONSTANTS=2 

30e9, 3e6 

 

En el esquema de árbol aparece una rama denominada CCX cuando el Solucionador se configuró como 
CCX. Haciendo clic derecho sobre esta rama puede controlar el modo en que se genera el archivo .inp. 
Las opciones son: 
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13.2 Definición de modelo personalizada (Custom model definition) 

Aquí puede introducir el texto que se inserta en el archivo .inp al final de la sección de definición del 
modelo inmediatamente antes de la sección del primer paso (identificado por una palabra clave *STEP). 
Puede usarlo para agregar manualmente distintos elementos, materiales condiciones de frontera 
homogéneas (cero), etc., que no están disponibles en Mecway. Consulte la documentación de CCX para 
detalles de las palabras clave. 

13.3 Contenido de paso personalizado (Custom step contents) 

Custom step contents es similar a Custom model definition, pero el texto se coloca al final de un 
bloque de paso (identificados por *STEP). Se puede utilizar para definir cargas, variables de salida, 
condiciones de frontera no-homogéneas o secciones de paso adicionales. 

Para tipos de análisis que generan dos bloques de paso, el texto se coloca en el bloque de paso que 
contiene las cargas. 

13.4 Modificar palabra clave (Modify keyword) 

A veces las tarjetas de archivo .inp generadas por Mecway puede no tener las mismas opciones que 
usted desea. Si esto sucede, usted puede usar Modify keyword para alterar todas las instancias en las 
que normalmente Mecway generaría esa palabra clave. Las modificaciones disponibles son: 

Omit key word block. Evita que se generen la tarjeta de la palabra clave y sus líneas de datos asociadas. 
Esto se llamaba Don’t generate keyword en versiones anteriores de Mecway. 

Set parameter. Establece un parámetro en un valor. Por ejemplo, para usar el contacto mortar, configure 
el parámetro con Name TYPE a Value MORTAR en la palabra clave * CONTACT PAIR. 

Omit parameter. Evita que se genere el parámetro especificado. 

13.5 No generar paso (Don’t generate STEP) 

Agregue este elemento para evitar que la sección * STEP sea generada por Mecway. Es útil si lo 
reemplaza con su propia sección * STEP definida en custom model definition. 

13.6 Sin paso de contacto extra (No extra contact step) 

El uso de este elemento de compatibilidad puede causar resultados incorrectos para el contacto cuasi 
estático. Para más detalles, ábralo en Mecway. 

13.7 Tipo de elemento personalizado (Custom element type) 

Permite cambiar el tipo de elemento usado para el solucionador CCX a uno que de lo contrario no es 
soportado por Mecway. El tipo de elemento especificado se aplica a todos los elementos que coinciden 
con la forma especificada y están en la selección a la que se aplica customer element type.  

Por ejemplo, para usar integración reducida en todos los elementos hex8, agregar un customer element 
type con: 

Apply to  <todo el modelo> 

Element shape Hex8 

CCX element type C3D8R 
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14 Capítulo 14 

Solucionador OpenRadioss 

Mecway se puede utilizar como preprocesador y postprocesador para el solucionador de dinámica 
explícita de código abierto OpenRadioss. 

La documentación de Altair Radioss https://help.altair.com/hwsolvers/rad/index.htm se aplica 
principalmente a OpenRadioss. 

Solo se recomienda la versión estable 20260120 porque ha sido probada en su compatibilidad con 
Mecway. 

 

14.1 Instalación (Setup) 

1. Descargue OpenRadioss para Windows y extráigalo en un directorio de instalación. 

2. En Mecway, haga clic en Find OpenRadioss root directory en Tools→Options→OpenRadioss 
y elija el directorio de instalación. Esto identificará automáticamente los ejecutables del iniciador y 
del motor y definirá algunas variables de entorno. 

3. En Analysis settings, establezca el Solver como OpenRadioss. 

 

 

14.2 Características compatibles 

 

14.2.1 Tipo de análisis 

Respuesta dinámica no lineal 3D 

 

14.2.2 Elementos 

Viga, barra, muelle, amortiguador: línea2 

Cáscara: tri3, quad4 

Sólido: tet4, pyr5, wedge6, hex8, tet10, hex20 

 

14.2.3 Materiales 

Elástico isotrópico 

Plástico bilineal 

Materiales personalizados definidos por /MAT/... Palabras clave 

 

14.2.4 Condiciones iniciales 

Velocidad 

 

https://help.altair.com/hwsolvers/rad/index.htm
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14.2.5 Cargas y restricciones 

Soporte fijo 

Soporte sin fricción 

Desplazamiento 

Rotación de nodos 

Velocidad 

Contacto 

Acoplamiento nodo-superficie 

Junta flexible en viga 

Fuerza 

Presión (solo uniforme) 

Momento 

Orientación de los elementos (solo vigas y cáscaras) 

Amortiguación de Rayleigh 

Simetría 

Gravedad 

 

14.2.6 Selecciones con nombre 

Las selecciones de nodos se exportan como grupos de nodos (/GRNOD/NODE) 

Las selecciones de caras se exportan como segmentos de superficie (/SURF/SEG) que contienen caras 

2D y segmentos de línea (/LINE/SEG) que contienen caras 1D (bordes). Las caras de elementos Hex20 

no son soportadas. 

Las selecciones de elementos se exportan como grupos (/GRBRIC/BRIC, /GRSHEL/SHEL, 

/GRSH3N/SH3N, /GRBEAM/BEAM, /GRSPRI/SPRI, /GRTRUS/TRUS) que contienen sus respectivos 

tipos de elementos. 

Los ID de grupo y segmento se numeran secuencialmente desde 1 en orden alfabético de los nombres 
de sus selecciones con nombre. Esto le permite hacer referencia a ellos en otras palabras clave en la 
definición del modelo personalizado (ver más abajo). 

Las selecciones con nombre pueden contener una mezcla de tipos de caras o elementos que se exportan 
como varios segmentos o grupos que comparten el mismo ID. Por ejemplo, si la 5ª selección con nombre 
contiene elementos tri3 y quad4, se exporta como /GRSH3N/SH3N/5 y /GRSHEL/SHEL/5 que tienen 

grsh3n_ID = 5 y grshell_ID = 5 respectivamente. Esto le permite hacer referencia a cualquiera de ellos en 
otras palabras clave según sea necesario. 

 

14.2.7 Variables de solución 

Desplazamiento 

Rotación 

Velocidad 

Aceleración 

Fuerza axial (viga, barra, resorte, amortiguador) 

Fuerza cortante (viga) 
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Momento flector (viga) 

Momento de torsión (viga) 

Fuerza de reacción 

Momento de reacción 

Tensión principal 

Tensión (sólido) 

Tensión en coordenadas del elemento (cáscaras) 

Tensión de Von Mises (sólido) 

Paso de tiempo del elemento 

Paso de tiempo (global) 

Energía interna (global) 

Energía cinética (global) 

 

14.2.8 Características especiales 

Están disponibles en la rama OpenRadioss del árbol de esquema. 

Definición de modelo personalizado (Custom model definition) 

Aquí, puede introducir palabras clave de inicio para características que no son compatibles con la interfaz 
de Mecway, como contacto, otros tipos de cargas y elementos, etc. 

Entrada de motor personalizada (Custom engine input) 

Aquí, puede introducir palabras clave del motor para funciones que no son compatibles con la interfaz de 
Mecway, como para generar diferentes variables de solución. 

Modificar palabra clave inicial (Modify starter keyword) 

Modify starter keyword altera todas las instancias de bloques de palabras clave iniciales que 
normalmente generaría Mecway. La única modificación disponible es Omit key word block, que impide 
que se genere el bloque de palabra clave. 
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15 Capítulo 15 

Solucionador Mystran 

Mecway incluye el solucionador Mystran. Para usarlo, en Analysis setting, configure el Solver como 
Mystran. 

Mystran es un solucionador lineal de código abierto que utiliza un formato de entrada compatible con 
Nastran. Hasta 2025 carece de validación exhaustiva y todavía tiene algunos bugs conocidos, por lo que 
aún no se recomienda para uso general. 

 

15.1 Funciones soportadas 

 

15.1.1 Tipos de análisis 

3D estático 

Pandeo 

 

15.1.2 Elementos 

Viga, barra, muelle: línea2 

Cáscara: tri3, quad4, quad8 

Sólido: tet4, wedge6, hex8, tet10, wedge15, hex20 

 

15.1.3 Materiales 

Isótropo 

Ortótropo 

Laminado 

 

15.1.4 Cargas y restricciones 

Soporte fijo 

Soporte sin fricción 

Soporte clavado 

Desplazamiento 

Rotación de nodo 

Acoplamiento nodo-superficie 

Fuerza 

Presión 

Momento 

Masa 
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Temperatura 

Temperatura de nodo 

Orientación del elemento 

Estrés térmico 

Simetría 

Ecuación de restricción 

Gravedad 

 

15.1.5 Características especiales 

Estos están disponibles en la rama Mystran del esquema de árbol. 

 

Datos masivos personalizados (Custom bulk data) 

Aquí, puede ingresar entradas de datos masivas para funciones que no son compatibles con la interfaz 
de Mecway. 

 

Modificar la entrada masiva de datos (Modify bulk data entry) 

Impide que se genere la entrada. 



127 

 

16Capítulo 16 

Automatización 

16.1 Parámetros de línea de comandos 

Puede utilizar parámetros de línea de comandos para ejecutar Mecway desde otra aplicación, un archivo 
por lotes o un script de comandos. 

Mecway [<filename> [solve | clearsolutions| script <script filename>]] 

La opción <filename> es un archivo de cualquiera de los tipos de geometría o de malla que Mecway puede 
abrir. Hace que Mecway inicie con el archivo abierto. El nombre de archivo debe incluir la extensión 
como .liml, .stp, etc. Por ejemplo: 

Mecway mimodelo.liml 

El parámetro opcional solve hace que Mecway resuelva el archivo y luego salga sin mostrar la ventana 
principal. Para obtener la solución, establezca un archivo de salida en el modelo en Write solution to 
liml file o una tabla con Write to csv file after solving. Cuando se utiliza el parámetro solve, <filename> 
puede contener comodines. Por ejemplo, para resolver todos los archivos liml en la carpeta actual, ejecute: 

Mecway *.liml solve 

clearsolutions sirve para reducir el tamaño de un archive grande removiendo los datos de la solución. 

script abre el archivo <filename>, ejecuta el script <script filename>, luego sale. Si <filename> define 
varios archivos mediante el uso de comodines, ejecuta el script después de abrir cada archivo. 

16.2 Scripts 

Puede escribir scripts que aparecen como elementos de menú y se ejecutan mediante una 
implementación integrada de Python 2.7 (IronPython). El alcance aproximado de la funcionalidad es 
actualmente: 

• Operaciones simples en nodos y elementos. 

• Refinado, suavizado de malla y autommallado 

• Propiedades de material 

• Valores numéricos para la mayoría de las cargas y restricciones 

• Selecciones con nombres 

• Variables de campo de solución 

• Herramientas de medición que se integran sobre elementos o caras. 

• Leer la selección actual 

• Leer y modificar los elementos en componentes 

• Resolver (sin indicación de progreso) 

• Abrir y Guardar archivos 

• Biblioteca estándar de Python 

• Importar módulos escritos en Python puro 
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No incluye: 

• La mayoróa de las herramientas de mallado 

• Importar módulos que requieren CPython, como NumPy 

Para crear un script, haga clic en Tools → Scripts... y presione el botón New. Ingrese un nombre de 

archivo inexistente para crearlo o elija uno existente. El editor (predeterminado es el Bloc de notas) se 
abre, donde puede escribir y guardar el script. Aquí hay un ejemplo simple que crea un nodo y muestra 
un mensaje en un cuadro emergente: 

node_id = mw.new_node(Vector(1.2, 3.4, 5.6)) 

mw.message("Node " + str(node_id) + " created.") 

Para ejecutar un script, haga clic en su elemento de menú en el menú Tools. También puede activarlo 
desde el teclado usando Alt+T seguido de la primera letra del nombre del script o córralo con File → 
Open..., File → Import... o File → Import from library. 

La API de Mecway consta de los siguientes objetos y clases que están disponibles automáticamente en 
cada script: 

mw Objeto que contiene funciones que operan en la aplicación y el modelo en el modelador 

Solution Objeto que contiene funciones que operan en la solución en la configuración activa 

FaceId Clase para identificar una cara de un elemento 

Vector Clase para representar un vector 3D 

Los detalles se enumeran en un documento separado accesible mediante Help → API reference. 

Se proporcionan dos scripts de muestra en la carpeta Samples donde está instalado Mecway. Son 
generate_mesh.py, que crea un elemento, y transfer_displacements_from_solution.py, que lee los 
datos de desplazamiento de la solución y los utiliza para deformar la malla. 

Todas las cantidades físicas se expresan en el sistema de unidades SI (m, kg, s, K, A, radianes) 
independientemente de cómo se especificaron en el modelo. Por ejemplo, si su modelo tiene un nodo con 
una coordenada de 1 pulgada, leer eso usando un script devolverá el valor 0.0254. 

Precauciones: 

• Los scripts pueden contener malware, así que evite ejecutar scripts desconocidos de fuentes no 
confiables. 

• La aplicación no responderá mientras se ejecuta un script, por lo tanto, evite bucles infinitos. 

• La API, la versión de Python y la implementación de Python pueden cambiar en futuras versiones 
de Mecway, rompiendo la compatibilidad con los scripts existentes. Sin embargo, puede continuar 
usando versiones viejas de Mecway junto con las más nuevas si no desea actualizar sus scripts. 
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17 Capítulo 17 

Tutoriales 

Estos tutoriales suponen que usted es nuevo con Mecway y de hecho puede ser nuevo con el análisis de 
elementos finitos. Aquí encontrará instrucciones paso a paso para empezar a usar el programa.  

 

17.1 Inicio rápido 

Este es un tutorial muy sencillo que muestra cómo crear un modelo de trabajo desde cero. Puede omitirlo 
si prefiere una introducción más a fondo de los otros tutoriales. 

Paso 1 

Cambe al modo de Selección de caras.  

 

Paso 2 

Haga clic en el botón cubo rápido  para crear un elemento hexaédrico. 

 

 

Paso 3 

Haga clic derecho en la cara más a la derecha y 
haga clic en Loads & constraints y luego en Fixed 
support. Haga clic en OK en el cuadro que aparece. 

 

 

 

 

Paso 4 

Arrastre con el botón central del ratón para rotar el 
modelo para que la cara opuesta quede hacia usted.  

 

 

Paso 5 

Haga clic derecho en la cara opuesta y haga clic 
en Loads & constraints y en Pressure. 
Introduzca el valor 5 y pulse OK. 
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Paso 6 

Haga clic derecho en el componente Default en el esquema de árbol y haga 
clic en Assign new material. Elija Isotropic e introduzca Young’s 
modulus de 50000. Pulse OK. 

 

 

Paso 7 

Pulse resolver.  

 

Paso 8 

Haga clic en la variable de campo von Mises stress en el 
esquema de árbol. La escala de color muestra una tensión 
uniforme de 5 Pa debido a la carga de presión. 

 

17.2 Visualización y selección 

Este tutorial muestra cómo realizar las operaciones más comunes para cambiar la vista y seleccionar 
elementos. Se refiere a los menús, pero es posible que prefiera usar los botones de la barra de 
herramientas en su lugar, cuando existan. 

 

Paso 1 

En el menú File , haga clic en Open y abra el 
archivo ViewingAndSelecting.liml en la carpeta 
tutoriales donde se ha instalado Mecway. 

Paso 2 

Utilice el botón central del ratón para girar el 
modelo, el botón derecho para desplazarse y la 
rueda de desplazamiento para hacer zoom. 

 

Paso 3 

En el menú View , haga clic en Fit to window 
para volver a centrar el modelo. 

 

 

 

 

Paso 4 

Haga clic en la punta de flecha del eje X de la 
tríada para girar a una vista ortogonal. 

 

Paso 5 

Haga clic derecho en la punta de flecha del eje X 
para la vista desde la dirección -X. 
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Paso 6 

Haga clic en la bola cian de la tríada para rotar a 
la vista isométrica. 

 

Paso 7 

Active y desactive cada una de estas opciones 
en el menú View para ver su efecto:  Show 
element edges, Show model edges, Show 
element surfaces, Show thickness.  

  

 

 

Paso 8 

En el menú View , haga clic en Open cracks. 
Esto encoje los elementos y revela que las 
cáscaras no están conectadas a los sólidos. 
Pulse la tecla Esc para salir del modo Abrir 
grietas. 
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Paso 9 

Mueva el deslizador del plano de corte para 
ocultar los elementos en primer plano y ver el 
interior de la malla. Luego devuélvalo al extremo 
izquierdo. 

 

Paso 10 

Haga clic en Geometry en el esquema de árbol 
para mostrar los archivos STEP y haga clic en 
una superficie para seleccionarla. 

 

Paso 11 

Mantenga presionada la tecla Ctrl y haga clic en 
otra superficie para seleccionarla también. 

 

 

 

Paso 12 

En el menú Edit , haga clic en Invert selection 
para seleccionar todas las demás superficies 
excepto esas dos. 

 

Paso 13 

Haga clic en un lugar en blanco junto al modelo 
para borrar la selección. 

 

 

Paso 14 

Haga clic en Components & materials en el 
esquema de árbol para mostrar la malla. 
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Paso 15 

En el menú Edit, haga clic en Select nodes y, a 
continuación, haga clic en un nodo para 
seleccionarlo.  

 

 

Paso 16 

Mantenga presionada la tecla Ctrl y haga clic en 
otro nodo para seleccionarlo también. 

 

 

Paso 17 

Con Show element surfaces desactivado, haga 
clic en la punta de flecha del eje Z de la tríada y 
arrastre un rectángulo alrededor de los nodos del 
cilindro para seleccionarlos. 

 

 

 

 

Paso 18 

En el menú Edit, haga clic en Select elements 
para convertir la selección de nodo en una 
selección de elementos que contenga todos los 
elementos del cilindro. 

 

 

Paso 19 

Mantenga presionada la tecla Ctrl y haga clic en 
algunos de los elementos seleccionados para 
anular su selección. 

 

 

Paso 20 

Haga clic en un elemento de esquina para 
seleccionarlo solo. 
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Paso 21 

En el menú Edit, haga clic en Select faces para 
convertir la selección de elementos en una 
selección de caras. Observe que solo se 
seleccionan las caras exteriores. 

 

 

 

 

Paso 22 

Haga clic en un lugar en blanco junto al modelo 
para borrar la selección. 

 

 

Paso 23 

En el menú Edit , haga clic en Paint selection y 
arrastre el ratón sobre la malla para seleccionar 
muchas caras. 

 

 

 

 

 

 

 

 

 

Paso 24 

En el menú Edit, haga clic en Edge detecting 
selection y haga clic en el cilindro para 
seleccionar todas las caras delimitadas por un 
ángulo pronunciado entre caras adyacentes.  

  

 

Paso 25 

Con Show element surfaces activado, haga clic 
en uno de los elementos de viga para seleccionar 
su "cara" de borde, que es todo el perímetro. 

 

 

Paso 26 

Haga clic en el extremo de un elemento de viga 
para seleccionar su cara final. 
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Paso 27 

Con Show thickness activado, haga clic en una 
cara de borde del elemento cáscara para 
seleccionarlo. 

 

 

Paso 28 

En el menú Edit , haga clic en Select elements 
y se seleccionará el elemento cuya cara se 
seleccionó. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Paso 29 

En el menú Edit, haga clic en Select nodes y se 
seleccionarán todos los nodos del elemento 
seleccionado. 

 

Paso 30 

Con Show element surfaces desactivado, haga 
clic en la punta de flecha del eje X de la tríada y 
arrastre un rectángulo alrededor de los nodos 
que se muestran a continuación. 

 

Paso 31 

En el menú Edit, haga clic en Select faces para 
convertir la selección de nodos en las caras de 
las cáscaras a lo largo de ese borde. 
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17.3 Mallado manual 

Este tutorial muestra cómo utilizar las herramientas de mallado manual más comunes para construir una 
estructura 3D arbitraria desde cero que incluye elementos sólidos, de cáscara y de viga. 

 

 

 

Se supone que ya está familiarizado con el contenido del tutorial anterior “Visualización y selección”. Si 
comete un error, haga clic en Undo en el menú Edit para volver al paso anterior. Es posible que prefiera 
cerrar la ventana de cada herramienta después de usarla si están abarrotando la pantalla. 

Paso 1 

En el menú Mesh tools, abra Create y haga clic en 
Quick square. 

 

 

 

 

Paso 2 

Seleccione los dos nodos en el borde +X como se 
muestra a continuación. En el menú Mesh tools, clique 
en Node coordinates, defina los parámetros que se muestran a continuación y haga clic en OK.  
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Paso 3 

Seleccione los dos nodos en el borde +Y como se muestra a continuación. Si el cuadrado se ha convertido 
en un rectángulo delgado, es posible que deba hacer clic en la punta de flecha del eje X en la tríada para 
verlo al final como se muestra a continuación y seleccionar los dos nodos arrastrando un rectángulo 
alrededor de ellos. En el menú Mesh tools, haga clic en Node coordinates, defina los  

parámetros que se muestran a continuación y haga clic en OK.  

 

 

Paso 4 

Seleccione el elemento. En el menú Mesh tools,  abra Refine y haga clic en Custom, establezca los 
parámetros que se muestran a continuación y haga clic en Apply.  

 

Paso 5 

Cambie al modo Select faces para seleccionar las 6 caras que se muestran a continuación. En el menú 
Mesh tools, haga clic en Revolve, establezca los parámetros que se muestran a continuación y haga clic 
en Apply.  
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Paso 6 

El paso anterior generó muchos nodos coincidentes en el eje donde los elementos no están conectados 
entre sí. Para corregir esto, sin nada seleccionado, haga clic en Merge nearby nodes en el menú Mesh 
tools, establezca los parámetros que se muestran a continuación y haga clic en Apply. 

 

 

Paso 7 

En el menú Mesh tools, haga clic en Change element shape y haga clic en OK.  

 

 

Paso 8 

Las caras en el arco circular ahora son planas en lugar de curvas. Para corregir esto, seleccione las 16 
caras que se muestran a continuación, luego en el menú Mesh tools, haga clic en Proyect onto surface, 
establezca los parámetros que se muestran a continuación y haga clic en Apply.  
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Paso 9 

Seleccione el nodo en la superficie +Y que se muestra a continuación. En el menú Mesh tools, haga clic 
en Move/copy, establezca los parámetros que se muestran a continuación y haga clic en Apply. Esto 
crea un nuevo nodo aislado encima de la pieza. 

 

 

Paso 10 

Seleccione de nuevo el mismo nodo. En el menú Mesh tools, haga clic en Hole, defina los parámetros 
que se muestran a continuación y haga clic en Apply.  

 

 

Paso 11 

Seleccione los 12 nodos alrededor del borde del orificio como se muestra a continuación. En el menú 
Mesh tools, haga clic en Extrude, defina los parámetros que se muestran a continuación y haga clic en 
Apply.  
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Paso 12 

Cambie al modo Select nodes y seleccione el nodo que se muestra a continuación. En el menú Mesh 
tools, haga clic en Merge nearby nodes, defina los parámetros que se muestran a continuación y haga 
clic en Apply.  

 

 

 

Paso 13 

Seleccione los elementos que se muestran a continuación. En el menú Mesh tools , haga clic en 
Disconnect elements. 

 

 

Paso 14 

Con los mismos elementos aún seleccionados, haga clic en Move/copy en el menú Mesh tools, 
establezca los parámetros que se muestran a continuación y haga clic en Apply. 
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Paso 15 

Seleccione los dos nodos que se muestran a continuación. En el menú Herramientas de malla , haga 
clic en Insertar nodo entre. 

 

Paso 16 

Repita el paso anterior utilizando los dos nodos que se muestran a continuación. 

 

 

Paso 17 

En el menú Herramientas de malla, abra Crear y haga clic en Elemento. Seleccione quad8 en la lista 
y, a continuación, haga clic en cada uno de los 8 nodos que se muestran a continuación en el orden 
indicado. Un nuevo elemento aparecerá inmediatamente después de hacer clic en el nodo 8 

 

.  
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Paso 18 

Seleccione el nuevo elemento como se muestra a continuación. En el menú Mesh tools, haga clic en 
Rotate/copy, establezca los parámetros que se muestran a continuación y haga clic en Apply 7 veces.  

 

 

Paso 19 

La operación anterior deja los nuevos elementos desconectados. Para corregir esto, sin nada 
seleccionado, haga clic en Merge nearby nodes en el menú Mesh tools, establezca los parámetros que 
se muestran a continuación y haga clic en Apply. 

 

 

Paso 20 

En el menú Herramientas de malla,  abra Create y haga clic en Plate mesh, defina los parámetros que 
se muestran a continuación y haga clic en Apply.  
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Paso 21 

Con los nuevos elementos aún seleccionados, haga clic en Rotate/copy en el menú Mesh tools, 
establezca los parámetros que se muestran a continuación y haga clic en Apply. 

 

 

Paso 22 

Cambie al modo Select nodes para seleccionar los nodos del disco y, a continuación, arrastre uno de 
ellos al nodo correspondiente del semicírculo como se muestra a continuación. Cuando aparezca el 
mensaje Merge nodes?, haga clic en Yes. 

 

 

Paso 23 

Seleccione los elementos que se muestran a continuación y presione la tecla Suprimir para eliminarlos. 
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Paso 24 

En el menú Mesh tools, abra Create y haga clic en Curve generator. Haga clic en Circle/ellipse en la 
lista Curvas predefinidas, defina los parámetros que se muestran a continuación y haga clic en OK. A 
continuación, establezca los demás parámetros como se muestra a continuación y haga clic en Apply. 
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Paso 25 

El paso anterior generó una curva abierta con dos nodos finales coincidentes no conectados. Para corregir 
esto, sin nada seleccionado, haga clic en Merge nearby nodes en el menú Mesh tools, establezca los 
parámetros que se muestran a continuación y haga clic en Apply. 

 

 

 

Paso 26 

Seleccione los 16 elementos de la elipse como se muestra a continuación. Una forma rápida de hacerlo 
es desactivar Mostrar superficies de elementos, hacer clic en la punta de flecha X de la tríada y usar el 
modo Select nodes para seleccionarlos mientras se visualizan de canto, luego cambiar al modo Select 
elements. A continuación, en el menú Mesh tools, haga clic en Automesh 2D y haga clic en Apply.  
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Paso 27 

Seleccione los elementos mallados como se muestra a continuación. Una forma rápida de hacerlo es usar 
Edge detecting selection. En el menú Mesh tools, haga clic en Move/copy, defina los parámetros que 
se muestran a continuación y haga clic en Apply.  

 

 

Paso 28 

Con los nuevos elementos seleccionados, haga clic en Scale/copy en el menú Mesh tools, defina los 
parámetros que se muestran a continuación y haga clic en Apply. 

 

 

Paso 29 

Seleccione las caras de un lado de la primera elipse como se muestra. Active Show node numbers en 
el menú View y oriente la vista para que algunos números de ambas elipses sean visibles. A continuación, 
haga clic en Loft en el menú Mesh tools e introduzca el número de cualquier nodo en la primera elipse 
para (a) y el número de su nodo correspondiente en la segunda elipse (b).  Los números de nodo que se 
muestran a continuación pueden ser diferentes en el modelo. Por último, haga clic en OK para generar 
un cono truncado. Tenga en cuenta que la herramienta loft requiere que ambas superficies tengan la 
misma topología de malla y la misma diferencia entre cada par de números de nodo correspondientes, 
por lo que siempre debe crear uno como una copia del otro. 
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Paso 30 

Seleccione todos los nodos del cono truncado como se muestra a continuación, luego arrastre el nodo 
central superior (+Y) al nodo central del semicírculo como se muestra a continuación. Cuando aparezca 
el mensaje Merge nodes? haga clic en No. 

 

 

Paso 31 

Seleccione las 28 caras en la superficie del semicírculo como se muestra a continuación. En el menú 
Mesh tools, haga clic en Project onto surface y defina las opciones Mesh e Y como se muestra a 
continuación. Dejando la ventana abierta, seleccione las 8 caras de la superficie superior del cono 
truncado como se muestra a continuación y haga clic en Use selection en el cuadro Target. Finalmente, 
haga clic en Apply. Aunque las dos partes ahora tienen formas coincidentes, no están conectadas entre 
sí. 
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Paso 32 

Seleccione el elemento que se muestra a continuación. En el menú Mesh tools, abra Refine y haga clic 
en x2. Esto es refinamiento local. 

 

Paso 33 

Sin nada seleccionado, abra Refine en el menú Mesh tools y vuelva a hacer clic en x2. Este es el 
refinamiento global. Si está utilizando la versión gratuita de Mecway, no podrá guardar el modelo después 
de este paso porque tiene más de 1000 nodos. En ese caso, use Undo primero si desea guardarlo. 

 

17.4 Solución 

Paso 1 

Abra el archivo Solution.liml en la carpeta tutoriales donde se ha instalado Mecway. 

En la sección solución del esquema de árbol, haga clic en displacement → magnitude. La pantalla 
gráfica se actualizará para mostrar los resultados del modelo resuelto. Las unidades utilizadas en 
la leyenda de la escala de visualización pueden cambiarse haciendo clic sobre ellas. 

 

Paso 2 

Haga clic en el botón herramienta Vista deformada   para visualizar un desplazamiento exagerado 
del de la estructura. 

Haga clic en el botón herramienta Vista no deformada para superponer un esbozo de la forma sin 
deformar sobre el modelo deformado. 

 



149 

 

 

 

Paso 3 

Haga clic derecho en Solution en el esquema de árbol y seleccione Stress and strain→ stress para 
agregar las 6 componentes de tensión a la solución. 

 

 

Paso 4 

Haga clic en el botón herramienta de tabla  para mostrar los desplazamientos y tensiones en cada 
nodo en las celdas estilo hoja de cálculo que puede luego copiar y pegar en su propia hoja de cálculo. 

 

Paso 5 

Utilice el botón herramienta Animación  para animar la deflexión. Se simulará un movimiento suave 
entre los dos extremos de deformación. Puede elegir el factor de escala. Esta herramienta es 
especialmente útil para visualizar soluciones en análisis de vibraciones. 

Paso 6 

Para volver a la modelo sin mostrar los resultados, haga clic en cualquiera de los elementos en el 
esquema de árbol que no esté por debajo de Solution. 

Ahora que ya tiene cierta experiencia en la manipulación de los gráficos del modelo, es hora de aprender 
a crear uno desde cero. La siguiente sección le guiará a través de los casos que hemos estudiado. 
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17.5 Uso de archivos STEP de CAD 

Este tutorial le muestra cómo hacer un modelo a partir de varias piezas con diferentes materiales. Para 
utilizar sus propios modelos, primero debe exportar cada pieza de su software CAD como un archivo 
STEP independiente. 

 

Paso 1 

Utilice File → Import para importar plate.step y cylinder.step desde la carpeta de tutoriales donde se 
ha instalado Mecway. Para mayor comodidad, puede abrir ambos archivos al mismo tiempo manteniendo 
presionada Ctrl mientras los selecciona. 

 

 

 

Paso 2 

Haga clic derecho en la superficie cilíndrica, haga clic en Loads & constraints → Contact y haga clic en 
OK. 

 

Paso 3 

Gire la vista para encontrar la superficie delgada de la placa adyacente al cilindro. Haga clic en esta 
superficie para seleccionarla. Haga clic derecho en Contact en el esquema de árbol y haga clic en Edit. 
Defina Caras esclavas en <1 selected geometry surface> y haga clic en OK. 
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Paso 4 

Haga clic derecho en Geometry en el esquema de árbol y haga clic en Generate all meshes. 

Paso 5 

Haga clic en la rama Geometry del esquema de árbol para volver a la vista de geometría. Haga clic 
derecho en el extremo circular del cilindro y haga clic en Loads & constraints → Fixed support y, a 
continuación, haga clic en OK. 

 

 

Paso 6 

Haga clic derecho en la superficie grande de la placa y haga clic en Loads & constraints → Force. 
Especifique un componente Y de -100 lbf y, a continuación, haga clic en OK. 

 

Paso 7 

Haga clic derecho en el componente de plate <### elements linked> en el esquema de árbol y haga clic 
en Assign new material. Seleccione Isotropic y especifique un Young’s modulus de 70 GPa y, a 
continuación, haga clic en OK. 

 

Paso 8 

Haga clic derecho en el componente cylinder <### elements linked> en el esquema de árbol y haga clic 
en Assign new material. Seleccione Isotropic y especifique un Young’s modulus de 210 GPa, luego 
haga clic en OK. 
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Paso 9 

Haga clic en resolver . 

Paso 10 

Haga clic en magnitude bajo displacement en la rama Solution del esquema de árbol y, a continuación, 

en el botón Animar  para mostrar la deformación causada por la carga. 

 

 

Paso 11 

En el modo Select nodes, haga clic derecho en un nodo como se muestra, haga clic en Point refinement 
y, a continuación, haga clic en OK. 

 

 

Paso 12 

Vuelva a la vista Geometría y haga clic derecho en el extremo del cilindro y haga clic en Surface 
refinement. Introduzca Maximum element size de 1 mm y haga clic en OK. 

 

 



153 

 

Paso 13 

Haga clic derecho en Geometry en el esquema de árbol y haga clic en Generate all meshes. Observe 
que esas dos áreas ahora tienen una malla más fina. 

 

Si está utilizando la versión gratuita de Mecway, no podrá guardar el modelo después de este paso porque 
tiene más de 1000 nodos. En ese caso, use Undo primero si desea guardarlo. 

17.6 Materiales mixtos 

Paso 1 

Abra una nueva instancia de Mecway. 

Paso 2 

Haga clic en Quick cube  

Paso 3 

Haga clic en Refine x2  

Paso 4 

Haga clic derecho en el componente predeterminado en 
el esquema de árbol y seleccione Assign new material. 
Elija Isotropic y especifique Young’s modulus como 
200 GPa. Luego clique OK. 

 

Paso 5 

Cambiar el modo Select elements  y 
seleccione dos de los 8 elementos. Mantenga pulsada 
la tecla Ctrl mientras hace clic en cada elemento. 

Paso 6 

Haga clic derecho en uno de los elementos 
seleccionados y elija Add elements to new 
component. El recién creado material(2) es un 
duplicado del primer material, pero usted puede cambiar 
sus propiedades de forma independiente. 

Paso 7 

Haga clic en un espacio vacío en el área de gráficos 
para borrar la selección, a continuación, haga clic 
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en Show element surfaces . Observe que cada componente del material tiene un color diferente para 
que puedan distinguirse fácilmente entre ellos. 

 

17.7 Montaje con contacto 

Este tutorial es para ayudar a obtener una solución estática para un montaje de piezas que se mantienen 
en su lugar por contacto entre sí. Se supone que usted está familiarizado con el uso general de Mecway 
y del contacto. 

Todas las partes de un ensamblaje deben estar inicialmente en equilibrio estático, de lo contrario el 
solucionador no convergerá. Eso significa que todas las piezas cargadas deben tener restricciones que 
proporcionen fuerzas de reacción. El contacto no es confiable como restricción inicial pues puede dejar 
algunas partes sin restricciones o evitar que el primer paso de tiempo converja. 

Veremos un modelo de una prueba de flexión de tres puntos que falla y probaremos varios ajustes hasta 
que se resuelva. 

 

Paso 1 

 

Abrir AssemblyWithContact.liml desde la carpeta de tutoriales donde se ha instalado Mecway. 

 

 

Paso 2 

 

Resolver la configuración Naive.  El solucionador falla con el mensaje 

 

*ERROR: too many cutbacks best solution and residuals are in the frd file 
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Paso 3 

Verifique que el problema es causado por un movimiento del cuerpo rígido y que el contacto esté 
funcionando correctamente. Para ello, añadimos un Fixed support a cada parte libre. Inténtelo 
resolviendo la configuración Fixed_support.   

 

Se resuelve rápidamente y la probeta se dobla en la forma esperada. La forma deformada parece extraña 
al principio porque está exagerada debido al alto factor de escala de deformación y la baja magnitud de 
desplazamiento. Esta no es la solución correcta debido al soporte fijo artificial, pero muestra que el error 
probablemente se debía a falta de restricciones. 

 

Paso 4 

Una falla en el primer paso es físicamente razonable porque las superficies de contacto no tienen fricción, 
por lo que la probeta es libre de deslizarse fuera de lugar. Corregimos esto agregando fricción para 
restringirla. Intente esto resolviendo la configuración Friction.   

 

Desafortunadamente, la fricción no es suficiente porque la probeta y/o el pin de carga no están siendo 
restringidos adecuadamente por los contactos. Puede ver esto en la solución no convergente. Si los 
desplazamientos son demasiado altos, establezca un factor de escala de deformación adecuado en 
Solution → Deformed view settings.. 

Paso 5 

A continuación, agregamos Elastic support a la muestra y al pin de carga para restringirlos levemente. 
La rigidez del soporte elástico debe ser suficientemente baja como para que no interfiera 
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significativamente con el modelo, pero suficientemente alta como para evitar desplazamientos extremos. 
Intente esto resolviendo la configuración de Elastic_support.  Sigue fallando. 

 

Paso 6 

Una forma final de ayudar a converger es comenzando con una fuerza inicial más pequeña. Esto es fácil 
de lograr sin afectar la fuerza final al aumentarla cuadráticamente (Fy  = -1000 × t2) en lugar de linealmente 
(Fy  = -1000 × t). Intente esto resolviendo la configuración de Quadratic_ramp.   

 

Ahora se resuelve con éxito. Observe que el desplazamiento es simétrico a pesar de las ubicaciones 
asimétricas de los soportes elásticos. Eso indica que son lo suficientemente débiles como para no tener 
un efecto obvio en la solución. Para medir esto con mayor precisión debemos comprobar que las fuerzas 
externas en los soportes elásticos son insignificantes. Desafortunadamente, la fuerza externa no está 
disponible con soporte elástico, por lo que tendría que reemplazarlo con soporte fijo conectado al modelo 
a través de elementos con un material de baja rigidez. 

. 

 

17.8 Análisis estático de un cilindro presurizado 

Un cilindro de 2m de radio, 10m de longitud, 0,2 m de espesor, módulo de Young 200 GPa y coeficiente 
de Poisson 0,285 será analizado para determinar la tensión circunferencial causada por una presión 
interna de 100 N/m2. 

Según la teoría de recipientes, la tensión circunferencial o de aro para un cilindro delgado de radio 
constante y presión interna uniforme está dada por: 
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σ = (presión × radio) / espesor 

σ = (100 × 2) / 0,2 

σ = 1000 Pa 

 

 
Paso 1 

  Compruebe que el tipo de análisis predeterminado es Static 3D. 

 

Paso 2 

Mesh tools→ Create→ Curve generator... clique en Straight line e ingrese los siguientes valores: 

 

X1   2 m 

Y1   0 

Z1   0 

X2   2 m 

Y2   0 

Z2   10 m 

Number of nodes 12 

 

Clique OK y luego Apply para generar los elementos y use Fit to 

window  para verlos. 

 

 

 

 

Paso 3 

 

Debido a la simetría axial, solo modelaremos un cuadrante  

 

Active Edit → Edge detecting selection y clique en la línea 

para seleccionar todos los elementos. 

 

 

Mesh tools→ Revolve... 

Axis direction  +Z 

Angle    90 ° 

Subdivisions   8 
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Paso 4 

Haga clic derecho, seleccione Assign new material  

Ficha Geometric   

Seleccione Shell/membrane 

Thickness   0,2 m 

Ficha Mechanical 

Seleccione Isotropic. 

Young’s modulus  200E9 Pa 

Poisson’s ratio   0,285 

Paso 5 

Gracias a la simetría de espejo se ha modelado solo un 
cuadrante del cilindro. En los planos de simetría de 
espejo, los nodos deben ser restringidos para que no 
salgan del plano. Asimismo, no deben producirse flexión 
en ese plano de simetría.  

Active Edit → Edge detecting selection nuevamente. 

Para aplicar la simetría de espejo en el borde en el plano 
YZ, clique en ese borde de la cáscara para seleccionarlo, 
haga clic derecho Loads & Constraints en el esquema 
de árbol, clique nodes y luego OK. 

Repita para el borde en el plano ZX pero esta vez, 
seleccione la opción Y en la ventana Symmetry. 

Para eliminar el movimiento de traslación de cuerpo rígido a lo largo del eje Z, haga clic en la arista del 
plano XY, clique con el botón derecho en Loads & Constraints en el esquema de árbol, haga clic en 
Desplacement, seleccione la opción Z y luego, haga clic en OK. 

Paso 6 

Clique sobre la superficie exterior para seleccionarle. 
Haga clic derecho Loads & Constraints en el 
esquema de árbol, clique Pressure, y fíjela en -100 Pa. 

Paso 7 

Haga clic aquí  para resolver el modelo. 

Los resultados se muestran en el esquema de árbol 
bajo Solution. Clique von Mises stress para ver la 
tensión de aro. 

Lo primero que hay que hacer es comprobar la 
deformación. Errores en la aplicación de restricciones o 
cargas pueden notarse en la deformación. 

Haga clic en la flecha Z para ver el plano XY paralelo a la pantalla. 

Haga clic en el botón herramienta Deformed view  y aceptar los valores predeterminados. 
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Haga clic en el botón herramienta Undeformed shape 

 para superponer la geometría sin deformar sobre la 
deformada. 

Observe que los nodos en el plano YZ y ZX permanecen 
en estos planos y no se ha producido deflexión, esto 
indica que las restricciones aplicadas para imponer 
simetría están trabajando. El hecho de que la 
deformación se expande hacia fuera radialmente indica 
que la presión interna se ha aplicado correctamente. 

 

 

 

 

 

 

La tensión de aro calculada difiere sólo el 0,48% de 
la calculada a mano. Esto es lo suficientemente 
cerca como para no necesitar mayor refinamiento de 
malla. 

 

17.9 Análisis térmico de una barra que 
se está enfriando 

Una barra de acero a una temperatura inicial de 250 °C se sumerge repentinamente en un baño de aceite 
de temperatura de 50 °C.  Encontraremos el tiempo que tarda la barra en enfriarse a una temperatura de 
200 °C. 

Paso 1 

Abra BarMesh.liml desde la carpeta de tutoriales donde se ha instalado Mecway. 

Paso 2 

Haga doble clic en Analysis en la parte superior del esquema de árbol y especifique: 

 Analysis type  Thermal Transient 

 Time period  400 s 

 Time step  10 s 

Paso 3 

Haga clic con el botón derecho en el componente Predeterminado en el esquema de árbol y haga clic en 
Assign new material. En la ficha Density, seleccione Density e introduzca 7860 kg/m3. En la ficha 
Thermal, seleccione Isotropic y especifique Thermal conductivity como 40 W/m/K y Specific heat 
como 500 J/kg/K. 

 

Paso 4 

Seleccione los 16 elementos, haga clic con el botón derecho en Initial Conditions en el esquema de 
árbol y haga clic en Temperature. Especifique un valor de 250 °C. 
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Paso 5 

La transferencia de calor por convección tiene lugar en toda la superficie de la barra. Seleccione todas 
las caras exteriores, haga clic con el botón derecho en una de ellas, haga clic en Convection en el 
submenú Loads & Constraints, especifique los siguientes valores y, a continuación, haga clic en OK.  

Ambient temperature 50°C 

Heat transfer coefficient 80 W/m2/K 

 

 

 

Paso 6 

Haga clic para resolver el modelo. Los resultados se enumeran en el esquema de árbol debajo de 
Soluction. Haga clic en temperature y, en el modo Select nodes, haga clic en un nodo cerca del centro 
de la barra. Se mostrará un gráfico de su historial de temperatura en la línea de tiempo. Puede ver que el 
centro de la barra alcanza los 200 ° C a unos 300 s. 
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Paso 7 

Puede haber un error debido a la tosquedad de la malla, así que refina la malla usando Mesh tools → 
Refine → x2. 

 

Paso 8 

Haga clic para resolver el modelo de nuevo. Haga clic en temperature bajo Solution en el esquema 
de árbol y, en el modo Select nodes, vuelva a hacer clic en el mismo nodo. Esto muestra que la 
temperatura todavía está dentro de aproximadamente medio grado de lo que era con la malla gruesa, por 
lo que la malla probablemente sea lo suficientemente fina. 

17.10 Tensión térmica 

Paso 1 

Comenzar un nuevo modelo. File→ New 

Haga doble clic en Analysis en el esquema de árbol y seleccione Thermal Steady State y, a 
continuación, pulse OK. 

 

Paso 2 

Cree un nuevo elemento hex8 haciendo clic en el botón de herramienta Cubo rápido   

 

Paso 3 

Active Selección de caras   

Haga clic en cualquier lugar del área de 
gráficos para borrar la selección. 

Haga clic derecho sobre cualquier cara y 
seleccione Loads & constraints→ 
Temperature 
Introduzca el valor 100. Esto fija la 
temperatura de esa cara en 100°C. 

 

Paso 4 

Haga clic derecho sobre otra cara y seleccione Loads & 
constraints→ Convection 

Ambient temperature 20°C 

Heat transfer coefficient 400 W/m2/K 
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Paso 5 

Haga clic derecho en el componente Default <1 elements> en el esquema de árbol y elija Assign new 
material. 

Seleccione Isotropic e introduzca Thermal conductivity de 40. Esto es 40 W/m/K. 

Paso 6 

 Resolver. 

Haga clic en Temperature bajo la rama Solution del esquema de 
árbol. 

Sus valores de temperatura pueden ser diferentes dependiendo del 
tamaño del cubo. 

Observe que algunos nodos tienen una irreal temperatura inferior a 
los 20°C de temperatura ambiente. Esto es debido a la malla 
demasiado gruesa. En un problema práctico, se refinaría la malla para 
mejorar la precisión. 

Paso 7 

Haga doble clic en Analysis. Seleccione Static 3D  

Paso 8 

 

Haga clic derecho en Loads & constraints y seleccione Transfer temperatures 
from solution 

Paso 9 

Haga clic derecho en Loads & constraints y seleccione de Thermal stress 

Reference temperature 20 

La temperatura de referencia es la temperatura inicial de los nodos que son ahora en las temperaturas 
que fueron transferidos de la solución de análisis térmico. 

Paso 10 

Haga clic derecho en Material y seleccione Edit  

Ficha Mechanical 

Isotropic 

Young’s modulus   200 GPa 

Thermal expansion coefficient 11E-06  1/K 

Ficha Density 

Density    7800 kg/m3 

Paso 11 

 

Haga clic derecho en cualquier cara y elija Loads & constraints→ Fixed 
support 

Paso 12. 

 Resolver 

La solución ahora muestra el cubo deformado por la expansión térmica. 
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17.11 Vibración libre de una viga en voladizo 

Encontraremos la frecuencia natural más baja de una viga en voladizo de longitud 1.2 m, sección 
transversal 0.2 m × 0.05 m, módulo de Young 200 GPa y densidad 7860 kg/m3. 

Para vigas delgadas, se utiliza la siguiente ecuación analítica para calcular la primera frecuencia natural: 

 

𝑓 =
𝐾1

2𝜋
√

𝑘

3𝑚
 

 K1 = 3,52 

 m  = densidad × volumen 

  = 94,32 kg 

 k = 3× E×I / L3 

 I  = momento de inercia de la sección transversal 

  = bh3/12 

  = 2,083×10-6 m4 

 E  = Módulo de Young 

 L  = longitud 

𝑓 = 28.3Hz 

 

Paso 1 

Abra BarMesh.liml desde la carpeta de tutoriales donde se ha instalado Mecway. 

 

Paso 2 

Haga doble clic en Analysis en la parte superior del árbol de contorno y especifique: 

 Analysis type  Frequency 

 Number of modes  3 

Paso 3 

Haga clic con el botón derecho en el componente Predeterminado en el árbol de contorno y haga clic en 
Assign new material. Seleccione Isotropic y especifique Young's modulus como 200 GPa. En la ficha 
Density, seleccione Density e introduzca 7860 kg/m3. 

 

Paso 4 

Haga clic con el botón derecho en una de las caras finales, haga clic en Fixed support en el submenú 
Loads & Constraints y, a continuación, haga clic en OK. 
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Paso 5 

Haga clic para resolver el modelo. Los resultados se enumeran en el esquema de árbol debajo de 
Solution. La frecuencia para el modo más bajo (Mode 1) coincide con el resultado del cálculo manual de 

28,3 Hz. Haga clic en Mode 1 y, a continuación, en el botón Animar para ver la forma del modo. 

 

Tenga en cuenta que los valores de desplazamiento y tensión de un análisis modal solo son significativos 
entre sí. La escala de los valores de una estructura real depende del historial de carga y la amortiguación 
que no se modelan mediante análisis de frecuencia. 

17.12 Respuesta Dinámica de una pieza sólida 

Paso 1 

Abra DynamicResponse.liml en la carpeta tutoriales donde se ha instalado Mecway. 

Paso 2 

Haga doble clic en Analysis en la parte superior del esquema de árbol y especifique: 

Time period   0.003 s 

Time step   0.0004 s 

Paso 3 

Active Selección de nodos  y seleccione este nodo. 

Se aplicará una fuerza en forma de rampa lineal desde 0 hasta un 
máximo de 500 N y luego hasta 0. En cada etapa, Mecway 
determinará la fuerza por interpolación entre los valores 
especificados. 

Haga clic derecho en Loads & constraints y seleccione Force. Bajo 
X seleccione Table e ingrese las siguientes 3 filas: 

 0  0 

 0.0015  500 

 0.003  0 
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Paso 4 

 

Haga clic derecho en la selección Surface15 y 
seleccione Loads & constraints→ Fixed 

support 

 

Paso 5 

 Resuelva y luego seleccione cualquiera de los 
resultados bajo el grupo solución en el esquema de 
árbol. Arrastre el control deslizante de la línea de 
tiempo para mostrar los resultados en los distintos 
escalones de tiempo. Seleccione un nodo para 
mostrar un gráfico de su desplazamiento. 

 

17.13 Análisis acústico de un tubo de órgano 

Vamos a predecir la nota musical producida por un tubo de órgano de "madera abierta" de 8 pies de largo. 
Un tubo real sería de sección rectangular, pero aquí hacemos solo un modelo 2D. La tubería tendrá 120 
mm de ancho con una boca de 30 mm en un extremo donde se sopla el aire y una abertura en el otro 
extremo para que salga el aire. La madera tiene un grosor de 10 mm. 

En el análisis acústico, se debe mallar el aire dentro del tubo y no el tubo en sí. La malla debe incluir un 
gran volumen de aire en la habitación fuera de la tubería que está conectada a la boca y al extremo abierto. 
Este esquema permite a Mecway modelar fugas y aberturas. Estamos interesados sólo en los modos 
resonantes del tubo del órgano, pero Mecway también predecirá las resonancias en el aire exterior. Una 
parte importante de este estudio de caso, por lo tanto, es mostrar cómo se requiere cierta comprensión 
de la física para interpretar los resultados e identificar los modos apropiados. 

Se hará un cálculo aproximado de la frecuencia esperada. 

Se debe agregar un factor de corrección final a la longitud de la tubería. Este factor de corrección es igual 
al ancho de la tubería. Por lo tanto, la longitud efectiva de la tubería es 2.4384 m + 0.12 m = 2.5584 m 

Cuando 1/2 longitud de onda encaja en la tubería, será de longitud de onda λ = 2 × 2.5584 m = 5.1168 m 

La velocidad del sonido en el aire a 15°C es de 340 m/s, por lo que la frecuencia esperada será f=v/λ = 
340/5.1168 = 66.45 Hz. 

Paso 1 

Abra el archivo AcousticAnalysisOfAnOrganPipe.liml en la carpeta tutoriales donde se ha instalado 
Mecway. Esto es solo la malla. 

Paso 2 

Haga doble clic en Analysis en la parte superior del árbol de contorno y, a continuación, seleccione 
Acoustic Resonance 2D y establezca Number of modes en 20. 
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Para determinar el tono fundamental necesitamos examinar los resultados una serie de tonos. También 
veremos los armónicos. 

Paso 3 

Haga clic con el botón derecho en el componente Default en el árbol de contorno y haga clic en Assign 
new material. Seleccione Isotropic y especifique Speed of sound como 340 m/s. 

Paso 4 

No se requieren condiciones de contorno especiales porque el borde de la malla representa una superficie 

dura. Haga clic en para resolver el modelo. 

Las frecuencias modales se enumeran en el esquema de árbol debajo de Solución. Haga clic en los nodos 
para obtener una lectura de la variable de campo allí. 

La sutileza en este estudio de caso está en la interpretación de los resultados. De los 20 modos calculados 
queremos elegir el tono fundamental del tubo en sí. Haga clic en los diversos modos y observe que la 
mayoría muestran manchas rojas, amarillas y azules para los elementos de aire de la habitación. 

El 4º modo a 64,59 Hz es diferente porque la "habitación" está casi a presión constante (color). Haga 
zoom en la tubería y observe que la magnitud de la presión máxima dentro de la tubería es mucho mayor 
que en cualquier lugar fuera de la tubería. Esto identifica el modo 4 como el tono fundamental del tubo 
del órgano. La mitad de una longitud de onda cabe dentro de la tubería. La frecuencia coincide muy bien 
con el valor calculado a mano. 
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Del mismo modo, el modo 8 a 131 Hz tiene una presión casi constante en la habitación y una presión alta 
y variable en la tubería. Este es el primer armónico al doble de la frecuencia del modo 4, sonando una 
octava más alto. Una longitud de onda completa encaja dentro de la tubería. 

 

17.14 Ecuaciones de restricción 

Paso 1 

Abra ConstraintEquations.liml de la carpeta tutoriales donde se ha instalado Mecway. 

Paso 2 

Haga clic derecho en Loads & Constraints en el esquema de árbol y clique en Constraint equation. 

Haga clic en New term y especifique: 

Coeficiente   1 

DOF    Desplazamiento en X 

Nodo    201 

Clique OK 

Haga clic en OK 

Haga clic nuevamente en New term y especifique: 

Coeficiente   -1 

DOF    Desplazamiento en X 

Nodo    36 

Clique OK 

La ecuación de restricción ahora debe quedar 

1 ux201 - 1 ux36 = 0 

Paso 3 

clic derecho en este nodo y seleccione Loads & constraints→ Force 

Especifique la componente X como 100 N. 

Paso 4 

Haga clic en  para resolver el modelo. Los dos nodos tienen el 
mismo desplazamiento X como si estuvieran conectados por una 
barra rígida no rotativa. 

 

 



168 

 

18 Capítulo 18 

License Agreements 

18.1 Mecway End User License 
Agreement (EULA) 

1. This agreement is between you and Mecway Limited (New Zealand) and relates to the 
Mecway finite element analysis package including third party software libraries and any internet 
and support services provided for it, collectively referred to as "the software". 

2. THE SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED 
WARRANTIES FOR MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

3. You must indemnify and defend Mecway Limited, its directors, staff, contractors and 
suppliers and the developers of and contributors to any portion of the software from any claims 
related to your use of the software. 

4. You may not redistribute, reverse engineer or disassemble the Intel Math Kernel Library 
included with the software. 

5. Parts of the software are used under license from their respective copyright holders. 

6. Your use of Open CASCADE Technology 6.3 used by the software is covered by the Open 
CASCADE Technology Public License version 6.3. 

7. Open CASCADE Technology 7.3 used by the software is covered by the GNU Lesser 
General Public License Version 2.1 with with additional exception. 

8. The Netgen, Pthreads-win32 and ZedGraph libraries used by the software are covered by 
the GNU Lesser General Public License Version 2.1. 

18.2 ARPACK 
The ARPACK software library included with Mecway is used under the following license. 

 

Copyright (c) 1996-2008 Rice University.   

Developed by D.C. Sorensen, R.B. Lehoucq, C. Yang, and K. Maschhoff. 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

- Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 

- Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer listed in this license in the documentation and/or other materials 
provided with the distribution. 

- Neither the name of the copyright holders nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

18.3 SlimDX 
The SlimDX graphics library included with Mecway is used under the following license. 

 

Copyright (c) 2007-2010 SlimDX Group 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software 
and associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, 
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. 
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, 
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

18.4 Bouncy Castle 
The Bouncy Castle software library included with Mecway is used under the following license. 

 

Copyright (c) 2000 - 2015 The Legion of the Bouncy Castle Inc. (http://www.bouncycastle.org) 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software 
and associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, 
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. 
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, 
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

18.5 Netgen, Pthreads-win32 
ZedGraph and OCCT version 7.3 

The Netgen software library included with Mecway is copyright by Joachim Schoeberl. Its use 
is covered by the GNU Lesser General Public License Version 2.1. 

The Pthreads-win32 software library release 2.8.0 included with Mecway is subject to the 
following copyright: 

Pthreads-win32 - POSIX Threads Library for Win32 

Copyright(C) 1998 John E. Bossom 

Copyright(C) 1999, 2006 Pthreads-win32 contributors 

Copying, distribution and modifications of it must be done in accordance with the GNU Lesser 
General Public License version 2.1. 

The ZedGraph software library included with Mecway is copyright by John Champion. Its use 
is covered by the GNU Lesser General Public License Version 2.1. 

The ZedGraph software library included with Mecway is copyright by John Champion. Its use 
is covered by the GNU Lesser General Public License Version 2.1. 

Open CASCADE Technology version 7.3 is included with Mecway. The source code is 
available from https://www.opencascade.com/. Its use is covered by the GNU Lesser General 
Public License Version 2.1 with additional exception. The exception is: 

Open CASCADE Exception (version 1.0) to GNU LGPL version 2.1. 

The object code (i.e. not a source) form of a "work that uses the Library" can incorporate 
material from a header file that is part of the Library. As a special exception to the GNU Lesser 
General Public License version 2.1, you may distribute such object code incorporating material 
from header files provided with the Open CASCADE Technology libraries (including code of 
CDL generic classes) under terms of your choice, provided that you give prominent notice in 
supporting documentation to this code that it makes use of or is based on facilities provided by 
the Open CASCADE Technology software. 

Netgen has been modified for use with Mecway. You can obtain a complete machine-readable 
copy of the modified source code by sending a written request to the address for service of 
Mecway Limited (NZBN/GLN 9429030014299). Your request must include a return email 
address and be sent within 3 years of the date you received Netgen. For your convenience, 
you may also be able to obtain this source code by sending a request to support@mecway.com 

The original source code is available from: 

http://sourceforge.net/projects/netgen-mesher/files/ 

If you wish to modify and/or recompile the Pthreads-win32 library, the source code can be 
obtained from: 

http://sourceware.org/pthreads-win32/ 

If you wish to modify and/or recompile the ZedGraph library, you can download the source 
code from: 
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http://sourceforge.net/projects/zedgraph 

18.6 GNU Lesser General Public 
License 

GNU LESSER GENERAL PUBLIC LICENSE 

Version 2.1, February 1999 

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 

51 Franklin Street, Fifth Floor, Boston, MA  02110-1301 USA 

Everyone is permitted to copy and distribute verbatim copies of this 

license document, but changing it is not allowed. 

 

[This is the first released version of the Lesser GPL.  It also counts 

as the successor of the GNU Library Public License, version 2, hence 

the version number 2.1.] 

 

Preamble 

The licenses for most software are designed to take away your freedom to share and change 
it. By contrast, the GNU General Public Licenses are intended to guarantee your freedom to 
share and change free software--to make sure the software is free for all its users. 

This license, the Lesser General Public License, applies to some specially designated software 
packages--typically libraries--of the Free Software Foundation and other authors who decide 
to use it. You can use it too, but we suggest you first think carefully about whether this license 
or the ordinary General Public License is the better strategy to use in any particular case, based 
on the explanations below. 

When we speak of free software, we are referring to freedom of use, not price. Our General 
Public Licenses are designed to make sure that you have the freedom to distribute copies of 
free software (and charge for this service if you wish); that you receive source code or can get 
it if you want it; that you can change the software and use pieces of it in new free programs; 
and that you are informed that you can do these things. 

To protect your rights, we need to make restrictions that forbid distributors to deny you these 
rights or to ask you to surrender these rights. These restrictions translate to certain 
responsibilities for you if you distribute copies of the library or if you modify it. 

For example, if you distribute copies of the library, whether gratis or for a fee, you must give 
the recipients all the rights that we gave you. You must make sure that they, too, receive or 
can get the source code. If you link other code with the library, you must provide complete 
object files to the recipients, so that they can relink them with the library after making changes 
to the library and recompiling it. And you must show them these terms so they know their rights. 

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer 
you this license, which gives you legal permission to copy, distribute and/or modify the library. 

To protect each distributor, we want to make it very clear that there is no warranty for the free 
library. Also, if the library is modified by someone else and passed on, the recipients should 
know that what they have is not the original version, so that the original author's reputation will 
not be affected by problems that might be introduced by others. 

Finally, software patents pose a constant threat to the existence of any free program. We wish 
to make sure that a company cannot effectively restrict the users of a free program by obtaining 
a restrictive license from a patent holder. Therefore, we insist that any patent license obtained 
for a version of the library must be consistent with the full freedom of use specified in this 
license. 

Most GNU software, including some libraries, is covered by the ordinary GNU General Public 
License. This license, the GNU Lesser General Public License, applies to certain designated 
libraries, and is quite different from the ordinary General Public License. We use this license 
for certain libraries in order to permit linking those libraries into non-free programs. 

When a program is linked with a library, whether statically or using a shared library, the 
combination of the two is legally speaking a combined work, a derivative of the original library. 
The ordinary General Public License therefore permits such linking only if the entire 
combination fits its criteria of freedom. The Lesser General Public License permits more lax 
criteria for linking other code with the library. 

We call this license the "Lesser" General Public License because it does Less to protect the 
user's freedom than the ordinary General Public License. It also provides other free software 
developers less of an advantage over competing non-free programs. These disadvantages are 
the reason we use the ordinary General Public License for many libraries. However, the Lesser 
license provides advantages in certain special circumstances. 

For example, on rare occasions, there may be a special need to encourage the widest possible 
use of a certain library, so that it becomes a de-facto standard. To achieve this, non-free 
programs must be allowed to use the library. A more frequent case is that a free library does 
the same job as widely used non-free libraries. In this case, there is little to gain by limiting the 
free library to free software only, so we use the Lesser General Public License. 

In other cases, permission to use a particular library in non-free programs enables a greater 
number of people to use a large body of free software. For example, permission to use the 
GNU C Library in non-free programs enables many more people to use the whole GNU 
operating system, as well as its variant, the GNU/Linux operating system. 

Although the Lesser General Public License is Less protective of the users' freedom, it does 
ensure that the user of a program that is linked with the Library has the freedom and the 
wherewithal to run that program using a modified version of the Library. 

The precise terms and conditions for copying, distribution and modification follow. Pay close 
attention to the difference between a "work based on the library" and a "work that uses the 
library". The former contains code derived from the library, whereas the latter must be 
combined with the library in order to run. 

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 

0. This License Agreement applies to any software library or other program which contains a 
notice placed by the copyright holder or other authorized party saying it may be distributed 
under the terms of this Lesser General Public License (also called "this License"). Each 
licensee is addressed as "you". 

A "library" means a collection of software functions and/or data prepared so as to be 
conveniently linked with application programs (which use some of those functions and data) to 
form executables. 

The "Library", below, refers to any such software library or work which has been distributed 
under these terms. A "work based on the Library" means either the Library or any derivative 
work under copyright law: that is to say, a work containing the Library or a portion of it, either 
verbatim or with modifications and/or translated straightforwardly into another language. 
(Hereinafter, translation is included without limitation in the term "modification".) 

"Source code" for a work means the preferred form of the work for making modifications to it. 
For a library, complete source code means all the source code for all modules it contains, plus 
any associated interface definition files, plus the scripts used to control compilation and 
installation of the library. 

Activities other than copying, distribution and modification are not covered by this License; they 
are outside its scope. The act of running a program using the Library is not restricted, and 
output from such a program is covered only if its contents constitute a work based on the 
Library (independent of the use of the Library in a tool for writing it). Whether that is true 
depends on what the Library does and what the program that uses the Library does. 

1. You may copy and distribute verbatim copies of the Library's complete source code as you 
receive it, in any medium, provided that you conspicuously and appropriately publish on each 
copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that 
refer to this License and to the absence of any warranty; and distribute a copy of this License 
along with the Library. 

You may charge a fee for the physical act of transferring a copy, and you may at your option 
offer warranty protection in exchange for a fee. 

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work 
based on the Library, and copy and distribute such modifications or work under the terms of 
Section 1 above, provided that you also meet all of these conditions: 

a) The modified work must itself be a software library. 

b) You must cause the files modified to carry prominent notices stating that you changed the 
files and the date of any change. 

c) You must cause the whole of the work to be licensed at no charge to all third parties under 
the terms of this License. 

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an 
application program that uses the facility, other than as an argument passed when the facility 
is invoked, then you must make a good faith effort to ensure that, in the event an application 
does not supply such function or table, the facility still operates, and performs whatever part of 
its purpose remains meaningful. 

(For example, a function in a library to compute square roots has a purpose that is entirely well-
defined independent of the application. Therefore, Subsection 2d requires that any application-
supplied function or table used by this function must be optional: if the application does not 
supply it, the square root function must still compute square roots.) 

These requirements apply to the modified work as a whole. If identifiable sections of that work 
are not derived from the Library, and can be reasonably considered independent and separate 
works in themselves, then this License, and its terms, do not apply to those sections when you 
distribute them as separate works. But when you distribute the same sections as part of a 
whole which is a work based on the Library, the distribution of the whole must be on the terms 
of this License, whose permissions for other licensees extend to the entire whole, and thus to 
each and every part regardless of who wrote it. 

Thus, it is not the intent of this section to claim rights or contest your rights to work written 
entirely by you; rather, the intent is to exercise the right to control the distribution of derivative 
or collective works based on the Library. 

In addition, mere aggregation of another work not based on the Library with the Library (or with 
a work based on the Library) on a volume of a storage or distribution medium does not bring 
the other work under the scope of this License. 

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this 
License to a given copy of the Library. To do this, you must alter all the notices that refer to this 
License, so that they refer to the ordinary GNU General Public License, version 2, instead of 
to this License. (If a newer version than version 2 of the ordinary GNU General Public License 
has appeared, then you can specify that version instead if you wish.) Do not make any other 
change in these notices. 

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU 
General Public License applies to all subsequent copies and derivative works made from that 
copy. 

This option is useful when you wish to copy part of the code of the Library into a program that 
is not a library. 

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in 
object code or executable form under the terms of Sections 1 and 2 above provided that you 
accompany it with the complete corresponding machine-readable source code, which must be 
distributed under the terms of Sections 1 and 2 above on a medium customarily used for 
software interchange. 

If distribution of object code is made by offering access to copy from a designated place, then 
offering equivalent access to copy the source code from the same place satisfies the 
requirement to distribute the source code, even though third parties are not compelled to copy 
the source along with the object code. 

5. A program that contains no derivative of any portion of the Library, but is designed to work 
with the Library by being compiled or linked with it, is called a "work that uses the Library". 
Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside the 
scope of this License. 

However, linking a "work that uses the Library" with the Library creates an executable that is a 
derivative of the Library (because it contains portions of the Library), rather than a "work that 
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uses the library". The executable is therefore covered by this License. Section 6 states terms 
for distribution of such executables. 

When a "work that uses the Library" uses material from a header file that is part of the Library, 
the object code for the work may be a derivative work of the Library even though the source 
code is not. Whether this is true is especially significant if the work can be linked without the 
Library, or if the work is itself a library. The threshold for this to be true is not precisely defined 
by law. 

If such an object file uses only numerical parameters, data structure layouts and accessors, 
and small macros and small inline functions (ten lines or less in length), then the use of the 
object file is unrestricted, regardless of whether it is legally a derivative work. (Executables 
containing this object code plus portions of the Library will still fall under Section 6.) 

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the 
work under the terms of Section 6. Any executables containing that work also fall under Section 
6, whether or not they are linked directly with the Library itself. 

6. As an exception to the Sections above, you may also combine or link a "work that uses the 
Library" with the Library to produce a work containing portions of the Library, and distribute that 
work under terms of your choice, provided that the terms permit modification of the work for 
the customer's own use and reverse engineering for debugging such modifications. 

You must give prominent notice with each copy of the work that the Library is used in it and 
that the Library and its use are covered by this License. You must supply a copy of this License. 
If the work during execution displays copyright notices, you must include the copyright notice 
for the Library among them, as well as a reference directing the user to the copy of this License. 
Also, you must do one of these things: 

a) Accompany the work with the complete corresponding machine-readable source code for 
the Library including whatever changes were used in the work (which must be distributed under 
Sections 1 and 2 above); and, if the work is an executable linked with the Library, with the 
complete machine-readable "work that uses the Library", as object code and/or source code, 
so that the user can modify the Library and then relink to produce a modified executable 
containing the modified Library. (It is understood that the user who changes the contents of 
definitions files in the Library will not necessarily be able to recompile the application to use the 
modified definitions.) 

b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism 
is one that (1) uses at run time a copy of the library already present on the user's computer 
system, rather than copying library functions into the executable, and (2) will operate properly 
with a modified version of the library, if the user installs one, as long as the modified version is 
interface-compatible with the version that the work was made with. 

c) Accompany the work with a written offer, valid for at least three years, to give the same user 
the materials specified in Subsection 6a, above, for a charge no more than the cost of 
performing this distribution. 

d) If distribution of the work is made by offering access to copy from a designated place, offer 
equivalent access to copy the above specified materials from the same place. 

e) Verify that the user has already received a copy of these materials or that you have already 
sent this user a copy. 

For an executable, the required form of the "work that uses the Library" must include any data 
and utility programs needed for reproducing the executable from it. However, as a special 
exception, the materials to be distributed need not include anything that is normally distributed 
(in either source or binary form) with the major components (compiler, kernel, and so on) of the 
operating system on which the executable runs, unless that component itself accompanies the 
executable. 

It may happen that this requirement contradicts the license restrictions of other proprietary 
libraries that do not normally accompany the operating system. Such a contradiction means 
you cannot use both them and the Library together in an executable that you distribute. 

7. You may place library facilities that are a work based on the Library side-by-side in a single 
library together with other library facilities not covered by this License, and distribute such a 
combined library, provided that the separate distribution of the work based on the Library and 
of the other library facilities is otherwise permitted, and provided that you do these two things: 

a) Accompany the combined library with a copy of the same work based on the Library, 
uncombined with any other library facilities. This must be distributed under the terms of the 
Sections above. 

b) Give prominent notice with the combined library of the fact that part of it is a work based on 
the Library, and explaining where to find the accompanying uncombined form of the same work. 

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly 
provided under this License. Any attempt otherwise to copy, modify, sublicense, link with, or 
distribute the Library is void, and will automatically terminate your rights under this License. 
However, parties who have received copies, or rights, from you under this License will not have 
their licenses terminated so long as such parties remain in full compliance. 

9. You are not required to accept this License, since you have not signed it. However, nothing 
else grants you permission to modify or distribute the Library or its derivative works. These 
actions are prohibited by law if you do not accept this License. Therefore, by modifying or 
distributing the Library (or any work based on the Library), you indicate your acceptance of this 
License to do so, and all its terms and conditions for copying, distributing or modifying the 
Library or works based on it. 

10. Each time you redistribute the Library (or any work based on the Library), the recipient 
automatically receives a license from the original licensor to copy, distribute, link with or modify 
the Library subject to these terms and conditions. You may not impose any further restrictions 
on the recipients' exercise of the rights granted herein. You are not responsible for enforcing 
compliance by third parties with this License. 

11. If, as a consequence of a court judgment or allegation of patent infringement or for any 
other reason (not limited to patent issues), conditions are imposed on you (whether by court 
order, agreement or otherwise) that contradict the conditions of this License, they do not 
excuse you from the conditions of this License. If you cannot distribute so as to satisfy 
simultaneously your obligations under this License and any other pertinent obligations, then as 
a consequence you may not distribute the Library at all. For example, if a patent license would 
not permit royalty-free redistribution of the Library by all those who receive copies directly or 
indirectly through you, then the only way you could satisfy both it and this License would be to 
refrain entirely from distribution of the Library. 

If any portion of this section is held invalid or unenforceable under any particular circumstance, 
the balance of the section is intended to apply, and the section as a whole is intended to apply 
in other circumstances. 

It is not the purpose of this section to induce you to infringe any patents or other property right 
claims or to contest validity of any such claims; this section has the sole purpose of protecting 
the integrity of the free software distribution system which is implemented by public license 
practices. Many people have made generous contributions to the wide range of software 
distributed through that system in reliance on consistent application of that system; it is up to 
the author/donor to decide if he or she is willing to distribute software through any other system 
and a licensee cannot impose that choice. 

This section is intended to make thoroughly clear what is believed to be a consequence of the 
rest of this License. 

12. If the distribution and/or use of the Library is restricted in certain countries either by patents 
or by copyrighted interfaces, the original copyright holder who places the Library under this 
License may add an explicit geographical distribution limitation excluding those countries, so 
that distribution is permitted only in or among countries not thus excluded. In such case, this 
License incorporates the limitation as if written in the body of this License. 

13. The Free Software Foundation may publish revised and/or new versions of the Lesser 
General Public License from time to time. Such new versions will be similar in spirit to the 
present version, but may differ in detail to address new problems or concerns. 

Each version is given a distinguishing version number. If the Library specifies a version number 
of this License which applies to it and "any later version", you have the option of following the 
terms and conditions either of that version or of any later version published by the Free 
Software Foundation. If the Library does not specify a license version number, you may choose 
any version ever published by the Free Software Foundation. 

14. If you wish to incorporate parts of the Library into other free programs whose distribution 
conditions are incompatible with these, write to the author to ask for permission. For software 
which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; 
we sometimes make exceptions for this. Our decision will be guided by the two goals of 
preserving the free status of all derivatives of our free software and of promoting the sharing 
and reuse of software generally. 

NO WARRANTY 

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY 
FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER 
PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH 
YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. 

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING 
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 
REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR 
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING 
BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR 
LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO 
OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

END OF TERMS AND CONDITIONS 

How to Apply These Terms to Your New Libraries 

If you develop a new library, and you want it to be of the greatest possible use to the public, 
we recommend making it free software that everyone can redistribute and change. You can do 
so by permitting redistribution under these terms (or, alternatively, under the terms of the 
ordinary General Public License). 

To apply these terms, attach the following notices to the library. It is safest to attach them to 
the start of each source file to most effectively convey the exclusion of warranty; and each file 
should have at least the "copyright" line and a pointer to where the full notice is found. 

One line to give the library's name and an idea of what it does. 

Copyright (C) year  name of author 

 

This library is free software; you can redistribute it and/or modify 

it under the terms of the GNU Lesser General Public 

License as published by the Free Software Foundation; either version 

2.1 of the License, or (at your option) any later version. 

 

This library is distributed in the hope that it will be useful, but 

WITHOUT ANY WARRANTY; without even the implied warranty of 

MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU 

Lesser General Public License for more details. 

 

You should have received a copy of the GNU Lesser General Public 

License along with this library; if not, write to the Free Software 

Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA  02110-

1301 USA 

 

Also add information on how to contact you by electronic and paper mail. 
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You should also get your employer (if you work as a programmer) or your school, if any, to sign 
a "copyright disclaimer" for the library, if necessary. Here is a sample; alter the names: 

Yoyodyne, Inc., hereby disclaims all copyright interest in the library 

`Frob' (a library for tweaking knobs) written by James Random Hacker. 

 

Signature of Ty Coon, 1 April 1990 

Ty Coon, President of Vice 

 

That's all there is to it! 

18.7 OCC CAD Kernel 
Parts of version 6.3 of OCC are included with Mecway. The source code is available from 
http://www.opencascade.org/. It is used under the following license agreement. 

Open CASCADE Technology Public License 

License version: 6.3 August, 2008 

Open CASCADE S.A.S. releases and makes publicly available the source code of the software 
Open CASCADE Technology to the free software development community under the terms 
and conditions of this license. 

It is not the purpose of this license to induce you to infringe any patents or other property right 
claims or to contest validity of any such claims; this license has the sole purpose of protecting 
the integrity of the free software distribution system, which is implemented by public license 
practices. Many people have made generous contributions to the wide range of software 
distributed through that system in reliance on consistent application of that system; it is up to 
the author/donor to decide if he or she is willing to distribute software through any other system 
and a licensee cannot impose that choice. 

Please read this license carefully and completely before downloading this software. By 
downloading, using, modifying, distributing and sublicensing this software, you indicate your 
acceptance to be bound by the terms and conditions of this license. If you do not want to accept 
or cannot accept for any reasons the terms and conditions of this license, please do not 
download or use in any manner this software. 

1. Definitions 

Unless there is something in the subject matter or in the context inconsistent therewith, the 
capitalized terms used in this License shall have the following meaning. 

"Applicable Intellectual Property Rights" means (a) with respect to the Initial Developer, any 
rights under patents or patents applications or other intellectual property rights that are now or 
hereafter acquired, owned by or assigned to the Initial Developer and that cover subject matter 
contained in the Original Code, but only to the extent necessary to use, reproduce, modify, 
distribute or sublicense the Original Code without infringement; and (b) with respect to You or 
any Contributor, any rights under patents or patents applications or other intellectual property 
rights that are now or hereafter acquired, owned by or assigned to You or to such Contributor 
and that cover subject matter contained in Your Modifications or in such Contributor's 
Modifications, taken alone or in combination with Original Code 

"Contributor" means each individual or legal entity that creates or contributes to the creation of 
any Modification, including the Initial Developer. 

"Derivative Program": means a new program combining the Software or portions thereof with 
other source code not governed by the terms of this License. 

"Initial Developer": means Open CASCADE S.A.S., with main offices at Tour Opus 12, 77, 
Esplanade du Général de Gaulle, 92914, Paris, La Défense Cedex, France. 

"Modifications": mean any addition to, deletion from or change to the substance or the structure 
of the Software. When source code of the Software is released as a series of files, a 
Modification is: (a) any addition to, deletion from or change to the contents of a file containing 
the Software or (b) any new file or other representation of computer program statements that 
contains any part of the Software. By way of example, Modifications include any debug of, or 
improvement to, the Original Code or any of its components or portions as well as its next 
versions or releases thereof. 

"Original Code": means (a) the source code of the software Open CASCADE Technology 
originally made available by the Initial Developer under this License, including the source code 
of any updates or upgrades of the Original Code and (b) the object code compiled from such 
source code and originally made available by Initial Developer under this License. 

"Software": means the Original Code, the Modifications, the combination of Original Code and 
any Modifications or any respective portions thereof. 

"You" or "Your": means an individual or a legal entity exercising rights under this License 

2. Acceptance of license 

By using, reproducing, modifying, distributing or sublicensing the Software or any portion 
thereof, you expressly indicate your acceptance of the terms and conditions of this License 
and undertake to act in accordance with all the provisions of this License applicable to you. 

3. Scope and purpose 

This License applies to the Software and you may not use, reproduce, modify, distribute, 
sublicense or circulate the Software, or any portion thereof, except as expressly provided under 
this License. Any attempt to otherwise use, reproduce, modify, distribute or sublicense the 
Software is void and will automatically terminate your rights under this License. 

4. Contributor license 

Subject to the terms and conditions of this License, the Initial Developer and each of the 
Contributors hereby grant You a world-wide, royalty-free, irrevocable and non-exclusive license 
under the Applicable Intellectual Property Rights they own or control, to use, reproduce, modify, 
distribute and sublicense the Software provided that: 

You reproduce in all copies of the Software the copyright and other proprietary notices and 
disclaimers of the Initial Developer as they appear in the Original Code and attached hereto as 
Schedule "A" and any other notices or disclaimers attached to the Software and keep intact all 
notices in the Original Code that refer to this License and to the absence of any warranty; 

You include a copy of this License with every copy of the Software you distribute; 

If you distribute or sublicense the Software (as modified by You or on Your behalf as the case 
may be), You cause such Software to be licensed as a whole, at no charge, to all third parties, 
under the terms and conditions of the License, making in particular available to all third parties 
the source code of the Software; 

You document all Your Modifications, indicate the date of each such Modifications, designate 
the version of the Software You used, prominently include a file carrying such information with 
respect to the Modifications and duplicate the copyright and other proprietary notices and 
disclaimers attached hereto as Schedule "B" or any other notices or disclaimers attached to 
the Software with your Modifications. 

For greater certainty, it is expressly understood that you may freely create Derivative Programs 
(without any obligation to publish such Derivative Program) and distribute same as a single 
product. In such case, you must ensure that all the requirements of this License are fulfilled for 
the Software or any portion thereof. 

5. Your license 

You hereby grant all Contributors and anyone who becomes a party under this License a world-
wide, non-exclusive, royalty-free and irrevocable license under the Applicable Intellectual 
Property Rights owned or controlled by You, to use, reproduce, modify, distribute and 
sublicense all Your Modifications under the terms and conditions of this License. 

6. Software subject to license 

Your Modifications shall be governed by the terms and conditions of this License. You are not 
authorized to impose any other terms or conditions than those prevailing under this License 
when You distribute and/or sublicense the Software, save and except as permitted under 
Section 7 hereof. 

7. Additional terms 

You may choose to offer, on a non-exclusive basis, and to charge a fee for any warranty, 
support, maintenance, liability obligations or other rights consistent with the scope of this 
License with respect to the Software (the "Additional Terms") to the recipients of the Software. 
However, you may do so only on your own behalf and on your sole and exclusive responsibility. 
You must obtain the recipient's agreement that any such Additional Terms are offered by you 
alone, and you hereby agree to indemnify, defend and hold the Initial Developer and any 
Contributor harmless for any liability incurred by or claims asserted against the Initial Developer 
or any Contributors with respect to any such Additional Terms. 

8. Disclaimer of warranty 

The Software is provided under this License on an "as is" basis, without warranty of any kind, 
including without limitation, warranties that the Software is free of defects, merchantable, fit for 
a particular purpose or non-infringing. The entire risk as to the quality and performance of the 
Software is with you. 

9. Liability 

Under no circumstances shall You, the Initial Developer or any Contributor be liable to any 
person for any direct or indirect damages of any kind including, without limitation, damages for 
loss of goodwill, loss of data, work stoppage, computer failure or malfunction or any and all 
other commercial damages or losses resulting from or relating to this License or indirectly to 
the use of the Software. 

10. Trademark 

This License does not grant any rights to use the trademarks, trade names and domain names 
"MATRA", "EADS Matra Datavision", "CAS.CADE", "Open CASCADE", "opencascade.com" 
and "opencascade.org" or any other trademarks, trade names or domain names used or owned 
by the Initial Developer. 

11. Copyright 

The Initial Developer retains all rights, title and interest in and to the Original Code. You may 
not remove the copyright © notice which appears when you download the Software. 

12. Term 

This License is granted to you for a term equal to the remaining period of protection covered 
by the intellectual property rights applicable to the Original Code. 

13. Termination 

In case of termination, as provided in Section 3 above, You agree to immediately stop any 
further use, reproduction, modification, distribution and sublicensing of the Software and to 
destroy all copies of the Software that are in Your possession or control. All sublicenses of the 
Software which have been properly granted prior to termination shall survive any termination 
of this License. In addition, Sections 5, 8 to 11, 13.2 and 15.2 of this License, in reason of their 
nature, shall survive the termination of this License for a period of fifteen (15) years. 

14. Versions of the license 

The Initial Developer may publish new versions of this License from time to time. Once Original 
Code has been published under a particular version of this License, You may choose to 
continue to use it under the terms and conditions of that version or use the Original Code under 
the terms of any subsequent version of this License published by the Initial Developer. 

15. Miscellaneous 

15.1 Relationship of the Parties 

This License will not be construed as creating an agency, partnership, joint venture or any 
other form of legal association between You and the Initial Developer, and You will not 
represent to the contrary, whether expressly, by implication or otherwise. 

15.2 Independent Development 

Nothing in this License will impair the Initial Developer's right to acquire, license, develop, have 
others develop for it, market or distribute technology or products that perform the same or 
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similar functions as, or otherwise compete with, Modifications, Derivative Programs, 
technology or products that You may develop, produce, market or distribute. 

15.3 Severability 

If for any reason a court of competent jurisdiction finds any provision of this License, or portion 
thereof, to be unenforceable, that provision of the License will be enforced to the maximum 
extent permissible so as to effect the economic benefits and intent of the parties, and the 
remainder of this License will continue in full force and extent. 

END OF THE TERMS AND CONDITIONS 

OF THIS LICENSE 

Open CASCADE S.A.S. is a French société par actions simplifiée having its registered head 
office at 31, avenue de la Baltique , 91954 Les Ulis Cedex, France and main offices at Tour 
Opus 12, 77, Esplanade du Général de Gaulle, 92914, Paris, La Défense Cedex, France. Its 

web site is located at the following address www.opencascade.com 

Open CASCADE Technology Public License 

Schedule "A" 

The content of this file is subject to the Open CASCADE Technology Public License Version 
6.2 (the "License"). You may not use the content of this file except in compliance with the 
License. Please obtain a copy of the License at http://www.opencascade.org and read it 

completely before using this file. 

The Initial Developer of the Original Code is Open CASCADE S.A.S., with main offices at 
Tour Opus 12, 77, Esplanade du Général de Gaulle, 92914, Paris, La Défense Cedex, 

France. The Original Code is copyright © Open CASCADE S.A.S., 2001. All rights reserved. 

"The Original Code and all software distributed under the License are distributed on an "AS 
IS" basis, without warranty of any kind, and the Initial Developer hereby disclaims all such 

warranties, including without limitation, any warranties of merchantability, fitness for a 
particular purpose or non-infringement. 

Please see the License for the specific terms and conditions governing rights and limitations 
under the License". 

End of Schedule "A" 

Open CASCADE Technology Public License 

Schedule "B" 

"The content of this file is subject to the Open CASCADE Technology Public License Version 
6.2 (the "License"). You may not use the content of this file except in compliance with the 
License. Please obtain a copy of the License at http://www.opencascade.org and read it 

completely before using this file. 

The Initial Developer of the Original Code is Open CASCADE S.A.S., with main offices at 
Tour Opus 12, 77, Esplanade du Général de Gaulle, 92914, Paris, La Défense Cedex, 

France. The Original Code is copyright © Open CASCADE S.A.S., 2001. All rights reserved. 

Modifications to the Original Code have been made by ________________________. 
Modifications are copyright © [Year to be included]. All rights reserved. 

The software Open CASCADE Technology and all software distributed under the License are 
distributed on an "AS IS" basis, without warranty of any kind, and the Initial Developer hereby 
disclaims all such warranties, including without limitation, any warranties of merchantability, 
fitness for a particular purpose or non-infringement. Please see the License for the specific 

terms and conditions governing rights and limitations under the License" 

End of Schedule "B" 

18.8 Turbo Color Map 
Apache License 

Version 2.0, January 2004 

http://www.apache.org/licenses/ 

 
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION 
 

1. Definitions. 
"License" shall mean the terms and conditions for use, reproduction, and distribution as 
defined by Sections 1 through 9 of this document. 

 
"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that 
is granting the License. 

 
"Legal Entity" shall mean the union of the acting entity and all other entities that control, are 
controlled by, or are under common control with that entity. For the purposes of this 
definition, "control" means (i) the power, direct or indirect, to cause the direction or 
management of such entity, whether by contract or otherwise, or (ii) ownership of fifty 
percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity. 
 

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by 
this License. 

 
"Source" form shall mean the preferred form for making modifications, including but not 
limited to software source code, documentation source, and configuration files. 
 

"Object" form shall mean any form resulting from mechanical transformation or translation 
of a Source form, including but not limited to compiled object code, generated 
documentation, and conversions to other media types. 
 

"Work" shall mean the work of authorship, whether in Source or Object form, made 
available under the License, as indicated by a copyright notice that is included in or 
attached to the work (an example is provided in the Appendix below). 
 

"Derivative Works" shall mean any work, whether in Source or Object form, that is based 
on (or derived from) the Work and for which the editorial revisions, annotations, 
elaborations, or other modifications represent, as a whole, an original work of authorship. 
For the purposes of this License, Derivative Works shall not include works that remain 
separable from, or merely link (or bind by name) to the interfaces of, the Work and 
Derivative Works thereof. 
 

"Contribution" shall mean any work of authorship, including the original version of the Work 
and any modifications or additions to that Work or Derivative Works thereof, that is 
intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an 
individual or Legal Entity authorized to submit on behalf of the copyright owner. For the 
purposes of this definition, "submitted" means any form of electronic, verbal, or written 
communication sent to the Licensor or its representatives, including but not limited to 
communication on electronic mailing lists, source code control systems, and issue tracking 
systems that are managed by, or on behalf of, the Licensor for the purpose of discussing 
and improving the Work, but excluding communication that is conspicuously marked or 
otherwise designated in writing by the copyright owner as "Not a Contribution." 
 

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a 
Contribution has been received by Licensor and subsequently incorporated within the 
Work. 

 
2. Grant of Copyright License. Subject to the terms and conditions of this License, each 
Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royaltyfree, 
irrevocable copyright license to reproduce, prepare Derivative Works of, publicly 
display, publicly perform, sublicense, and distribute the Work and such Derivative Works in 
Source or Object form. 

 
3. Grant of Patent License. Subject to the terms and conditions of this License, each 
Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royaltyfree, 
irrevocable (except as stated in this section) patent license to make, have made, use, 
offer to sell, sell, import, and otherwise transfer the Work, where such license applies only 
to those patent claims licensable by such Contributor that are necessarily infringed by their 
Contribution(s) alone or by combination of their Contribution(s) with the Work to which such 
Contribution(s) was submitted. If You institute patent litigation against any entity (including 
a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
incorporated within the Work constitutes direct or contributory patent infringement, then any 
patent licenses granted to You under this License for that Work shall terminate as of the 
date such litigation is filed. 

 
4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works 
thereof in any medium, with or without modifications, and in Source or Object form, 
provided that You meet the following conditions: 

 
(a) You must give any other recipients of the Work or Derivative Works a copy of this 
License; and 

 
(b) You must cause any modified files to carry prominent notices stating that You changed 
the files; and 

 
(c) You must retain, in the Source form of any Derivative Works that You distribute, all 
copyright, patent, trademark, and attribution notices from the Source form of the Work, 
excluding those notices that do not pertain to any part of the Derivative Works; and 
 

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative 
Works that You distribute must include a readable copy of the attribution notices contained 
within such NOTICE file, excluding those notices that do not pertain to any part of the 
Derivative Works, in at least one of the following places: within a NOTICE text file 
distributed as part of the Derivative Works; within the Source form or documentation, if 
provided along with the Derivative Works; or, within a display generated by the Derivative 
Works, if and wherever such third-party notices normally appear. The contents of the 
NOTICE file are for informational purposes only and do not modify the License. You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as 
an addendum to the NOTICE text from the Work, provided that such additional attribution 
notices cannot be construed as modifying the License. 
 

You may add Your own copyright statement to Your modifications and may provide 
additional or different license terms and conditions for use, reproduction, or distribution of 
Your modifications, or for any such Derivative Works as a whole, provided Your use, 
reproduction, and distribution of the Work otherwise complies with the conditions stated in 
this License. 

 
5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution 
intentionally submitted for inclusion in the Work by You to the Licensor shall be under the 
terms and conditions of this License, without any additional terms or conditions. 
Notwithstanding the above, nothing herein shall supersede or modify the terms of any 
separate license agreement you may have executed with Licensor regarding such 
Contributions. 

 
6. Trademarks. This License does not grant permission to use the trade names, 
trademarks, service marks, or product names of the Licensor, except as required for 
reasonable and customary use in describing the origin of the Work and reproducing the 
content of the NOTICE file. 

 
7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, 
Licensor provides the Work (and each Contributor provides its Contributions) on an "AS IS" 
BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or 
implied, including, without limitation, any warranties or conditions of TITLE, 

http://www.apache.org/licenses/
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NONINFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. 
You 
are solely responsible for determining the appropriateness of using or redistributing the 
Work and assume any risks associated with Your exercise of permissions under this 
License. 

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including 
negligence), contract, or otherwise, unless required by applicable law (such as deliberate 
and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for 
damages, including any direct, indirect, special, incidental, or consequential damages of 
any character arising as a result of this License or out of the use or inability to use the Work 
(including but not limited to damages for loss of goodwill, work stoppage, computer failure 
or malfunction, or any and all other commercial damages or losses), even if such 
Contributor has been advised of the possibility of such damages. 
 

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative 
Works thereof, You may choose to offer, and charge a fee for, acceptance of support, 
warranty, indemnity, or other liability obligations and/or rights consistent with this License. 
However, in accepting such obligations, You may act only on Your own behalf and on Your 
sole responsibility, not on behalf of any other Contributor, and only if You agree to 
indemnify, defend, and hold each Contributor harmless for any liability incurred by, or 
claims asserted against, such Contributor by reason of your accepting any such warranty 
or additional liability. 
 

END OF TERMS AND CONDITIONS 

 
APPENDIX: How to apply the Apache License to your work. 

 
To apply the Apache License to your work, attach the following boilerplate notice, with the 
fields enclosed by brackets "[]" replaced with your own identifying information. (Don't 
include the brackets!) The text should be enclosed in the appropriate comment syntax for 
the file format. We also recommend that a file or class name and description of purpose be 
included on the same "printed page" as the copyright notice for easier identification within 
third-party archives. 
 

Copyright [yyyy] [name of copyright owner] 

 
Licensed under the Apache License, Version 2.0 (the "License"); 

 
you may not use this file except in compliance with the License. 

 
You may obtain a copy of the License at 

 
http://www.apache.org/licenses/LICENSE-2.0 

 
Unless required by applicable law or agreed to in writing, software 
distributed under the License is distributed on an "AS IS" BASIS, 
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. 
See the License for the specific language governing permissions and 
limitations under the License. 

18.9 Intel MKL 
Intel Simplified Software License (Version October 2022) 

Use and Redistribution. You may use and redistribute the software, which is provided in binary 
form only, (the “Software”), without modification, provided the following conditions are met: 

• Redistributions must reproduce the above copyright notice and these terms of use in the 
Software and in the documentation and/or other materials provided with the distribution. 

• Neither the name of Intel nor the names of its suppliers may be used to endorse or 
promote products derived from this Software without specific prior written permission. 

• No reverse engineering, decompilation, or disassembly of the Software is permitted, nor 
any modification or alteration of the Software or its operation at any time, including during 
execution. 

No other licenses. Except as provided in the preceding section, Intel grants no licenses or other 
rights by implication, estoppel or otherwise to, patent, copyright, trademark, trade name, 
service mark or other intellectual property licenses or rights of Intel. 

Third party software. “Third Party Software” means the files (if any) listed in the “thirdparty-
software.txt” or other similarly-named text file that may be included with the Software. 
Third Party Software, even if included with the distribution of the Software, may be governed 
by separate license terms, including without limitation, third party license terms, open source 
software notices and terms, and/or other Intel software license terms. These separate license 
terms solely govern Your use of the Third Party Software. 

DISCLAIMER. THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-
INFRINGEMENT ARE DISCLAIMED. THIS SOFTWARE IS NOT INTENDED FOR USE IN 
SYSTEMS OR APPLICATIONS WHERE FAILURE OF THE SOFTWARE MAY CAUSE 
PERSONAL INJURY OR DEATH AND YOU AGREE THAT YOU ARE FULLY RESPONSIBLE 
FOR ANY CLAIMS, COSTS, DAMAGES, EXPENSES, AND ATTORNEYS’ FEES ARISING 
OUT OF ANY SUCH USE, EVEN IF ANY CLAIM ALLEGES THAT INTEL WAS NEGLIGENT 
REGARDING THE DESIGN OR MANUFACTURE OF THE SOFTWARE. 

LIMITATION OF LIABILITY. IN NO EVENT WILL INTEL BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

No support. Intel may make changes to the Software, at any time without notice, and is not 
obligated to support, update or provide training for the Software. 

Termination. Your right to use the Software is terminated in the event of your breach of this 
license. 

Feedback. Should you provide Intel with comments, modifications, corrections, enhancements 
or other input (“Feedback”) related to the Software, Intel will be free to use, disclose, reproduce, 
license or otherwise distribute or exploit the Feedback in its sole discretion without any 
obligations or restrictions of any kind, including without limitation, intellectual property rights or 
licensing obligations. 

Compliance with laws. You agree to comply with all relevant laws and regulations governing 
your use, transfer, import or export (or prohibition thereof) of the Software. 

Governing law. All disputes will be governed by the laws of the United States of America and 
the State of Delaware without reference to conflict of law principles and subject to the exclusive 
jurisdiction of the state or federal courts sitting in the State of Delaware, and each party agrees 
that it submits to the personal jurisdiction and venue of those courts and waives any objections. 
THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE INTERNATIONAL SALE 
OF GOODS (1980) IS SPECIFICALLY EXCLUDED AND WILL NOT APPLY TO THE 
SOFTWARE. 
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